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1: Introduction and Installation
Congratulations on your purchase of a GCC Technologies Elite 12ppm laser printer. You
now have a fast, high-quality, versatile solution for all your printing needs.

Using this manual

This manual has all the text of the Quick Install (printed) guide, along with further infor-
mation about configuring your printer and computer. To navigate around the manual, see
the section “Using Adobe Acrobat with the Elite 12ppm CD-ROM” either in this manual
or in the Quick Install guide. You’ll also find the Networking Guide, various installation
guides, and printer specifications. Elsewhere on this CD-ROM you’ll find printing software
for your computer.

Elite 12ppm highlights
Note: GCC makes several models of the Elite 12ppm. Your model may not incorporate all
these features.

True 1200 dots per inch printing
All Elite 12ppm models print at 600 or 300 dpi. The Elite 1212 also prints at a true 1200
dots per inch (dpi). All models give you razor-sharp text and detailed graphics.

Fast processing power
The AMD 29040 50 MHz RISC processor gives you faster printing of complex pages.

Full support for mixed-platform printing
The Elite 12ppm accepts jobs in PostScript Level 2 and PCL 5 formats from Macintosh,
Windows, MS-DOS, and UNIX based computers.

Low operational costs
The Elite 12ppm is an Energy Star compliant low power consumption printer, and its
one-piece microfine toner cartridge prints an average of 6,000 pages.

Full network capability
The Elite 12ppm comes with Ethernet to allow connection to an Ethernet network. It also
has LocalTalk as standard, and supports NetWare and TCP/IP.

WebAdmin remote printer management
If you have an Ethernet network that supports TCP/IP, you can remotely view and config-
ure any Elite 12ppm using a World Wide Web browser.
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Better halftones with AccuGray
GCC’s exclusive AccuGray software ensures that halftones reproduce with consistent
brightness, regardless of the screen frequencies used, making for more detailed photo-
graphs.

Edge to edge printing
The Elite 12ppm can print an area right up to the edge of the paper for full bleeds.

All ports active feature
The Elite 12ppm can accept print jobs from a Bidirectional Parallel port and LocalTalk/
Serial and Ethernet networks at the same time.

Flexible paper handling
The Elite 12ppm has a 250-sheet paper tray that can accept paper up to legal size (8.5 x 14
inch, 215.9 x 355.6 mm), and also includes an additional paper feed source for envelopes
and postcards.

Full featured front panel display
The font panel display of the Elite 12ppm displays messages that make it easy to configure
and control the printer; you get continuous information as jobs print.

SCSI interface (1200 dpi model only)
The Elite 1212 has a SCSI interface that allows you to connect an external SCSI hard drive
for additional font storage and faster printing.

Novell NEST Support (1200 dpi model only)
The Elite 1212 supports Novell’s NEST system which allows you to connect an Elite 12ppm
to a Novell network without needing to dedicate a computer as print server.

Environmentally friendly
The Elite 12ppm emits extremely small amounts of ozone, well within the safety limits, and
is engineered to reduce dust emissions for a healthier work area.

Optional equipment
A 500-sheet paper tray and an envelope feeder are available options to make the Elite
12ppm the printer you need.

Fast and easy ordering of upgrades and consumables
Replacement toner cartridges and optional equipment are available from your GCC dis-
tributor or direct from GCC at 1-800-422-7777. Visit our web store at www.gccdirect.com.
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How to set up your Elite 12ppm

Overview

You’ll carry out these steps to get your printer up and running:

• Selecting a location for the printer.

• Unpacking the printer and connecting it to a power outlet.

• Installing the toner cartridge.

• Connecting the printer to a computer or network.

The detailed instructions for these steps are in this section of the manual.

Once you have the printer physically set up, you’ll install software on every computer that
will use it. This includes:

• Installing the printer driver on a Macintosh or Windows computer.

• Installing PPD (PostScript Printer Description) and other files, if necessary.

• Configuring the control panel, driver, and ports, if necessary.

The detailed instructions for these steps are in the appropriate section of this manual,
according to which type of computer or operating system you use.

Why would I install PPD files or configure the control panel, printer
driver, or ports?

Installing PPD files
Although the standard software install gives the computer all the details of the printer, a
few software applications need you to install special files. If you don’t have any of these
applications on your computer, you don’t need to install the files. GCC supplies PPD files
for these applications:

• Adobe Illustrator® for Windows, versions 4.0 and 4.1.

• Adobe PageMaker® for Windows, versions 5.0 and 6.0.

• Aldus FreeHand® for Windows, all versions up to 4.0.

• MacroMedia FreeHand® for Windows, version 5.0.

• QuarkXPress® for Windows.

• Aldus FreeHand for Macintosh, versions 3.0 and 3.1.

• Aldus PageMaker for Macintosh, version 4.2.

• Adobe Separator for Macintosh, versions up to 3.2.
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• Deneba Canvas® for Macintosh, versions 3.0 and later.

• QuarkXPress for Macintosh, versions 3.1 and later.

• Ready, Set, Go!® for Macintosh, versions 5.0 or later.

You may need to install these files for certain other applications. If this is the case, you’ll
find details in your application’s manuals.

Instructions on how to install these files are in the sections for Macintosh or Windows.

Configuring the control panel, printer driver, and ports
Your Elite 12ppm printer has numerous settings you can adjust to make it meet your
printing needs. However, many users are satisfied with the settings as supplied.

The sections of this manual on Macintosh and Windows list the steps you must take to
configure the computer to print. The rest of each section covers the optional changes you
can make. If you’re not aware of any special circumstances in your printing it’s unlikely
that you’ll need to make any optional changes.

However, if you need to make changes, there are three ways you can do this:

• Using the printer’s control panel menus (or GCC’s WebAdmin tool).

• Using the Printer Setup dialog box on your computer.

• In the Page Setup and Print dialog boxes of many applications.

The place where you make changes affects how widespread those changes will be.

• If you change settings in the Elite 12ppm’s control panel, this sets the default for all
computers using the printer. If you don’t make any control panel changes, the factory
defaults will be the default settings. If you make changes with GCC’s WebAdmin
utility, this has the same effect as if you made them at the printer’s control panel.

• If you change settings in the Printer Setup dialog boxes on a computer, the new
settings are now the defaults for all applications on the computer. If you change
something from “Printer’s Default,” this overrides the printer control panel defaults
for this computer only.

• If you change settings in the Page Setup or Print dialog boxes in an application, this
overrides any other settings for that feature.

❏ Some changes that you make revert to the defaults as soon as you’ve printed

the document.

❏ Other changes become the defaults every time you print that document.

❏ Some will become the defaults every time you print from that application.

Download from Www.Somanuals.com. All Manuals Search And Download.



1-5

Different applications treat these changes in different ways.

GCC recommends that you make changes in the application’s Page Setup or Print dialog
boxes. If you find that you are making the same changes for every print job, use the Printer
Setup dialog boxes or the Elite 12ppm control panel menus to make these settings the
default.

You’ll find instructions on changing the settings through the control panel menus (or
GCC’s WebAdmin tool) elsewhere in the manual. The instructions for changing the set-
tings in the Printer Setup dialog boxes are in the sections on each type of computer or
operating system.

Page Setup and Print dialog boxes vary from application to application. You’ll find details
in your application’s manuals.

Setting up the Elite 12ppm
Choosing a location for the printer

Place the printer on a flat level surface in a well ventilated area away from direct sunlight
and areas where the air temperature and humidity can vary. Do not obstruct the fan vent
on the right side of the printer, and make sure that the fan vent does not blow air directly
onto someone’s face.

Use the diagram below to determine where to put your printer.

8 inches (200mm)
minimum overhead
clearance.

7.2 inches
(180mm)

1 inch
(25mm)

12.4 inches
(310mm)

without Duplex

10.8 inches
(270mm)

21.8 inches
(545mm)

with Duplex
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Removing the printer from the shipping box

Warning: The printer weighs about 30 pounds (about 14 kilograms).

Note: Save the packing materials inside the shipping box and put the box in a safe place;
you will be able to repack the printer should you need to move it again.

1. Take the printer out of the of the box and remove the packing material.

2. Take the printer out of the plastic bag.

3. Take the documentation and CD-ROM out of the plastic bag.

4. Check that you have all of the following:

GCC
TECHNOLOGIES

Elite™12ppm
Configuration Page

Printer Information

Interfaces

Paper Handling
Language:  English
AppleTalk Name:  Model
Page Count:  20
RAM Installed:  8MB
Hard disk:  No disk
OS Version:  2.3
PostScript Level 2 Version: 2.3
ROM Version: 2.3
H/W Version: 1.0
AccuGray:  Enabled

Print Darkness:  Normal
Default Source:  Upper Tray
Default Size:  Letter
Jam Recovery:  Disabled
Paper Reserve:  Enabled
Manual Feed Timeoutt:  5 Minutes

8-pin Serial:  LocalTalk

RS422 Serial (Inactive)
Baude Rate:  9600
Data Bits:  8
Stop Bits:  1
Parity:  None
Flow Control:  Xon/Xoff

RS232 Serial (Active)
Baude Rate:  9600
Data Bits:  8
Stop Bits:  1
Parity:  None
Flow Control:  Xon/Xoff

Parallel Port (Active)

PS/PCL Sensing:  PostScript Only

Port Emulation
Parallel Port:  Auto Switch
RS232 Port:  Auto Switch
RS422 Port:  Auto Switch
LocalTalk Port:  PostScript Only

PostScript
Default Resolution:  800
Job Cancel:  Enabled
Start Page:  Disabled
Wait Timeout:  300 Seconds

PCL
Resolution:  600
Copies:  1
Font Source:  Internal
Font Number:  1
Pitch:  10.0
Point Size:  12.0
Orientation:  Portrait
Page Length:  60
Symbol Set:  Roman-8
Wait Timeout:  120 Seconds
Line Wrap:  Disabled
Line Termination:  Normal

Emulations

Configuration page

Toner cartridge
(in box)

Installation guide Elite 12ppm CD-ROM Universal paper tray

AC power cord

Elite 12ppm
INSTALLAT ION GUIDE

If any of these items are missing, contact your dealer or GCC Technical Support (781-276-
8620) immediately.

You will need to provide a cable to connect your computer or network to the printer.

Warning: If you use the parallel port interface, the cable you use must be suitable for
bi-directional transmission (IEEE 1284). Standard (unidirectional) parallel cables can
cause errors in printing.

Removing additional packing

1. Remove the tape from the printer’s top cover.
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2. Press the release button on the top right of the printer.

3. Lift open the printer cover.

4. Remove the plastic foam block. Save it with the other packing materials.

The Elite 12ppm Configuration Page

Each Elite 12ppm package includes a configuration page. It was printed on your printer, at
GCC’s manufacturing facility. The page shows the hardware and software versions of the
printer, factory default settings, and the hardware configuration of your Elite 12ppm.

Installing or replacing the toner cartridge

The toner cartridge contains a microfine plastic powder that is fused to paper during the
print process. If your pages have an average of five percent coverage, you should expect to
print about 6,000 pages with each toner cartridge; if you print graphics images you should
expect to change the cartridge more often.

Warning: Do not touch the area toward the back of the inside of the printer (behind the
toner cartridge). This area has a yellow warning label. It’s unlikely that you would touch
this area when changing a toner cartridge, but you may want to leave the cover open for a
few minutes to let the area cool down.

1. Press the release button on the top of the printer to open it.

2. Lift open the printer cover.

GCC
TECHNOLOGIES

GCC
TECHNOLOGIES
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3. Move the yellow plastic slider from left to right a few times to remove dust and
toner from any previous cartridges.

4. If you are replacing a cartridge, remove the old cartridge by lifting it up and
out of the printer; otherwise, go to the next step.

5. Take the new toner cartridge out of its box and wrappings.

GCC
TECHNOLOGIES

6. Distribute the toner evenly by gently rocking the cartridge a few times.
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7. Pull the seal on the cartridge gently but
firmly to remove it completely. Do not
tug sharply or pull the seal at an angle.

GCC
TECHNOLOGIES

8. There is an arrow on the left side of the cartridge. There is a similar arrow on
the left side of the printer. Align these two arrows and insert the cartridge
down and into the printer completely.

9. Close the top cover so that it latches. If the top cover does not close and latch,
you may not have fully inserted the toner cartridge. Open the cover and carry
out step 8 again.

If you have replaced a used toner cartridge, you can resume printing when the
printer warms up.
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Connecting power to the Elite 12ppm

Plug the power cord into the socket located on the back of the printer, then plug the cord
into an AC power outlet. Switch on the printer using the ON/OFF switch located on the
right side of the printer.

Warning: Do not attempt to use an adapter to plug the power cord into a 2-pin socket.
The third pin is for your protection; it grounds the printer. If you use a printer (or any
electronic or electrical equipment) that has no ground connection, you run the risk of
electric shock. If necessary, have a licensed electrician replace the socket.

Using the paper tray

The universal (standard) paper tray holds up to 250 sheets of 20 lb. (75 g/m2) copier-type
paper up to 8.5 x 14 inches (215.9 x 355.6 mm). It can handle the following paper sizes:

• Letter

• Legal 13"

• Legal 14"

• Executive

• A4

• B5

You can use smaller sizes of paper and envelopes in the Multipurpose feeder—see the next
section for details. The standard paper tray will also handle up to 50 transparency or label
sheets in Letter or A4 size.
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Loading paper into the tray

Note: Place letterhead paper face down
and with the letterhead toward the front
of the tray.

1. Remove the paper tray from the
printer. Pull firmly using the
handle at the front of the tray.

2. Adjust the guides at the rear of
the paper tray to accommodate
the length of the paper you
intend to use. Adjust the smaller guide at the left (A) to accommodate paper up
to A4 size. For sizes larger than A4, extend both of the guides (B).

3. Make sure that the paper fits underneath the plastic tab at the rear of the tray
and under the metal bracket at the front (C).

4. Place the paper in the paper tray and move the paper width guide (D) so that it
lies next to the paper. Don’t move the guide so close that it holds the paper
tightly, because this may cause jams.

C

A B

D

A48.5 X 11"7 1/4 X 10.5"
B5

A

8.5 X 13"8.5 X 14"

B C

D
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5. Replace the tray in the printer. Make sure you push it all the way in, so that the
control panel displays the “ready” message.

Using the multipurpose feeder

The multipurpose feeder holds up to an extra 80 sheets of 20 lb. copier-style paper, 40
transparencies, 40 sheets of labels, 10 envelopes or 25 postcards. You can also manually
feed single sheets of paper or other media. The multipurpose feeder handles the following
paper and envelope sizes:

• Letter • Legal 13" • Legal 14"

• Executive • A4 • B5

• Postcard • Commercial #10 • Monarch

• DL • C5

Exact measurements of these paper sizes is in the appendix “Specifications.”

You have to select the multipurpose feeder from a computer’s Print dialog box (assuming
you specified the main paper tray as the default paper source). See “Paper Source” in the
sections on Macintosh and Windows for information on how to select the multipurpose
feeder.
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Loading Paper in the Multipurpose Feeder

1. Open the cover of the multipurpose feeder; it folds down to a 45º angle. If one
side of the cover doesn’t unlatch, push the cover gently toward that side.

2. Pull the tab to slide out the extension.

3. When the extension is fully extended, lift the tab up and toward you so that
the folding part of the extension is in place.

GCC
TECHNOLOGIES

GCC
TECHNOLOGIES

4. Insert paper (or other
media). If necessary, slide
the paper guide so that it
lies against the edge of the
paper.  Insert letterhead face
up with the top toward the
printer, and envelopes face
up with the flap down and
to the right.

Note: The Elite 12ppm does not check
the size of the media you insert in the
multipurpose feeder (unlike the paper
trays). Make sure you’re using the
paper size you specified in your application.

GCC
TECHNOLOGIES

A5 B5 A4
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Note: If you are using legal-size paper, you may need to support the stack to help it feed
properly.

When you close the multipurpose feeder, first move the paper guide back to the right side.
Then fold the extension and slide it back into the main part of the feeder. Now close the
cover; this lifts the feeder back to the upright position.

Optional paper handling accessories

Optional on the Elite 12ppm is a face-up paper tray that attaches to the rear of the printer.
This gives you a straight-through paper path (which you may need for thicker media) in
conjunction with the multipurpose feeder.

Other optional units include a 500-sheet feeder and paper tray, and a 50-envelope tray that
fits inside the 500-sheet feeder.

Elite 12ppm interface connections

The Elite 12ppm includes Ethernet, LocalTalk, RS-422 serial, and bidirectional parallel
interfaces; the LocalTalk and RS-422 serial interfaces share the same 8-pin mini-DIN port.

With your printer’s all ports active feature, all the interfaces are simultaneously active,
which means you can print through more than one interface at a time. You don’t have to
select a port; this feature works automatically.

Note: If you are connecting through the parallel interface, insert this plug before you
make any other interface connections. If other plugs are inserted it’s difficult to connect the
parallel plug.

• The 8-pin DIN connector (A) can be used as either a
LocalTalk network interface or an RS-422 serial interface.
LocalTalk is the default setting. If you want to use this as a
serial interface, you’ll have to change settings in the printer’s
control panel menus.

• (1200 dpi model only) You can add an external hard disk for
font storage using the SCSI interface (B). It is not used for
communication between the printer and computer.

• If you want to connect your printer to a single PC-compat-
ible computer, use the  parallel interface (C). Alternatively,
you can connect the RS-422 serial interface port to the PC’s
serial port, but the serial port transmits data much slower
than a parallel port or network.

D

C

B

A
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• The Ethernet network interface (D) is used to connect the printer to an Ethernet
network. The interface contains one or two connectors: an RJ-45 connector (upper)
for connecting to 10BASE-T networks and (1200 dpi model only) a BNC connector
(lower) for connecting to 10BASE-2 networks.

Note: Some interfaces have specific settings that you must select through the printer’s
control panel Interfaces submenu.

Connecting cables correctly
Most cables come with some kind of mechanical locking device. Be sure to use these
locking devices, otherwise you may experience intermittent errors or the printer will fail to
operate altogether.

• There is no locking device on LocalTalk or RS-422 Serial connectors. Make the plug is
pushed all the way into the socket.

• When you have inserted a Parallel port plug, lift up the wire clips at either end of the
socket so that they fit into the slots on the sides of the plug.

• 10BASE-T plugs have a locking tab similar to plugs on telephone cords. When the
plug is fully inserted the tab clicks into place.

• 10BASE-2 plugs have a rotating collar. Plug the cable onto the socket, then rotate the
collar clockwise to lock it.

Improperly inserted cables are the cause of many networking and printer-related problems.

LocalTalk connection
The Elite 12ppm uses the LocalTalk cable system to connect to AppleTalk-compatible
networks. This connection forms a chain; do not
connect devices so that it forms a circle.

Important: You need a connector kit for each
device on the network. Therefore, you need two
connector kits to connect the printer to one
computer, and so forth.

To plug in LocalTalk cables:

1. Switch off the printer.

2. Connect one LocalTalk connector box to
the LocalTalk port on the printer.

3. Connect one LocalTalk connector box to
the printer port (identified by a printer
icon) on the back of the Macintosh.

PhoneNET

Connector box

Resistor

Terminator

Cable
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4. Connect the LocalTalk boxes together with one of the LocalTalk cables. You will
only need one of the LocalTalk cables (for one Macintosh and one printer).

5. Insert resistors. (Depending on the type of cables you are using, terminating
resistors may be needed. Please refer to the documentation included with your
cable kit for instructions.)

6. Switch on the printer.

7. Verify the printer’s LocalTalk setting. The 8-pin serial submenu, accessed from
the printer’s control panel, should be set to LocalTalk. LocalTalk is the factory
default, so you should not need to change the setting.

Bi-directional (parallel) connection
The bi-directional parallel connection between the printer and a PC requires a standard
36-pin bi-directional cable (to IEEE 1284 standards). The length of a bi-directional cable
can be up to 10 meters or 30 feet. This interface offers the fastest communication between a
PC and the printer (unless the PC and printer support Ethernet).

Serial connections
You can connect a PC to the printer by using the RS-422 connection and the computer’s
serial port. In general, this is not recommended, because data is transmitted more slowly
than if you connect the parallel port on the PC to the parallel port on the printer, or use a
network. Therefore, printers connected through the serial port take longer to print.

RS-422 serial enables data to travel in either direction between the printer and a single
computer. For an RS-422 serial connection, use an 8-pin serial cable. The RS-422 interface
allows a cable length of up to 300 feet.

Note: You need to set the printer for Serial communication. The 8-pin serial submenu,
accessed from the printer’s control panel, should be set to RS422. LocalTalk is the factory
default, so you will need to change the setting. Configure the serial interface settings. In
order for successful serial communications between the printer and the PC to take place,
the configuration of the serial interface of each device must match.

Ethernet network connection
The Elite 12ppm printer includes an Ethernet network interface. The Ethernet interface on
your printer lets you connect to an Ethernet network via one or two types of Ethernet
cables: 10BASE-T and 10BASE-2 (1200 dpi model only).

• 10BASE-T (Unshielded Twisted-Pair or UTP)
Your printer connects to 10BASE-T Ethernet via the 10BASE-T (RJ-45) connector on the
network card. The cabling used is Unshielded Twisted-Pair (UTP).
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• (1200 dpi model only) 10BASE-2 (RG-58, Thin Coax, or Thinnet)
Your printer connects to 10BASE-2 Ethernet via the 10BASE-2 (BNC) connector on the
network card. The cabling used is called RG-58 or Thin Coax.

Supported network protocols

• EtherTalk
EtherTalk is Apple’s name for the AppleTalk network protocol running over Ethernet
cabling.

• NetWare
NetWare is Novell’s system for Ethernet connection.

• TCP/IP
TCP/IP is a networking protocol used by various vendors of network software.

If you need to know more about these protocols, refer to the Networking Guide on this
CD-ROM. You’ll also see how to connect your printer to make it available on other net-
works such as those running Windows for Workgroups 3.11, Windows 95, and Windows
NT.
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2: The Elite 12ppm Control panel
Introduction to the Elite 12ppm control panel

You use the Elite 12ppm’s control panel to get information about your printer and to
adjust specific printer functions. It includes an LCD display window, four LEDs that show
the status of the printer at all times, and eight pushbuttons.

Control panel (LCD) display window
The LCD display window has several functions. It shows:

• The current status of the printer.

• A more detailed explanation of errors.

• Prompts to complete tasks, like “Insert Paper.”

• The Elite 12ppm menus and submenus.

When the printer is not printing, you’ll see the printer’s name and “Ready” in the display
window.

Menu Enter

Manual
Feed

On Line Form Feed Cancel
ResetContinue

On Line Comm Paper Service

Status LEDs

Function keys

Control panel status LEDs
The control panel status LEDs show you the following:

When the On Line LED is solid (lit and not flashing), the Elite 12ppm is ready to
receive data and print. When you turn the printer on, this LED flashes while the
printer is intializing.

When the Comm LED flashes, one of the Elite 12ppm’s interface ports is receiving or
transmitting data.
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The Paper LED is solid in one of the following situations:

• The printer is out of paper

• The wrong size paper is loaded in the paper tray

• The printer is waiting for you to insert paper because you specified manual feed in
the paper source section of your application’s Print dialog box.

When the Service LED is flashing, you need to perform some type of simple service
procedure in order to continue printing. If this LED is solid, the printer needs to be
serviced by GCC authorized service personnel.

When a LED indicates that the printer needs attention, you’ll see a message explaining the
situation  in the display.

Control panel function keys
On Line key

You use the On Line key to set the printer either on line or off line. The printer is normally
on line — that is, ready to receive data from computers and print it. If you need to use the
control panel menu system, you must set the printer off line. Press the On Line key to set
the printer off line. After you’ve finished using the menu system, press the On Line key
again to set the printer back on line.

If you press the On Line key while a document is being printed, the On Line LED flashes.
This indicates that the printer will finish processing this document and any other waiting
documents, and then go off line.

Manual Feed key
You use the Manual Feed key:

• When you select manual feed as the paper source for the document in your
application’s Print dialog box.

• When the control panel requests you to load a paper size that is not loaded in the
printer’s paper trays.

In both cases, you load the multipurpose feeder with the correct size paper and press the
Manual Feed key.

During the period when you can load paper, the printer displays a “Load Paper” message.
Any jobs received while the printer is displaying this message will wait to print until you
load paper and the current document finishes printing.

The amount of time that the printer will wait for you to load paper can be set throught the
control panel. It’s located in the Manual Feed Timeout submenu of the Paper Handling
menu. The default time is 300 seconds (5 minutes).
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If you do not load paper within the specified time, the printer discards the job and carries
on printing any other jobs that are pending.

Form Feed/Continue key
You use the Form Feed/Continue key:

• When the printer needs a Form Feed command for PCL5 print jobs from certain
applications.

Some applications send data for a PCL 5 print job except the command to make the
printer feed paper. In this case you should press the On Line key and then press the
Form Feed/Continue key.

• When you want the printer to print on the paper in the paper trays, even though they
do not hold the specified paper sizes.

The Form Feed/Continue key overrides the printer’s requests that you load a different
size of paper or load paper through the multipurpose feeder. In both cases the printer
will draw paper from the 250-sheet cassette, whatever size of paper it holds.

Cancel/Reset key
You use the Cancel/Reset key:

• To cancel a PostScript job that is either processing or waiting to print.

To cancel printing, press the On Line key and then hold down the Reset key for three
seconds. You’ll see “Cancelling job” in the display window. It’s possible that this
feature has been disabled through the menu system; in this case, pressing these keys
will have no effect.

If the Job Cancel feature has been disabled, you can enable it by going to the
PostScript menu in the Control Panel and changing the setting in the Job Cancel
submenu. The default setting for this feature is enabled.

• To reset the control panel menu and submenu settings to the factory settings (the
printer must be off line).

If you want to reset all the menu items to their default settings, press the On Line key
to take the Printer off line, then hold down the Cancel/Reset key for five seconds.
You’ll be prompted to either press the Enter key to confirm that you want to reset all
menu items, or to press the Cancel/Reset key again to leave menu items as they are.

If you want to reset all items in one menu to the default settings, navigate through the
menu system until you see the menu you want to reset. Hold down the Cancel/Reset
button for five seconds. You’ll be prompted to either press the Enter key to confirm
that you want to reset all the items on this menu (including submenus), or to press
the Cancel/Reset key again to leave these menu items as they are.
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If you want to reset just one submenu to the default settings, navigate through the
menu system until you see the submenu you want to reset. Hold down the Cancel/
Reset button for five seconds. Because you are resetting only one item, you won’t be
prompted to confirm or cancel this change.

Note: Some items will not reset until you switch the printer off and on again.

Menu key
You use the Menu key to get to the menu system. First, you must press the On Line key.to
take the printer off line. You can only get to the menu system when the printer is off line.

You’ll use the printer’s menus if you need to configure printer functions or get information
about current settings.

Note: You’ll only need to change the settings on the menus if you have specialized printing
or connection needs. The factory settings suit most users.

To see the menus, first press the On Line key to take the printer off line. Then press the
Menu key. Each time you press the Menu key you’ll see one of the main items. There’s a
full list of menu items later in this section.

When you are finished in the menu system, press the On Line key to leave the menu system
and place the printer back on line and ready to print.

Enter key
You use the Enter key:

• To see submenus.

“Press Enter…” appears in the display window to prompt you to press the Enter key
to see a submenu(s).

• To save changes when you change main menu or submenu settings.

After you make a change to a main menu setting or submenu setting, press the Enter
key to save the new setting. An asterisk (*) will appear in the display window to the
right of the setting to confirm that new setting has been saved.

• To find out which port is being used for the current print job.

Press the Enter key when the Elite 12ppm is processing a job (when the Comm LED is
flashing). The LCD display window shows the name of the interface port that is
receiving data.

+ and – keys
You use the + and – keys to move through main menu and submenu settings. You can use
these keys only when the printer is off line.
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The Elite 12ppm menu system

The menu system consists of a number of main menus. Some main menus contain sub-
menus. Some menus only give you information, while others let you change settings.

Depending on your choices, some menus may not be available. For instance, the factory
defaults set the PS/PCL Sensing menu to PostScript Only, and you cannot access the PCL
menus. If you changed this menu setting to Auto Switch or PCL Only, the PCL menus
would be accessible.

Note: Items that appear in bold  in this section are the factory default settings.

Reminder:  Press the Enter key to save a new setting. An asterisk (*) will appear next to the
new setting confirming that your changes have been saved.

The main menu items are:

1. Language 6. Emulations

2. Print Help Page 7. Interfaces

3. Print 1 Sample(s) 8. Print Info Pages

4. Printer Info 9. Print Control

5. Paper Handling

Do I need to change control panel menus?

The factory default menu settings suit most users. If you have specialized printing or
connection needs, you may find that you need to change these settings.

We suggest that you read the remainder of this section to understand what the menu items
can control. If you decide that you can usefully change some settings, we advise that you
first print out a Help page (described below).

The Help page shows the current settings of all menus. Items in bold are the current set-
tings. Menus which cannot be accessed in the current configuration are grayed out.

If you change settings, make a note on the Help page of the setting(s) that you’ve changed.
This gives you a record of changes and may help you understand what needs to be done if
your printer behaves in a way users don’t expect.

1. Language

This menu lets you change the language of the messages in the display window. Languages
are English, Français, and Deutsch.
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2. Print Help Page

This prints a chart of all the items on the menus. Press the Enter key to print this chart.
You cannot print this chart if the PS/PCL Sensing submenu is set to PCL only.

The Help page shows the current settings of all menus. Menus which cannot be accessed in
the currect configuration are grayed out.

3. Print (1) Sample Page(s)

You can print a sample page showing graphics and text. If you want to print more than one
copy of this sample page, press the + and - keys to change the number of copies. Press the
Enter key to print the page(s).  You cannot print this page if the PS/PCL Sensing submenu
is set to PCL only.

4. Printer Info

This menu has subitems which display general information about your printer. Press the
Enter key to see the subitems.

• Ram Installed: The total amount of RAM in the printer.

• Ethernet Address: The Ethernet address.

• S/W Version: The version of the printer’s operating system.

• H/W Version: The version of the printer’s hardware.

• Page Count: The total number of pages printed.
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Submenu

Default Source: Which paper tray is used
if the print job does not specify a paper tray.

Default Destination: Which paper output
tray is used if the print job does not specify a
paper output tray

Default Size: The “expected” paper size to
print whenever a print job does not specify a
paper size.

Jam Recovery: After you clear a jam, the
printer reprints any pages that were inside the
printer at the time of the jam. With Jam
Recovery enabled, pages that were exiting into
the output tray will also be reprinted.

Paper Reserve: Whether the printer will
draw paper from another paper tray if the
selected paper tray is empty or has the wrong
size paper. (The reserve paper tray must
contain the same size paper.)

Manual Feed Timeout: How long the
printer will wait for paper to be put in the
multipurpose feeder after the computer has
sent a manual feed request to the printer.

Settings

Tray 1, Tray 2, MPFeeder
(multipurpose feeder), or Manual
Feed.

Top (face down), or Rear
(face up)

Letter, Legal, Legal 13”,
Executive, A4, B5, Postcard,
Commercial #10, Monarch, DL,
or C5.

Disabled or Enabled.

Enabled or Disabled.

Range from 30-600 seconds (in
30-second increments), or Never
Timeout. Default is 300
seconds (5 minutes).

Notes

Only available paper trays will be shown.

Printing is slightly faster when Jam Recovery is
Disabled, as more of the printer’s RAM is
needed to store page details.

If enabled, the printer prints from another
paper tray when the paper tray specified by the
print job is empty or has the wrong size paper. If
Disabled is selected, the printer displays a
message to load a paper tray.

If you don’t place paper in the feeder before the
timeout occurs, the job will not be printed.
You’ll have to send it again.

5. Paper Handling – press the Enter key to access the submenus.
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Notes

To print PCL jobs the factory setting
(PostScript only) must be changed to either
Auto switch or PCL only. See the note below
this table.

The Port Emulations submenu only appears
when PS/PCL sensing is set to Auto switch.

See note below.

See note below.

See note below.

See note below.

See note below. This option will only appear if
it is configured.

See note below. This option will only appear if
it is configured.

See note below. This option will only appear if
it is configured.

Submenu

PS/PCL Sensing: Whether the printer will
automatically switch between PostScript and
PCL emulations, or print only PostScript or
only PCL jobs.

Port Emulations
(5 submenus)

Parallel: Whether the parallel port will
automatically switch between PostScript and
PCL emulations, or print only PostScript or
only PCL jobs.

RS422: Whether the RS422 port will
automatically switch between PostScript and
PCL emulations, or print only PostScript or
only PCL jobs.

LocalTalk: Whether the LocalTalk port will
automatically switch between PostScript and
PCL emulations, or print only PostScript or
only PCL jobs.

EtherTalk: Whether the EtherTalk port will
automatically switch between PostScript and
PCL emulations, or print only PostScript or
only PCL jobs.

Lpd: Whether the Lpd port will automatically
switch between PostScript and PCL emula-
tions, or print only PostScript or only PCL
jobs.

TCP direct: Whether TCP will automatically
switch between PostScript and PCL emula-
tions, or print only PostScript or only PCL
jobs.

NEST (1200 dpi model only): Whether
NEST will automatically switch between
PostScript and PCL emulations, or print only
PostScript or only PCL jobs.

Settings

Auto switch, PostScript only,
or PCL only.

Auto switch, PostScript only,
or PCL only.

Auto switch, PostScript only,
or PCL only.

Auto switch, PostScript only,
or PCL only.

Auto switch, PostScript only,
or PCL only.

Auto switch, PostScript only,
or PCL only.

Auto switch, PostScript only,
or PCL only.

6. Emulations – press the Enter key to access the Emulations submenus. These
menus contain additional submenus.

Note: Your printer and each individual port can be set
to accept jobs in PostScript only, PCL only, or to switch
automatically between the two. If you set the printer
to Auto Switch, it will accept either PostScript or PCL
documents without you having to change settings.

Your printer will work more efficiently if you change
only the ports that actually need Auto Switch. This

Auto switch, PostScript only, or
PCL only.

means that any other ports that only need to accept a
single standard will not examine each print job to see
whether it’s PostScript or PCL.

However, if you choose Auto Switch for any port (or
the entire printer), you’ll use more printer RAM than if
you choose PostScript only or PCL only.
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Submenu

PostScript
(5 submenus)

Default Resolution: The default
PostScript output resolution (in dots per inch).

Default screens: Opens a submenu which
lets you set the screen frequencies for 300 dpi,
600 dpi, and 1200 dpi (if available).

AccuGray: Improves the look of halftones
(photographs), especially those printed at
higher line frequencies.

Job Cancel: Whether the Cancel/Reset key is
able to cancel the PostScript printing process.

Start Page: Whether the printer prints a
Start page every time the printer is switched
on.

Wait Timeout: How long the printer waits
for more input after printing all the input
received (but without receiving a message
saying that the job is complete).

PCL
(11 submenus)

Resolution: The default PCL resolution (in
dots per inch).

Copies: The default number of copies.

Font Source: Which default location fonts
will print from — the printer’s PCL resident
fonts or additional fonts manually downloaded
to the printer’s RAM.

Font Number: The default font number.

Settings

Resolution options depend on the
model being used. Default is the
highest resolution
available for the model.

Default line screens are 53 for
300 dpi, 85 for 600 dpi, and 106
for 1200 dpi.

Enabled or Disabled

Enabled or Disabled

Enabled or Disabled

From 45 to 120 seconds in 15
second increments, or Never
Timeout.

300 or 600

From 1 to 99

Internal or Downloaded

From 1 upward (see notes)

Notes

The PostScript submenus will only appear when
the PS/PCL Sensing option is set to Auto Switch
or PostScript only.

Press the Enter button to show these submenus.
Press the Menu button to move from resolution
to resolution.

AccuGray does not work with all applications,
and documents may print more slowly.

If the PS/PCL Sensing option is set to PCL only,
the Start Page will not print even if this menu is
set to Enabled.

Some applications may change this setting
during the printing process. In some cases the
change will be permanent and the new timeout
setting will appear in the display. You can reset
it, or, if the application is one you use
frequently, leave the new setting.

The PCL menus will only appear when the PS/
PCL Sensing option is set to Auto Switch or PCL
only.

Downloaded does not appear if you haven’t
manually downloaded PCL fonts into the
printer’s RAM.

The font number must correspond to a font
available from the location specified by the Font
Source submenu.

Emulations (continued)
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either Pitch: The number of characters per
horizontal inch for the default font.

or Point Size: The point size of the default
font.

Orientation: The default alignment of the
image on the page.

Page Length: The default number of lines
on the page.

Symbol Set: The set of character symbols
the default font uses.

Wait Timeout: How long the printer waits
for more input after printing all the input
received (but without receiving a message
saying that the job is complete).

Line Wrap: For “plain text” print jobs,
whether the text at the end of a line will end at
the margin and continue onto the next line, or
whether the line of text will be cut off at the
margin.

Line Termination: For “plain text” print
jobs, sets carriage return and line feed (form
feed) commands to determine which is the
end-of-line indicator.

From 0.44 to 99.99 in 0.25
increments. Default is 10.00.

From 4.00 to 99.75 in 0.25
increments. Default is 12.00.

Portrait or Landscape

From 5 to 256. The default is 60
for letter size paper.

The character symbols the font
supports (see notes). Default is
Roman-8.

From 45 to 120 seconds in 15-
second increments, or Never
Timeout.

Disabled or Enabled.

Normal, CR=CRLF, LF=CRLF
and FF=CRFF, or ALL.

This submenu only appears if the default font
uses fixed spacing (monospaced).

This submenu only appears if the default font is
scalable and is proportionally spaced.

This setting may change if the settings in the
Default Size submenu of the Paper Handling
menu are set to a size other than the factory
default.

See the Fonts section of this CD-ROM for a list
of the symbol sets for resident PCL fonts.

Some applications may change this setting
during the printing process. In some cases the
change will be permanent and the new timeout
setting will appear in the display. You can reset
it, or, if the application is one you use fre-
quently, leave the new setting.

Emulations (continued)
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Submenu

8-pin serial

RS422 Serial
(5 submenus)

RS422 Baud Rate: The RS422 baud rate.

RS422 Data Bits: The number of data bits
sent with each serial byte.

RS422 Stop Bits: The number of stop bits
sent with each serial byte.

RS422 Parity: The parity sent with each
serial byte.

RS422 Flow Control: Which flow control
is used by the RS422 serial port.

Settings

LocalTalk or RS422

300, 600, 1800, 2400, 3600, 4800,
7200, 9600, 19200, 38400, or
57600.

8 or 7

1, 1.5, or 2

None, Even, or Odd

XON/XOFF, XON/XOFF Input,
or DTR

Notes

If you change the 8-pin serial setting, you must
restart the printer.

The RS422 menu only appears when you choose
the RS422 option in the 8-pin serial menu.

Always set this to DTR when you send a PCL
job.

7. Interfaces – press the Enter key to access the submenus. The Interfaces submenus also
have submenus.

TCP/IP: Whether print jobs will be accepted
over a TCP/IP network.

There are twelve other submenus in the TCP/IP
menu system; you will need to configure these
to run TCP/IP. Full details of the menus and
their recommended settings are in the TCP/IP
section of the networking guide on this CD-
ROM.

NEST (1200 dpi model only): Allows you
to configure the printer on a Novell network
without needing to use a computer as a print
server.

Frame Type: The Frame Type of printers on
the Novell network.

Enabled or Disabled.

Enabled or Disabled.

802.2, 802.3, Ethernet II, or
SNAP.

TCP/IP will not be operational until you have
configured the settings in the TCP/IP submenus.
Until then, setting this switch to Enabled has no
effect. When TCP/IP is configured, this menu will
allow you to turn it on and off. For full details, see
the TCP/IP section of the networking guide on
this CD-ROM.

If the Frame Type differs from what you specified
in the NEST software, the printer will not be
available to the network.
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Submenu

Print Control
(five submenus)

Darkness: Controls the overall darkness of
the page.

TonerMiser (Elite 1212): Lets you use less
toner, but with a reduction in image quality.

Smoothing (Elite 1212): Reduces the
jagged appearance of text and graphics.

Print Cal. Pages (Elite 1212): Prints a
series of pages to be used in conjunction with
the Calibration menu.

Calibration (Elite 1212): A range of
settings corresponding to the pages printed
using the Print Cal. Pages menu command.

Settings

Darkest, Darker, Normal,
Lighter, or Lightest.

Enabled or Disabled.

Enabled or Disabled.

Press the Enter key to start the
process.

Calibration 1 - Calibration 5. The
default setting is set at the
factory, and is different for each
printer.

Notes

Cannot be used if either Smoothing is enabled
or print resolution is 1200 dpi.

Cannot be used if either Toner Miser is enabled
or print resolution is 1200 dpi.

You should examine the output and choose the
page that looks best overall.

If necessary, change this setting to the Calibra-
tion number of the page that looks best (from
those printed using the Print Cal. Pages menu
command above).

9. Print Control – press the Enter key to access the submenus.

Page Type

Configuration: A list of the control panel
settings for each menu and submenu.

Font List: The resident fonts and any
downloaded fonts.

Help: A diagram of the control panel menu
system.

Sample: Common graphics formats and
elements, and different fonts and sizes.

Settings

Press the Enter key to print the
Configuration page.

Press the Enter key to print the
Font list.

Press the Enter key to print the
Help page.

Press the Enter key to print the
Sample page.

Notes

This page only prints if the PS/PCL sensing
menu is set to Auto Switch or PS only.

The list of fonts you’ll see depends on the
setting of the PS/PCL menu. Auto Switch
shows all resident fonts, PS Only shows only
resident PostScript fonts, and PCL Only shows
only resident PCL fonts.

This page only prints if the PS/PCL sensing
menu is set to Auto Switch or PS only. Menus
and submenus will appear dimmed if you can’t
select them because of other menu settings (for
instance, the PCL menus will be dimmed if you
have set the PS/PCL menu to PS only).

This page only prints if the PS/PCL sensing
menu is set to Auto Switch or PS only.

8. Info Pages – The info pages menu lets you print four different pages of information.
Press the + or - keys to access each individual page type. Press the Enter key to print the page
you select. The printer will temporarily go on-line, print a page, and then go back off line to
the menu.
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3: Using a Macintosh
Software Installation

Software for the Macintosh is included on the Elite 12ppm CD-ROM provided with your
printer. The automatic installer places all the printing software into the appropriate loca-
tions on your startup disk (the startup disk is the hard disk that contains the System and
Finder™ files used to start your Macintosh).

To install the Elite 12ppm software:

1. Put the Elite 12ppm CD-ROM into the CD-ROM drive.

2. Open the folder labeled “Printing Software.”

3. Double-click the Elite 12ppm Installer icon.

4. Click Continue. You’ll see the Read Me file. Take some time to read this file. It
contains last-minute information on the installation procedure, as well as
updates on Elite 12ppm features and compatibility issues. After reading the
Read Me file, you can print it (if a printer is available) or save it as a TeachText
document.

5. Click Continue. You’ll see the Install dialog box. Choose the file(s) you want to
install.

If you want to install all the
files for your 12ppm model
(recommended), choose the
model name and click the
Install button.

If you want to only install
certain files, scroll through
the list and click on those
files. You can select more
than one file by holding
down the Shift key as you
click on the line. When
you’ve selected all the files
you want to install, click the
Install button.

6. Click Install. You’ll see a progress box describing the status of the installation.
When the installation is complete, you’ll see a dialog box indicating that the
installation was successful.
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Installing application-specific printer description files
A few applications require you to install additional files. These files give the application
information about the capabilities of your printer and are often known as Printer Descrip-
tion files. The manuals included with an application tell you whether or not it requires
these files. The LaserWriter 8 driver, shipped with the Elite 12ppm, uses printer descrip-
tions called PostScript Printer Description (PPD) files.

When you install software from the Elite 12ppm CD-ROM, the printer description files are
copied into a folder named Application Files in the Elite™ 12ppm Folder. The Elite™
12ppm Folder is then located in your startup disk’s window. Follow the instructions below
to copy each file into the folder specified by the application.

For more detailed information on printer description files, please refer to the documenta-
tion included with the application.

Elite 12xx (format 4)
This file is automatically placed in the
Printer Descriptions folder during the
initial (complete) software installation
procedure. It’s provided here because some
application(s) may require it to be placed in
a folder other than the standard Printer
Descriptions folder.

GCxx.PPD (format 3.0)
This is the printer description file for
Aldus® FreeHand™ versions 3.0 and 3.1,
Aldus PageMaker® version 4.2x, Adobe
Separator™ 3.2 or earlier, Canvas™ ver-
sions 3.0 or later, and other applications
that require a .PPD file. Copy this file into
the appropriate PPD Folder specified by the
application you are using (e.g., the Aldus
PageMaker PPD Folder is located in the
Aldus Folder, which is located in the
System Folder).

GCxx.PDX
This is the extension to the PostScript
printer description file for Aldus FreeHand
3.0 and 3.1 and PageMaker 4.2x. Copy the
file into the PPD Folder located in the
Aldus Folder, which is located in the
System Folder.

Elite 12xx.PDF
This is the PostScript printer description
file for QuarkXPress™ versions 3.1 or later.
This file contains Elite 12ppm-specific
information for paper sizes. Copy this file
into the folder where the QuarkXPress
application resides.

Elite 12xx.MPD
This extension is the PostScript printer
description file for Ready,Set,Go!® versions
5.0 or later. Copy the file into the MPD
Folder located in the Ready,Set,Go! Folder.
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Selecting the LaserWriter 8 printer driver

The LaserWriter 8 driver shipped with the Elite 12ppm may look slightly different (presen-
tation and layout of dialog boxes, menu items, etc.) from other versions of the LaserWriter
8 driver. However, the Elite 12ppm and the Elite 12ppm PPD files are compatible with all
versions of LaserWriter 8.

Before you can print, you must select the LaserWriter 8 printer driver in the Chooser.

To select the LaserWriter 8 printer driver:

1. Choose the Chooser from the Apple (ð ) menu.

If you don’t see the LaserWriter 8 icon in the upper-left area of the Chooser (1a), reinstall
your printing software. If you don’t see the name of your printer in the upper-right area of
the Chooser (1c), refer to Chapter 6 in the Elite 12ppm User’s Manual.

Note: If you use the Apple LaserWriter Utility to change the zone that the Elite 12ppm
appears in, this won’t take effect until you switch the printer off and then back on.

Selecting the printer description file
The LaserWriter 8 printer driver in your computer uses PostScript Printer Descriptions
(PPDs). The Elite 12ppm PPD gives the Laserwriter driver information about capabilities
common to every Elite 12ppm printer. This PPD is installed when you install the software
from the Elite 12ppm CD-ROM. When you select the printer in the chooser, your com-
puter communicates with the printer to get specific information about it. This can include
memory amount, which paper trays are installed, and so on.

A. Click on the
LaserWriter 8
icon.

B. Select the
name of the
AppleTalk Zone
that the printer
is connected to.

C. Click on the
name of your Elite
12ppm printer in
this box.

D. Make sure
AppleTalk is active.
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Creating the Printer Descriptions folder
When you install software from the Elite 12ppm CD-ROM, the Elite 12ppm PPD is copied
into the Printer Descriptions folder. If a Printer Descriptions folder does not exist, the
installer creates one and then copies the PPD into it. (For System 6, the Printer Descrip-
tions folder is stored in the System Folder.)

Setting up the printer in the Chooser
You use the LaserWriter 8 Setup function in the Chooser to read the PostScript printer
description files.

To select the PostScript Printer Description:

1. Choose the Chooser from the Apple (ð ) menu.

2. Click the LaserWriter 8 icon in the upper-left area of the Chooser. The name
Elite 12ppm appears in the upper-right area of the Chooser below “Select a
PostScript Printer.” The name should appear highlighted; click the printer’s
name if it is not highlighted.

3. Click Setup ( ). A message box appears, informing you that the Macintosh is
communicating with the Elite 12ppm. The LaserWriter 8 driver is automatically
configured with specific information about your Elite 12ppm (model, memory,
paper sizes, paper trays, etc.). After the process is finished, the Chooser reap-
pears with an icon placed next to the Elite 12ppm name. Also, notice that
“Setup” has an ellipsis (…) added to it – . The ellipsis indicates that
“Setup” now contains user-selectable functions.

Setup options
Your printer is now correctly set up and you can print to it. However, if in the future you
change something about it (like adding extra memory or new paper trays, for instance) you
use the Setup dialog box. You can also use the Printer Info function to show you informa-
tion about your printer.

To access the additional Setup functions:

1. Choose the Chooser from the Apple menu and select LaserWriter 8.

2. Select the name of the Elite 12ppm in the right scroll box.

3. Click Setup. The Setup dialog box appears.

• Click Auto Setup to automatically reconfigure the printer driver after you have up-
graded your printer with additional memory or additional paper trays. Normally, this
will be all you need to do after making these changes.

• Click Select PPD to manually select a PostScript Printer Description file.
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• Click Printer Info to display information about the Elite 12ppm. Click the Update
button to view the information about the Elite 12ppm currently selected.

• Click Configure to manually reconfigure the printer driver after you have upgraded
your printer with new options. The available options for the Elite 12ppm are:

- Memory Configuration – After installing additional memory, select the memory
size range.

- Additional Tray – After installing additional paper trays, select the option that
corresponds to the new tray.

- Paper Sizes –  This pop-up menu enables you to select the page sizes that will be
displayed in the Paper menu of the Page Setup dialog box.

Printing documents using the LaserWriter 8 printer driver

To print a document:

1. Open the document that you want to print.

2. Choose Page Setup from the File menu.

3. Make any selections in the Page Setup dialog box and click OK.

4. Choose Print from the File menu.

5. Make any selections in the Print dialog box and click OK.

Note: You may get error messages about insufficient disk space during printing. This is
because your Startup disk does not contain enough free space. If the amount of free space
on your Startup disk is insufficient, you will probably get other errors not specifically
related to printing. The amount of free space you need is determined by the size and
complexity of jobs that you print. If you do not get insufficient disk space messages, then
you have enough free space.

When you print, the LaserWriter 8 driver makes a copy of the document before sending it
to the Elite 12ppm. This copy is temporarily saved onto the Startup disk. If the Startup disk
does not contain free space equal to the size of the document, you will get an error.

Selecting Page Setup options

Most applications have a Page Setup menu command. This allows you to control how a
page will look. There is a pop-up menu at the top left of the dialog box which lets you
change various items to do with page setup.
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Page Attributes

Paper
You select paper sizes in the Paper pop-up menu. The default paper size is US Letter Edge
to Edge. To change the paper size, click the Paper pop-up menu, drag the pointer to the
paper size you want, and release the mouse button. If you click on the  menu again, you’ll
see a check mark next to the current paper size. If you choose a paper size that is not edge
to edge, anything closer than .35 inches (8.9 mm) from the edge of the paper will not print.

If you click on the “Dogcow” icon at the left of the dialog box, the icon will change to a list
of paper and margin dimensions in inches. Click again to see the dimensions in centime-
ters.

Edge-to-edge printing
You can print edge-to-edge with all supported paper sizes. Print quality is not guaranteed
within 4mm (0.16 inches) of each edge.

Orientation
You can change the orientation of the print on the page using the Orientation icons.

Scale
You can print the contents of a page from 25 to 400 percent of its normal size, using the
Scale option. Enter a figure between these ranges (in 1 percent increments). The default is
100 percent, meaning there is no reduction or enlargement.

Options
If you choose PostScript Options from the Page Attributes pop-up menu, you’ll see addi-
tional layout and formatting options. (Note:   indicates an Elite 12ppm default setting.)
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Visual Effects
You can manipulate the image on the page using the visual effects section. Your selections
are graphically displayed in the image area in the left of the dialog box.

Flip Horizontal flips your document horizontally.

Flip Vertical flips your document vertically.

Invert Image inverts the image of your document. Black changes to white and white
changes to black.

Image and Text
Substitute Fonts prints high quality resident fonts for certain screen fonts. When you
select this checkbox, the following substitutions occur:

Times® for New York Helvetica® for Geneva Courier for Monaco

Smooth Text smooths the edges of text derived from screen fonts.

Smooth Graphics smooths the edges of bitmapped graphics.

Precision Bitmap Alignment allows you to print bitmaps with less distortion, but the
document will print at a slightly smaller size (1% to 4% depending on the printing
resolution).

If you check Unlimited Downloadable Fonts in a Document you can use as many
downloadable fonts as you need in a document, but it may take longer to print.

Selecting Print options

When you select Print from the File menu, you see a dialog box offering you printing
options. You’ll also see the name of the printer at the top of the dialog box. When you click
Print, you send the document to the Elite 12ppm. Clicking Cancel cancels the print job.

If you make changes in the Print dialog box, some of these changes stay in effect until you
change them again. Others revert to the default settings the next time you print.
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The pop-up menu named “General” gives you other options for printing.

 Copies

Use the Copies option to specify the number of copies of the document to print, from 1 to
999. The default is 1 copy. To change the number of copies, click in the box and type the
number of copies you want to print.

Pages
The Pages option default is All, which prints all the pages in the document, from first to
last. From and To allow you to specify a range of pages to print. Click the button labeled
From and type the page numbers of the range you want to print into the boxes (for ex-
ample, From 9 and To 11 prints pages 9, 10 and 11).

Paper Source
The Paper Source pull-down menu lets you choose which paper trays supply paper to the
printer. For instance, you may want to print a business letter where the first page is on
letterhead and the remainder is on continuation sheets.

If you click on the All button, all pages will be fed from the source you select in the upper
pop-up menu. When the All button is selected, the lower pop-up menu is dimmed. If you
click on the First from button, this lets you choose which paper source is used for the first
page of your document. When First from is selected, you can choose another paper source
from the lower pop-up menu for the remaining pages.

If you choose Auto Select, paper is drawn from the tray (in the case of multiple trays)
that contains the paper size selected in the Paper option of the Page Setup dialog box.
If no optional trays are installed, Auto Select has no effect and paper will be drawn
from the internal tray.
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If you choose Tray 1, paper is drawn from the tray that is currently inserted in the
Elite 12ppm’s main housing.

If you choose Tray 2 , paper is drawn from this tray if the corresponding optional
sheet feeder and cassette is installed.

If you choose MPFeeder, paper is drawn from the multipurpose feeder.

If you choose Manual Feed, this bypasses the normal paper sources of the printer so
that you can place a single sheet of special paper or other media (e.g., transparency
film) into the multipurpose feeder for printing.

Destination
The Destination pop-up menu lets you to send your document to the printer or save it to a
file.

Background Printing
This allows you to choose whether your documents print in the foreground or background.
Foreground printing means that your Mac cannot be used until the last page is printed.

Background printing (recommended) stores the print file on your hard disk and sends it
from there to the printer. This method is slightly slower than foreground printing, but it
lets you use your computer before printing is completed.

You can also control the time when your job is printed.

Cover Page
If several people share your printer on a network, you may find that printing a cover page
lets you identify the beginning and end of your print job from a stack of jobs in the output
tray.

If you select Cover Page, an extra page (identifying the document) is printed. The cover
page contains: the user name, as specified in the Chooser; the name of the document, if
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there is one; and the date and time the document was printed. If you choose the None
option, no cover page is printed. If you choose either Before or After Document, a cover
page will print in the appropriate position.

Color Matching
The Color Matching pop-up menu allows you to specify grayscale or black and white
printing.

If you choose Black and White, you get black and white output (no shades of gray).
Darker areas are converted to black, and lighter areas are converted to white.

If you choose Color/Grayscale, you get grayscale output. Color images have colors
substituted by gray shades.

If you choose Color Matching, you get grayscale output that uses the advanced color
matching capabilities of ColorSync or PostScript Level 2 to match the color and gray
tones on the computer screen as closely as possible.
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Layout
This option lets you print 1, 2 ,4,6, 9, or 16 pages on a sheet and resizes the images to fit. It
also lets you choose a border to use between pages on a sheet.

Error Handling
The Error Handling dialog box allows you to specify how any PostScript errors are re-
ported during printing.

If you choose No Special Reporting, no PostScript error reports are produced.

If you choose Summarize on Screen, you’ll see a message describing any PostScript
errors on the monitor. This option does not work when Background Printing is on.

If you choose Print Detailed Report, you’ll get a printed report describing any
PostScript errors.
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Save as File
This dialog box (not shown) lets you select options for print jobs that you save to the hard
disk as files.

Printer Specific Options
You can choose the output resolution (in dots per inch) for the current print job. This
overrides the default resolution that was specified in the printer’s control panel using the
Resolution submenu.

You can also choose to enable (recommended) or disable AccuGray. AccuGray is GCC’s
technology to control the tendency of laser images to print darker than expected.

Save
If you find that you’re often changing the Printer’s Default options, you can save your
settings by clicking the Save Settings button. Your saved settings will carry over to any
application that uses these LaserWriter 8 menus.

Manual feed printing

The LaserWriter 8 driver supports manual feed printing.

When you want to manually feed paper, envelopes, or transparencies into the printer:

1. Choose Print from the computer’s File menu.

2. Choose Manual Feed from the Paper Source pop-up menu.
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3. Click the Print button.

The message, Manual Feed, appears in the printer’s control panel display to indicate
that the printer is ready for you to insert the paper. The control panel display also
indicates the paper size and orientation.

4. On the printer, open and extend the multipurpose feeder.

5. Adjust the paper guides on the multipurpose feeder for the size of the paper
that you are using.

6. Insert the paper into the multipurpose feeder. (Insert letterhead face up, with
the top of the page entering the printer first. Insert envelopes with the flap
down and the top edge on the right as you face the front of the printer.)

7. Press the Manual Feed key on the control panel.

Note: If you realize that you want to use paper in the internal paper tray, do not insert
paper into the multipurpose feeder, and press the Form Feed/Continue key on the control
panel. If you insert paper into the Multipurpose feeder and you do not press the Manual
Feed key within the Manual Feed Timeout period, the job will be canceled. The default
Manual Feed Timeout period is five minutes, and you can change this through the printer’s
control panel menus to be in the range from 30 seconds to ten minutes.

Naming the Elite 12ppm

You must assign each printer a unique name if there is more than one Elite 12ppm on the
network. If you don’t assign a unique name to each printer, a number is automatically
added to duplicate names to distinguish the printers from one another.

Note: If you change the name of a printer on the network system, every user on the net-
work system must select the new printer name in the Chooser.

If you want to name the Elite 12ppm:

1. Select the Elite 12ppm in the Chooser. Click the LaserWriter 8 icon in the left
scroll box and click the name of the printer in the “Select a LaserWriter” scroll
box.

2. Double-click the LaserWriter Utility icon. (The LaserWriter Utility is located on
the startup disk in the Elite™ 12ppm Folder.) You’ll see the LaserWriter Utility,
with four menus in the menu bar.

3. Choose Name Printer from the Utilities menu. The “Rename the chosen printer”
dialog box appears displaying the current name of the printer.
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4. Type the new name of the printer in the space provided. Names must be at
least two characters in length, but no more than 31 characters. Names cannot
contain a colon (:), an asterisk (*), or parentheses.

5. Click Rename.

6. Choose Quit from the File menu.
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4: Using Windows 3.1

Overview
You set up your Windows or DOS computer to use the Elite 12ppm by installing the Elite
12ppm software for PC-compatibles. This software is on this CD-ROM.  It includes
customized Windows PostScript printer drivers for Windows 3.1 (and Windows for
Workgroups 3.11), Windows 95 and Windows NT 3.51 and 4.0. It also has printer descrip-
tion files that let you use all the printing and paper handling features of the Elite 12ppm.

This and the following sections detail installation and printing instructions for Windows
3.1, Windows 95, Windows NT 3.51, Windows NT 4.0, and DOS. Information on net-
working printers  with Windows is in the Networking section of this manual.

Important: Read the release notes contained in the README.TXT file before installing the
printing software. This file includes important last-minute feature and compatibility
information about the Elite 12ppm.

Printing with Windows 3.1
If you want to install the GCC Windows 3.1 PostScript driver:

1. Switch on the PC.

2. Start Windows.

3. Double-click the Main group from the Program Manager window. You’ll see
the Main group window.

4. Double-click the Control Panel icon. You’ll see the Control Panel window.

5. Double-click the Printers icon. You’ll see
the “Printers” dialog box.

6. Click the Add button.

7. The dialog box expands, and shows you a
list of printer drivers in the “List of Print-
ers” list box. These are the printer drivers
that came on the disks you received with
your Windows software. Select Install
Unlisted or Updated Printer and click the
Install button.

Download from Www.Somanuals.com. All Manuals Search And Download.



4-2

8. The “Install Driver” dialog box appears
displaying the message, “Insert unlisted,
updated, or vendor-provided printer driver
disk in:” along with the A:\ or B:\ prompt.
Change the A:\ or B:\ to the letter of your
CD-ROM drive (for example, to D:\). Add
the directory WIN31 so that the prompt
reads D:\WIN31, for example.

9. Insert the Elite 12ppm CD-ROM into the CD drive and click OK in the dialog box.
You’ll see the “Add Unlisted or Updated Printer” dialog box with a list of Elite
12ppm printer drivers. Select a driver and click OK.

10. You’ll see the “Printers” dialog box. Select the driver for your Elite 12ppm
model.

11.  After the driver is installed, you’ll see the
“Printers” dialog box again. GCC Elite
12ppm appears in the “Installed Printers” list
box with LPT1 (which is the first parallel
port) designated as the default port. Select
the GCC Elite 12ppm printer driver in the
“Installed Printers” list box and click Set As
Default Printer. The Elite 12ppm is now set
as the default printer and will appear in the
“Default Printer” area of the “Printer”
dialog box.

Choose Use Print Manager to enable print spooling. With print spooling, you have
the full use of your computer after you press the Print button rather than waiting until
the print job is completed. This option allows your documents to print in the back-
ground. Background printing is useful when printing large or multiple documents,
but documents do not print quite as fast.

12. Click Close, unless you want to change printer options (see the next section,
“Setting Windows 3.1 Printer Options”).

You can now print from your computer to the Elite 12ppm.

You may also need to install printer description files if you use certain applications that
require them. Go to the section “Installing printer description files.”
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Setting Windows 3.1 printing options

Now you have installed the printer software in Windows, there are a number of settings
that you may need to change if you have special printing requirements. Most users do not
need to change these settings.

If you want to change print options:

1. Click Setup in the “Printers” dialog box. You’ll see the Setup dialog box.

Paper Source
You choose which paper tray supplies the printer from the Paper Source drop-down menu.

• If you choose Auto Select, the printer selects the paper tray that holds the paper size
selected in the Paper option of the Page Setup dialog box. This option only works if
you have more than one paper tray.

• If you choose Tray 1, the printer uses paper from the Elite 12ppm’s main tray.

• If you choose Tray 2, the printer uses paper from the lower tray (if this extra tray is
installed).

• If you choose Manual Feed, the printer waits for you to place paper or other media
(transparency film, for example) in the multipurpose feeder. When you have done
this, you must press the Manual Feed key on the printer’s control panel to draw the
paper into the printer.

• If you choose MPFeeder, the printer uses paper from the multipurpose feeder. Unlike
the Manual Feed option, the printer doesn’t require you to press the Manual Feed
button on the control panel, but you must have paper ready in the Multipurpose
feeder.

Paper Size
If you want to change the paper size, click the Paper Size drop-down menu, and choose the
paper size.
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Edge-to-edge printing
The Elite 12ppm will print edge-to-edge on all supported paper sizes except Letter Small
and A4 Small. However, print quality is not guaranteed within 4mm of each edge.

Orientation
Use this option to change the position of the image on the page. If you choose vertical, or
Portrait, this prints the image upright on the page. If you choose horizontal, or Landscape,
this prints the image sideways on the page. The default is Portrait.

Note: If you create a document and specify in the application’s page setup that it should be
vertical, then if you choose Landscape in this dialog box the image will be cut off at the
bottom.

Copies
If you want to print more than one copy, enter the figure here. The maximum number of
copies is 999.

Options
To make further changes, click on the Options button. You’ll see the Setup Options dialog
box.

• Print to ...

If you choose Print To Encapsulated PostScript File, the document is not printed but
is saved in the location you specify as an (EPS) file. You may need to do this if you
send files to a service bureau or want to make a page into a graphics file.

• Scaling % ...

If you change the Scaling figure from the default 100 percent, the image is reduced or
enlarged on a page. If you select 50 percent, the image prints at half size; if you select
200 percent, the image prints at double size.

Note: We recommend that you use the application’s Scaling option and leave the
figure in the Print Options dialog box at 100 percent, unless an application does not
support scaling. If you set both this dialog box and the application’s Print dialog box
to scaling percentages other than 100 percent, you’ll get unpredictable results.

• Margins ...

If you choose Default Margins, certain applications will be limited to placing page
elements (i.e., text and graphics) within the page’s margins. This is only important if
you are using Letter Small or A4 Small paper sizes, since the other sizes are all edge-to-
edge and thus have no margins. Letter Small and A4 Small have margins of .35 inches
(9 mm) all around.
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If you select Default, the printer will tell your applications that these margins exist on
Letter Small and A4 Small. If you select None, your applications will be told that there
are no margins. However, the printer will not reproduce any text or graphics in the
margin area.

• Send Header ...

If you choose Send Header, a PostScript header will be sent at the beginning of each
print job you send to the printer. This is especially useful if you are printing to a
networked printer.

• Smoothing ...

Select either printer’s default, enabled or disabled. If you select the printer’s default
option, the Elite 1212 default (either enabled or disabled) will be used. If you enable
smoothing here, Windows 3.1 will smooth text and graphics.

Advanced Options

To make more changes, click Advanced to see the Advanced Options dialog box.

• You can set a default resolution for this computer by choosing the output resolution
(in dots per inch) from the Resolution menu. The resolution you select overrides the
resolution selected in the printer’s front panel Default Resolution submenu.

You may have a computer on a network that is used for work which can be printed at
lower resolutions than the maximum. For instance, spreadsheets and internal docu-
ments can usually be printed satisfactorily at 300 dots per inch. You can set the resolu-
tion in the Advanced Options dialog box and override this as necessary in an
application’s Page Setup or Print dialog boxes.

• You need to change the Virtual Memory setting when you add RAM to the printer or
if you routinely download fonts to the printer’s memory. The figure sets the amount
of virtual memory that will be available for printing. The amount of memory that can
be allocated depends on the amount of
RAM installed in the printer.

Full instructions on how to change this
figure are included in the Adding RAM
section of the Elite 12ppm CD-ROM.

Port assignment – Windows 3.1

You may need to change the port used by your
PC; your PC’s LPT1 may be used by another
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device or you may wish to use a serial port. (GCC recommends that you use one of the LPT
[parallel] ports, because they are considerably faster than a serial port.)

If you want to change the port assignment:

1. In the Printers dialog box, select the GCC Elite 12ppm printer driver in the
“Installed Printers” list box (if it is not already selected).

2. Click Connect. You’ll see the Connect dialog box.

3. Select the new printer port assignment in the “Ports” list box. If the printer is
connected to a parallel interface, select one of the parallel ports (labeled LPT1,
LPT2, etc.). If the printer is connected to a serial interface, select one of the
serial ports (labeled COM1, COM2, etc.).

4. If you use a serial connection (as shown in step 3), click the Settings button.
(The Settings button is dimmed if the Elite 12ppm is connected via a parallel
interface.)

5. You’ll see the “Settings” dialog box, displaying the PC’s serial port default
parameters. Use the following: 19,200 Baud Rate, 8 Data Bits, None for Parity, 1
Stop Bit, and Hardware for Flow Control.

Note: The Elite 12ppm Windows driver is shipped with the baud rate set to 9600. If
you change the baud rate to 19,200, you will also need to change the baud rate in the
RS-422 Baud Rate submenu in the printer’s front panel to 19,200. Also, some versions
of DOS do not support 19,200 baud rate. If you frequently print from one of these
versions of DOS, leave the Windows serial port baud rate at 9600 to prevent commu-
nication problems.

6. You now need to verify the serial port settings, if the Elite 12ppm is connected
via its serial interface. Verify that the printer’s control panel serial port settings
match those set in the Windows “Settings” dialog box. Note that the Hardware
Flow Control setting in Windows corresponds to the DTR Flow Control setting
on the Elite 12ppm control panel.

7. Click OK to save the settings and return to the “Connect” dialog box.

8. Click OK to close the “Connect” dialog box.

9. Click Close to close the “Printers” dialog box.

10. Choose Close from the Control menu to close the Control Panel window.

11. Choose Close from the Control menu to close the Main window.
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Installing printer description files

Printer description files (file names with the following extensions: .PDF, .PDX, or .PPD)
are files that allow you to use Elite 12ppm-specific features from within specific applica-
tions. Please refer to the documentation included with the application for more informa-
tion on where to copy these files and how to use them.

To install printer description files:

1. Insert the Elite 12ppm CD-ROM into your CD-ROM drive.

2. At the root directory (C:\), type the following command and path name for the
application you are using and press the Enter key. (Note: Depending on where
you have installed any of these applications, the path names may be different).

• Adobe Illustrator 4.0 or 4.1:

Type copy d:\*.ppd c:\ai4\ppd  to install the PPD file.

• Adobe PageMaker 6.0:

Type copy d:\*.ppd c:\pm6\rsrc\usenglsh\ppd4\  to install the PPD file.

• Aldus FreeHand 4.0 or PageMaker 5.0:

Type copy d:\*.ppd c:\aldus\usenglsh\ppd4  to install the PPD file.

• Aldus FreeHand 3.1 and earlier:

Type copy d:\ppd3\*.* c:\aldus\usenglsh\ppds  to install the PPD and
PDX files.

• Macromedia FreeHand 5.0:

Type copy d:\*.ppd c:\fh5\usenglsh\ppd  to install the PPD file.

• QuarkXPress:

Type copy d:\*.pdf c:\xpress  to install the PDF file.

Printing from Windows 3.1 applications

The Elite 12ppm is designed to work with all Windows 3.1 (or higher) compatible applica-
tions. The GCC Windows driver provides commonly used printing options, along with
options specific to the Elite 12ppm.

The location of printing options can vary among Windows applications, and certain
options may be accessible from more than one dialog box. Options may also have different
names than those in the Printers control panel (e.g., print quality vs. resolution). Refer to
the application’s documentation for more information.
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Selecting Print Setup options
The Print Setup option is usually located under the File menu. The following Print Setup
dialog box example is taken from Microsoft Write.

Note: Applications use different terminology to refer to the Print Setup dialog box. For
example, Microsoft Word® uses Print Setup and Adobe PageMaker uses Target Printer or
Print (depending on the version). These commands are usually found on an application’s
File menu; for more information, refer to the documentation provided with the application
you are using.

Selecting Print options
The Print option is usually located under the File menu. The following print dialog box
example is taken from Microsoft Write.

Print Range
The Print Range option default is All, which prints all the pages in the document, from first
to last. From and To allow you to specify a range of pages to print. Click in the box labeled
From and type the first page number of the range you want to print. Then click in the box
labeled To and type the last number of the range. The Print Range option is the only
option which cannot be set through the Print Manager or Printers control panel.

Print Quality
The Print Quality option is identical to the Resolution option found in the Advanced
Options dialog box. The resolution selected in this menu will override the resolution
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selected in the Print Manager and/or the printer’s front panel Default Resolution submenu.
After you have made your selection in the Print dialog box you can click OK to print your
document or Cancel to close the dialog box.

Print to file
The Print to File option allows you to save your document to a PostScript file. This file can
then be sent to the printer with the DOS COPY command. If your application does not
have a Print to File option you can still print to a file by selecting the File: option available
from the Ports list box in the “Connect” dialog box. Refer to Windows Help for more
information.
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5: Using Windows 95
Windows 95 printing software overview

You set up your Windows 95 computer to use the Elite 12ppm by installing the Elite
12ppm software for Windows 95. This software is on the Elite 12ppm CD-ROM.

Windows 95 uses a Wizard to help you install printer software. A Wizard is a series of
dialog boxes. In each dialog box you make configuration choices then click the Next button
to move to the next dialog box.

Part of the software that you need is contained on the Windows 95 CD-ROM
or floppy disks. Make sure you have the disk(s). If you cannot locate the
disk(s) or your computer was not supplied with them, follow the special
instructions when you reach step 15.

Plug and Play installation

You can install the Elite 12ppm software on your computer using Plug and Play. This will
work if you are installing the software on the computer which is connected to the printer
through the parallel port.

If the printer is not connected to the computer through the parallel port, go to the section
“Using Add Printer” below.

To use Plug and Play to install the software on the computer, connect the parallel port of
the computer to the parallel port interface on the printer using an IEEE-1284 parallel cable
(it will be stamped “1284”). Turn on the printer and place paper in the paper tray. Then:

1. Start the computer if it is not turned on, or go to Shut Down on the Windows
95 Start menu and choose “Restart the computer.”

2. The computer will go through the normal startup proceedures and then show a
dialog box telling you that it has found new hardware.

3. You'll then see a dialog box which asks you to select which driver you want to
install. Choose the option “Driver from disk provided by hardware manufac-
turer” and click OK.

4. Go to step 8 of the numbered steps in the “Using Add Printer” section.

Using Add Printer

To install the printing software without using Plug and Play, make sure that the printer is
switched on, has paper, and is connected to the computer or network.
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To install the printing software, make sure that the printer is switched on, has paper, and is
connected to the computer or network. Then:

1. Click on the Start button in Windows 95.

2. You’ll see the Start menu. Click on Settings, then click on Printers on the
submenu.

3. You’ll see the Printers folder. Double-click the Add Printer icon.

4. You’ll see the first screen of the Add Printer Wizard dialog box. Click the Next
button at the bottom of the dialog box. If you see a list of printer manufactur-
ers and printer models, go to step 7. Otherwise, you’ll see the local/network
dialog box.

• Choose a connection:

- Select Local if your printer is attached
directly to your computer, even if you
may intend others to use it through a
network.

- Select Network only if your printer is
not attached directly to your com-
puter.

• If you selected Local, click Next and go
to step 7. If you selected Network, click
Next and go to the next step.

5. You’ll see the network path dialog.

• Type in the path or queue name of
the printer. You can click Browse to
display a visual representation of your
site’s network and the printer’s
location on it.

• Click the Yes radio button if you
print from MS-DOS based programs.

If you selected No for the MS-DOS print-
ing question, click Next and go to step 7. If
you selected Yes, click Next and go to the
next step.
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6. You’ll see a dialog box that lets you
print from MS-DOS applications to a
network printer. Click the Capture
Printer Port button and select an
appropriate LPT port and print
queue. Click OK.

• Click Next.

8. You’ll see the Install From Disk
dialog box.

• Change the drive letter in the box at the
bottom of the dialog box to the drive
letter of your CD-ROM drive.

9. Put the Elite 12ppm CD-ROM into the
CD-ROM drive of your computer, wait
for a few seconds, then click the OK
button.

10. You’ll see a dialog box with the names
of one or more Elite 12ppm printers.

• Select your Elite 12ppm printer model from
the list.

If you selected Network in step 4, click Next and
go to step 14. If you selected Local, click Next to
go to the next step.

7. You’ll see the manufacturer/model
selection dialog box.

This dialog box contains lists of printer
manufacturers and their printer models.

• Ignore the settings in the boxes, and
click the Have Disk button.
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11. You’ll see the port selection dialog box.

GCC printers can accept jobs from either an LPT
(Parallel) port or a COM (Serial) port. We
recommend that you use a parallel port (LPT)
wherever possible.

• Choose a port, then click Configure Port.

This is what you’ll see if you chose a COM
port. We recommend that you use these
settings.

Note: The serial port settings in the
printer’s control panel menus must match
the settings in this dialog box. Check the
settings and change them if necessary. The
serial port’s Baud Rate submenu corre-
sponds to the Bits per second drop-down
list box in the dialog box. The DTR setting
in the Flow Control submenu is the same
as the Hardware setting in the dialog box.

• Click OK.

13. You’ll see the port selection dialog
box again.

• Click Next.

12. You’ll see a configuration window,
specific to the type of port you chose
(LPT or COM).

This is what you’ll see if you chose an LPT
port. We recommend that you check all
available check boxes.
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14. You’ll see the name printer dialog
box.

• You can enter a new name for your
printer if you wish, or you can leave
the default name. Also, at this point
you should decide whether you want
to make this the default printer. If
you say Yes, the Elite 12ppm will be
the printer selected every time you
print from a Windows application.

• Click Next.

• The software installation will now commence. At one point, a dialog box will ask you
to insert either the Windows 95 CD-ROM or the Windows 95 floppy disk that con-
tains the printer driver. The kind of disk you need depends on whether Windows 95
was originally installed with a CD or floppy disks.

- If you are prompted to insert a CD, remove the Elite 12ppm CD-ROM,
insert the Windows 95 CD, and click OK.

- If you are prompted to insert a floppy disk, insert the appropriate Windows
95 floppy disk into the drive and click OK.

If you do not have Windows 95 on disk, or the installation process halts because a file
cannot be found, go to the section “Solutions to possible software installation prob-
lems” immediately after these numbered steps.

15. You’ll see the Print a Test Page
dialog.

• Change the setting to No. Because
you have to make changes after the
software is installed, we recommend
that you don’t choose to print a test
page yet. You’ll print a test page when
the installation is complete.

• Have your Windows 95 CD or disks
ready, and click Finish.
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16. When the installation is complete, you’ll see the Printers folder, including an
icon for the newly installed printer.

• Using the right mouse button, click on the printer’s icon. Select Properties from the
pop-up menu.

17. You’ll see the printer’s Properties dialog box.

• The next steps are for network printers only. If you
connected your printer using the parallel port go to
step 21.

18. Click the Capture Settings tab at the top of the
dialog box.

19. You’ll see the Capture Settings panel. Deselect all
the checkboxes, as shown.

20. Click Apply.

21. Click on the General tab at the top of the dialog
box.

22. Click Print Test Page.

The test page will be formatted and a message box will
appear asking you if the test page printed successfully. If
the test page printed (this may take a minute), click Yes.

If the test page does not print, check that the printer is
turned on and does not show an error message in its
control panel. Make sure there is paper in the printer and
all cables are properly connected. If there is still a prob-
lem, click No in the message box. Windows 95 will
display troubleshooting steps.

If your page printed correctly, you’ve completed the normal installation process. You may
need to install printer description files if your applications need them. Read the section
“Installing printer description files” later in this chapter.

A few users may have special printing requirements; for instance, they may have added
extra paper trays or more memory to their printer, or want the default resolution or paper
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size to be different from the factory default settings. Read the section “Exploring the Prop-
erties dialog box” later in this chapter.

The next section, “Solutions to possible software installation problems,” refers only to
problems users may encounter in step 15 of the installation process. If you completed step
15 without problems this section does not apply to you.

If none of these situations applies to you, you’ve completed installing the printer software
on this computer. Install the software on any other computers that will use the printer, and
the printer is ready to use.

Solutions to possible software installation problems

In some cases you may not be able to complete the software installation process when you
click the Finish button in step 15. Normally, the program stops and asks you to insert a
Windows 95 floppy disk or the CD-ROM. Once you have removed the Elite 12ppm CD-
ROM (if necessary) and inserted the Windows 95 disk, the program continues and the
installation is complete.

Two things may prevent this:

• You may have a Windows 95 computer that was not supplied with the program on
floppy disks or CD-ROM.

• In some cases you may find that after you have inserted the Windows 95 CD-ROM in
the drive and clicked OK, the printer installation does not continue and you’re
prompted to insert the Windows 95 CD-ROM again.

The installation process requires you to install files that are found on the Windows 95 CD-
ROM or disks. Some versions of the Windows 95 CD-ROM have these files in different
places than others, and you have to show the install program where these files are located.

If you use the original Windows CD-ROM that came with your computer this problem
should not arise.

If you do not have Windows 95
on disk or CD-ROM, continue
the installation in
this way:

1. Click on the Browse
button at the bottom
right of the Copying Files
dialog box.
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2. In the Open dialog box, choose drive C
in the Drives window at the bottom
center.

3. In the Folders list, scroll down till you
see the windows folder.

4. Click on the folder name “windows”
then click OK.

5. In the Folders list, scroll down until you
see the options folder.

6. Click on the folder name “options” then click OK.

7. Click on the folder name “cabs.”

8. Click OK to accept this folder. You’ll see a file name similar to win95_15.cab.

9. Click OK again to accept this file name.

10. Click OK in the Copying Files dialog box.

11. The installation will continue. Go back to step 16 in the installation instructions.

If you have a Windows 95 CD-ROM and the installation still does not continue, you’ll see
the Copying Files dialog box again.
Make sure that you have the Win-
dows 95 CD-ROM in the drive and
continue the installation:

1. Click on the Browse button at
the bottom right of the
Copying Files dialog box.

2. In the Open dialog box, scroll
down the list of folders in the center
pane until you see a folder called
win95.

3. Click on the folder name win95.

4. Click OK to accept this folder. You’ll
see a file name similar to
win95_15.cab.

5. Click OK again to accept this file name.
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6. Click OK in the Copying Files dialog box.

7. The installation will continue. Go back to step 16 in the installation instructions.

Exploring the Properties dialog box

Now that you have installed the printing software in Windows 95, there are a number of
settings that you may need to change if you have special printing requirements. Most users
will not need to make any changes here.

Most of the Properties dialog box contains options that are the same for all printers using
Windows 95, so this section of this installation guide only covers the options provided by
GCC. If you want information on options for all Windows 95 printers, please refer to the
Windows 95 on-line help system and Windows 95 documentation.

The changes you make in the Properties dialog box affect all applications, but on this
computer only.

If you don’t already have the Properties dialog box displayed:

1. Click on the Start button. You’ll see the Start menu.

2. Choose Settings, then choose Printers from the submenu that appears.

3. You’ll see the Printers window. Use the right mouse button to click on the Elite
12ppm icon, and choose Properties from the pop-up menu.

The Properties dialog box has tabs across the top. Click on the tabs to see other pages. Each
page has options to configure your printer.

If you configured your printer as a local printer, you’ll see a tab called Sharing. If you
configured your printer as a network printer, the Sharing tab is replaced by a Capture
Settings tab. Otherwise the tabs are the same.

You use Sharing if you want to share your printer and files over a network. This page
of the dialog box is the same on all Windows 95 comput-
ers; further details can be found in the Windows 95 on-
line help and documentation.

If you configured the printer for a network, you’ve al-
ready made the necessary changes to the Capture Settings
page.

The Device Options page

Click on the Device Options tab to see the Device Options
page. This page contains settings specific to your GCC
printer model.
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Printer features
In the Printer features box you’ll see options specific to your printer. If you want to change
the current setting of any feature, click on its name in the upper box. You’ll see settings in
the “Change setting for” drop-down list box below. Click on the setting you want.

Note: The features you see in the list may vary between printer models.

Installable options
If you add options (like more paper trays or extra printer RAM), you need to change the
Installable options list. After you have changed this option, Print dialog boxes in this
computer’s applications will show extra paper trays, for example.

Note on VMOption: The VMOption selection corresponds to the amount of RAM installed
in the printer. If you add or subtract printer memory, you will need to change the amount
shown under VMOption. If memory was added to your printer before you installed the
Windows 95 printer software, you will need to change the VMOption amount.

If you have to change the printer memory size, click on VMOption and select the correct
memory size from the drop-down list box. Answer Yes to the question about available
printer memory. Also, see the following section on upgrading printer memory.

Updating printer memory
If you install additional memory in your printer, you must update the printer driver. You
do this by adjusting the Available printer memory setting at the top of the Device Options
page. When the Available printer memory figure is correct, your computer will send files
that print faster.

If you routinely download more than one or two fonts to the printer’s memory, you should
also update your Available printer memory, even if you have not added any extra memory
to the printer. Download your normal font set and then update the memory.

If you want to update the printer driver, you first have to copy a file to the printer, using a
DOS window (do not use Windows 95’s Print command). This prints a page that tells you
the maximum suggested virtual memory for the printer. You then enter the figure in this
dialog box.

1. Copy the file TESTPS.TXT to the printer. This file is included with Windows 95.

• Click on the Start button, then choose Programs from the Start menu. Click on MS-
DOS Prompt in the program list; you’ll see a DOS window.

• Type:

copy c:\windows\system\testps.txt lpt1
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• Press the Enter key, type exit  and press the Enter key again to close the DOS win-
dow.

The printer will produce a page which shows the maximum available virtual
memory and the maximum suggested virtual memory. Use the suggested value
(Max Suggested VM ).

2. Enter the new suggested value into the Device Options page in the box labeled
Available printer memory (in KB).

The Details page

You can change the printer driver and port settings in the Details page.

The Paper page
You can change paper sizes, layout, orientation, and
paper source in the Paper page. Any changes you make
will override the settings in the printer’s control panel
for this computer only.

Paper size
You can set a default paper size by picking a new setting
in the paper size box. You can scroll to the right of this
box to see more paper sizes. Click on the icon of the
paper size you want to be the new default.

Only the first few characters of the name of the paper
size are shown beneath each icon. If you click on an icon
you’ll see the full name above the box. However, the
paper size you click on will now be the default, unless you click on another paper size icon
or click on the Cancel button at the bottom of the dialog box.

Paper source
You can set a default paper source by choosing from the Paper source drop-down
list box. These options specify how paper will be provided to the printer. There are selec-
tions for:

• Auto Select.

• Any installed paper trays.

• Manual feed.

• The multipurpose feeder.

We recommend that you leave other features at their default settings.
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Remember that any changes you make anywhere in this page of the dialog box become the
default selections for all applications on this computer.

The Graphics page

You can change aspects of the way your documents look in
the Graphics page. Any changes you make will override the
settings in the printer’s control panel for this computer
only.

Resolution
You can change the output resolution of your documents
in the resolution drop-down list box. If some computers on
a network are not used for documents that need a high
resolution, you can set the resolution to the lowest setting
(typically 300 dots per inch). Documents printed at low
resolution print faster than those printed at high resolution.

The figure you set here becomes the default setting for the dialog boxes in applications on
this computer. All resolutions that the printer supports are still options within application
dialog boxes, so you can select higher resolutions if necessary.

Halftoning
This section controls the look of any photographs in your document. We recommend that
you choose Use printer’s settings.

The only time you might need to change these settings is if you print a file to disk before
taking it to a service bureau. Your service bureau can advise you on the settings you should
use.

The Fonts page

The Fonts page enables you to specify how fonts are sent
to the printer.

We recommend you use the default settings.

The PostScript page

The PostScript page provides settings for controlling the
way print jobs are sent to the printer.

We recommend you use the default settings.
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Installing printer description files

Some graphics applications need more information about the printer than the standard
printer software provides. This extra information comes in files known as printer descrip-
tion files. You must copy one or more of these files from the Elite 12ppm CD-ROM into a
specified folder in your application folder.

Printer description files have the following extensions: .PDF, .PDX, or .PPD. Please refer to
the documentation included with the application for more information on where to copy
these files and how to use them.

If you want to install printer description files, you can use Windows Explorer or open a
DOS window.

Installing printer description files using Windows Explorer
1. Insert the Elite 12ppm CD-ROM into your CD-ROM drive.

2. Open Windows Explorer and choose Details from the View menu.

3. In the left pane, find the CD-ROM icon and click on it. You’ll see the files con-
tained in the root directory of the CD-ROM.

4. Click on the Type button at the top of the column in the right pane. The files
are sorted into order by type (three-letter extension).

5. Follow the instructions below for each application you wish to install printer
description files for.

• Adobe Illustrator 4.0 or 4.1:

a. Select all files that end in .ppd .

b. Choose Copy from the Edit menu.

c. Locate the Ai4 folder in the left pane (you may have to click on the plus sign next to
a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
PPD folder.

e. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Adobe PageMaker 6.0 (or 6.5):

a. Select all files that end in .ppd .

b. Choose Copy from the Edit menu.
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c. Locate the Pm6 (or Pm65) folder in the left pane (you may have to click on the plus
sign next to a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
Rsrc folder.

e. Double-click on the Usenglsh folder, then double-click on the Ppd4 folder.

f. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Aldus FreeHand 4.0 or PageMaker 5.0:

a. Select all files that end in .ppd.

b. Choose Copy from the Edit menu.

c. Locate the Aldus folder in the left pane (you may have to click on the plus sign next
to a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
Usenglsh folder.

e. Double-click on the ppd4 folder.

f. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Aldus FreeHand 3.1 and earlier:

a. Open the Ppd3 folder on the Elite 12ppm CD-ROM.

b. Select all files in this folder.

b. Choose Copy from the Edit menu.

c. Locate the Aldus folder in the left pane (you may have to click on the plus sign next
to a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
Usenglsh folder.

e. Double-click on the Ppds folder.

f. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Macromedia FreeHand 5.0:

a. Select all files that end in .ppd .

b. Choose Copy from the Edit menu.
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c. Locate the Fh5 folder in the left pane (you may have to click on the plus sign next to
a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
Usenglsh folder.

e. Double-click on the Ppd folder.

e. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• QuarkXPress:

a. Select all files that end in .pdf .

b. Choose Copy from the Edit menu.

c. Locate the Xpress folder in the left pane (you may have to click on the plus sign next
to a drive letter).

d. Click on this folder to show its contents in the right pane.

e. Choose Paste from the Edit menu. You’ll see the pdf files in the window (you may
have to scroll to see them). The files are installed.

Installing printer description files using an MS-DOS window

1. Insert the Elite 12ppm CD-ROM into your CD-ROM drive.

2. Click on the Start button, and choose Programs from the Start menu.

3. You’ll see the programs installed on this machine; click on MS-DOS prompt and
a DOS Window opens.

4. Type the following command and path name for the application you are using
and press the Enter key. These examples assume that your CD-ROM is drive D:
and your application is on drive C: If your CD-ROM uses another drive letter, or
your application is not on drive C:, change the drive letters accordingly (for
example, if your CD-ROM is drive E: and Adobe Illustrator is on drive D:, the first
example should read copy e:\*.ppd d:\ai4\ppd ).

• Adobe Illustrator 4.0 or 4.1:

Type copy d:\*.ppd c:\ai4\ppd  to install the PPD file.

• Adobe PageMaker 6.0:

Type copy d:\*.ppd c:\pm6\rsrc\usenglsh\ppd4\  to install the PPD
file.
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• Aldus FreeHand 4.0 or PageMaker 5.0:

Type copy d:\*.ppd c:\aldus\usenglsh\ppd4  to install the PPD file.

• Aldus FreeHand 3.1 and earlier:

Type copy d:\ppd3\*.* c:\aldus\usenglsh\ppds  to install the PPD and
PDX files.

• Macromedia FreeHand 5.0:

Type copy d:\*.ppd c:\fh5\usenglsh\ppd  to install the PPD file.

• QuarkXPress:

Type copy d:\*.pdf c:\xpress  to install the PDF file.

5. Type Exit and press the Enter key to close the DOS window.

Printing from Windows 95 applications

GCC printers are designed to work with all Windows 95 compatible applications. The Print
dialog box varies among applications, but all variations provide the common print com-
mands along with others that are available for that application only.

The printer’s control panel menus and the settings in the Properties dialog box provide the
default settings for an application’s Print dialog box.

Selecting print options
This is the Print dialog box for WordPad, a
simple word processing application in-
cluded with Windows 95. You’ll find the
Print command in the File menu of most
applications. You can change the target
printer, page range, and number of copies
in the main Print dialog box. You can also
click on the Properties button to make
further changes. Other applications may
provide more settings.
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The Print Properties dialog box
If you click on Properties in WordPad’s Print dialog box,
you’ll see this dialog box. This Properties dialog box is
similar to the Printer Properties dialog box, but there are
fewer pages.
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6: Using Windows NT 3.51
Windows NT printing software overview

You set up your Windows NT 3.51 computer to use the Elite 12ppm by installing the Elite
12ppm software for Windows NT 3.51. This software is on the Elite 12ppm CD-ROM.

Part of the software that you need is contained on the Windows NT 3.51 CD-ROM or
floppy disks. You must have the Windows NT 3.51 CD-ROM or floppy disks to
install the software for the Elite 12ppm.

To install the printing software, make sure that the printer is switched on and connected to
the computer or network, and that the computer is switched on and running Windows NT
3.51. Then:

1. Double-click the Main group from the Program Manager window.

You’ll see the Main group window.

2. Double-click the Control Panel icon.

You’ll see the Control Panel window.
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3. Double-click the Printers icon.

You’ll see the Print Manager window.

4. Select Create Printer from the Printer menu.

You’ll see the Create Printer window.

5. Insert the Elite 12ppm CD-ROM.

6. Select Other (from the bottom of the list) in the Driver drop-down list box.
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You’ll see the Install driver dialog box.

  Change A:\ to the drive letter of your CD-ROM drive.

7. Click OK.

You’ll see the Select Driver window, with one or more Elite 12ppm models.

8. If necessary, select a driver.

Select the driver for the model you are installing.

9. Click OK.

You’ll see a progress box. After a few seconds, the printer software is installed, and
you’ll see the Create Printer window again. This time it shows the driver for your Elite
12ppm printer.

At this point you must give the printer a name, and, optionally, enter a description. If the
printer is on a network, the description could be its location.

10. Go on to Section 2.
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Section 2 - Select and configure a communications port.

You must now select and configure a port. A port can be either a parallel port (also called
an LPT port), a serial port (also called a COM port), or you can select a network queue.

Printing using a serial port is very slow compared to using a parallel port or a network.

1. Select a port from the Print to drop-down list box.

2. Click Settings.

Depending upon the type of port you chose, some type of dialog box will appear.

• If you selected an LPT port: No settings are necessary.

• If you selected a Network print queue: Your network administrator or the network
software documentation has details of the settings you need to make in this dialog
box. A network print queue resides on a print server. Print queues are established with
the network software running your network. Any necessary settings will be specific to
the network software.

• If you selected a COM port:

You’ll see the Ports dialog box; the COM port you selected is highlighted.

• Click Settings

You’ll see the Settings dialog box.
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We recommend the above settings.

Note: The serial port settings in the printer’s control panel menus must match the settings
in this dialog box. Check the settings and change them if necessary (see the section of the
CD-ROM that deals with control panel menus). Note that the DTR setting in the Flow
Control submenu corresponds to the Hardware setting shown above.

• Click OK.

• Close the Ports dialog box.

You’ll return to the Create Printers dialog box.

3. Click OK.

In a few seconds you’ll see the PostScript Printer Setup Window.

• In the Form to Tray section, choose a paper tray and paper size. Your selections
should be the usual paper tray and paper size that will be used for print jobs. These
settings become the default settings in the Print dialog box of all applications that run
on this computer. You can override them from the Print dialog box.

• Select Use Printer Halftoning. Halftoning controls the screen frequency and screen
angle for your documents. We recommend that you select Use Printer Halftoning to
use the printer’s default screen frequency. Note that you can change the screen fre-
quency by using the Default Screens submenu in the printer’s control panel (see the
section of the CD-ROM that deals with control panel menus).
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4. Click OK.

You’ll see the Print Manager window, now showing an icon for the newly created
printer.

You are now ready to print. Most users will not need to make any further changes. You
may have special print requirements, or you may need to install PPD files for those applica-
tions that need them. You can change any of the settings by clicking once on the printers
icon, then choosing Properties from the Print Manager’s File menu.

This section of the CD-ROM deals only with those parts of the Properties that are specific
to GCC printers. For more general information, see the Windows NT documentation.

Selecting Page Setup and Print options

GCC printers are designed to work with all applications compatible with Windows NT
version 3.51 or later. The printing software provides commonly used printing options
along with some others (e.g. paper sizes and paper trays) that are specific to your GCC
printer model.

Printing options may be selected from within an application through the Print Setup and
Print dialog boxes, or from within the Windows NT Print Manager or the Printers control
panel. In general, options selected from within an application document will override
corresponding options in the printers control panel, Print Manager, and the printer’s
control panel submenus.

Most of the options found in the Print Setup and Print dialog boxes are standard to Win-
dows NT, while some are specific to your GCC printer model. This section details the
GCC-specific options. For information on other options, please refer to the Windows NT
on-line help system, and the Windows NT documentation.

The location of printing options can vary among applications, and certain options may be
accessible from more than one dialog box.  Refer to the application’s documentation for
further information.

Print Setup options
The Print Setup option is usually located under the File menu. The following Print Setup
dialog box example is taken from Microsoft Write.
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• Name - The Name drop-down list box enables you to select the printer that you wish to
send a job to. The printer that initially appears in the box is the default printer. The
default printer is set through the Print Manager.

• Size - The Size drop-down list box enables you to select a paper size. Available paper sizes
will differ between GCC printer models.

• Orientation - This option determines the orientation of the image on the page. Vertical, or
Portrait, orients the image upright on the page. Horizontal, or Landscape, orients the
image sideways on the page. The default is Portrait.

Print options
The Print command is usually located under the File menu. The following Print dialog box
example is taken from Microsoft Write.

• Print Range -The Print Range option default is All, which prints all of the pages in the
document, from first to last. From and To allow you to specify a range of pages to
print. Click in the box labeled From, and type the first page number of the range you
want to print. Then click in the box labeled To and type the last number of the range.
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7: Using Windows NT 4.0
Windows NT 4.0 printing software overview

You set up your Windows NT 4.0 computer to use the Elite 12ppm by installing the Elite
12ppm software for Windows NT 4.0. This software is on the Elite 12ppm CD-ROM.

Windows NT 4.0 uses a Wizard to help you install printer software. A Wizard is a series of
dialog boxes. In each dialog box you make configuration choices then click the Next button
to move to the next dialog box.

This installation guide does not cover connecting to a networked printer or making your
printer available for sharing by others. Details of these operations are contained on your
Windows NT 4.0 CD-ROM.

Important: Part of the software that you need is contained on the Windows
NT 4.0 CD-ROM. You must have the Windows NT 4.0 CD-ROM to install the
software for the Elite 12ppm.

To install the printing software, make sure that the printer is switched on and connected to
the computer or network. Also place the Elite 12ppm CD-ROM in your CD-ROM drive.
Then:

1. Click on the Start button.

2. You’ll see the Start menu. Click on Settings, then click on Printers on the
submenu.

3. You’ll see the Printers folder. Double-click the Add Printer icon.

4. You’ll see the local/network dialog box.

• Choose My Computer and click the Next button.
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5. You’ll see a list of ports.

• Select the port(s) you’ll be using and click
Next.

6. You’ll see a dialog box that lists makes
and models of printers. Ignore the set-
tings in these boxes and click the Have
Disk button.

7. You’ll see the Install from disk dialog
box.

• Change the drive letter in the dialog box to
the drive letter of your CD-ROM, and click
OK

8. You’ll see a dialog box with the names of
one or more Elite 12ppm printers.

• Select your Elite 12ppm printer model from
the disk, and click on the Next button.
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9. You’ll see the printer name dialog box.

• You can type a name or accept the name in
the box. Click Next.

10. You’ll see a dialog box that asks whether
you want to share this printer with
others. Choose Not Shared, and click
Next (Consult your Windows NT docu-
mentation for details on sharing your
printer with other users).

11. You’ll see the Print a Test Page
dialog.

• Change the setting to No. Because
you may have to make changes after
the software is installed, we recom-
mend that you don’t print the test
page at this point. You’ll print a test
page when the installation is com-
plete.

• Click Finish.

• The software installation will now
commence. At one point, you’ll be prompted to insert the Windows NT 4.0 CD-
ROM that contains the NT 4.0 printer driver.

12. When you see a prompt, remove the Elite 12ppm CD-ROM and insert the Win-
dows 4.0 CD-ROM. Click OK.

13. You’ll see the Locate File dialog box. Click Browse. The Windows NT CD-ROM
may run automatically if you have Autorun selected (the Windows NT default).
This opens a large Window over the screen; click on the close box at the top
right of the window.

• Select your CD-ROM drive. Choose the I386 folder.

• Choose the file called Pscript.dl_

• Click the Open button.
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14. You’ll see the Locate File dialog box again. Click OK.

• The printer software is now installed and you’ll see the Printers Window with your
printer icon in it.

15. Right mouse button click on this
icon, and choose Properties from
the list.

16. You’ll see the Properties tabbed
dialog box. Click on the Device
Settings tab at the top of the
dialog box.

• If your printer has options like extra
paper trays or more memory, you’ll
need to make changes here. See the
section “Device Options,” later in this
guide.

17. Click on the General tab at the top of
the dialog box.

18. Click Print Test Page.

The test page will be formatted and a message
box will appear asking you if the test page
printed successfully. Wait a few seconds to see if
the test page prints. If the test page printed,
click Yes; if there is a problem, click No (Win-
dows NT 4.0 will display troubleshooting steps).

If your page printed correctly, you’ve completed
the normal installation process. You may need
to install printer description files if your appli-
cations need them. Read the section “installing
printer description files” later in this guide.
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Exploring the Properties and Document Defaults dialog boxes

Now that you have installed the printing software in Windows NT 4.0, there are a number
of settings that you may need to change if you have special printing requirements. Most
users will not need to make any changes here.

You’ll make most of the changes in the Properties dialog box, but some settings are in the
Document Defaults. You can get to the Document Defaults dialog box by highlighting your
printer in the Printers window and choosing Document Defaults from the File menu.

Most of the Properties dialog box contains options that are the same for all printers using
Windows NT 4.0, so this section of this installation guide only covers the options provided
by GCC. If you want information on options for all Windows NT 4.0 printers, please refer
to the Windows NT 4.0 on-line help system and Windows NT 4.0 documentation. You can
also get information about an item in a dialog box by clicking on the question mark button
at the top right of most dialog boxes.

The changes you make in the Properties and Document Default dialog boxes affect all
applications, but on this computer only.

The Properties dialog box
If you don’t already have the Properties dialog box displayed:

1. Click on the Start button. You’ll see the Start menu.

2. Choose Settings, then choose Printers from the submenu that appears.

3. You’ll see the Printers window. Use the right mouse button to click on the Elite
12ppm icon, and choose Properties from the pop-up menu.

The Properties dialog box has tabs across the top. Click on the tabs to see other pages. Each
page has options to configure your printer.

The Device Settings page
Click on the Device Settings tab to see the Device Settings page. This page contains settings
specific to your GCC printer model.

In the Printer features box you’ll see options specific to your printer. If you want to change
the current setting of any feature, click on its name in the upper box. You’ll see settings in
the “Change setting” area below. Click on the setting you want to change.

Note: The features you see in the list vary between printer models. The Configuration Page
has details of the specific features in your printer.

If you add options (like more paper trays or extra printer RAM), you need to change the
Installable options list. After you have changed this option, Print dialog boxes in this
computer’s applications will show extra paper trays, for example.
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Note on VMOption: The VMOption selection corresponds to the amount of RAM installed
in the printer. If you add or subtract printer memory, you will need to change the amount
shown under VMOption. If memory was added to your printer before you installed the
Windows NT 4.0 printer software, you will need to change the VMOption amount.

If you have to change the printer memory size, click on VMOption and select the correct
memory size from the drop-down list box. Answer Yes to the question about available
printer memory. Also, see the following section on updating the printer driver to reflect the
new amount of printer memory.

Updating the printer driver to reflect the new amount of printer memory
If you install additional memory in your printer, you must update the printer driver. You
do this by adjusting the Available printer memory setting at the top of the Device Settings
page. When the Available printer memory figure is correct, your computer will send files
that print faster.

The Available Memory figure is less than the amount of RAM you have installed in your
printer, because part of the RAM is used by the printer for utilities.

If you routinely download more than one or two fonts to the printer’s memory, you should
also update your Available printer memory, even if you have not added any extra memory
to the printer. Download your normal font set and then update the memory.

If you want to update the printer driver, you first have to copy a file to the printer, using a
DOS window (do not use Windows NT 4.0’s Print command). This prints a page that tells
you the maximum suggested virtual memory for the printer. You then enter the figure in
this dialog box.

1. Copy the file TESTPS.TXT to the printer. This file is included with Windows NT
4.0.

• Click on the Start button, then choose Programs from the Start menu. Click on MS-
DOS Prompt in the program list; you’ll see a DOS window.

• The following example assumes that your printer is connected to your computer
through the LPT1 port. Type:

copy c:\windows\system\testps.txt lpt1

• Press the Enter key, type exit  and press the Enter key again to close the DOS win-
dow.

The printer will produce a page which shows the maximum available virtual
memory and the maximum suggested virtual memory. Use the suggested value (Max
Suggested VM ).
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2. Enter the new suggested value into the Device Settings page in the box labeled
Available printer memory (in KB).

3. Update the new RAM value by clicking on Memory Configuration and choosing
a new value, equal to the amount of memory in your printer.

Other general items in Device Settings
• The form to tray assignment sets defaults for the paper size for each paper tray.

• Font substitution replaces certain common fonts on Windows systems (such as Arial)
with the PostScript equivalents on the printer (Helvetica replaces Arial). We recom-
mend that you keep the default settings.

• PS timeout values control how long the computer will attempt to print to a port
before reporting that it is unable to print. The default setting of zero actually means
that there is no limit. We recommend that you keep these settings.

Other GCC-specific items in Device Settings
• Additional paper trays lets you tell the computer that you have installed any addi-

tional paper trays. These trays then appear as an option in the Print dialog boxes of
applications.

• Paper size lets you choose the default paper size. You can override this in an
application’s Page Setup dialog box.

The Document Defaults dialog box
You can set additional defaults in this
dialog box. These defaults will apply to
every application running on this com-
puter only, and can be overridden in an
application’s Page Setup and Print dialog
boxes.

Opening the Document Defaults
dialog box

If the Document Defaults dialog box is not
already open, follow these steps:

1. On the Start Menu, choose Set-
tings, and then choose Printers
from the sub-menu.

2. You’ll see the Printers window.
Click once on your printer.
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3. Go to the File menu in the Printers window, and choose Document Defaults
from the menu.

GCC-specific items
There are several items (depending on the
product you have installed) in the Docu-
ment Defaults dialog box which are added
when you install a GCC printer. You’ll find
them if you click on the Advanced tab and
scroll to the bottom of the window.

• AccuGray is GCC’s technology for
improving the reproduction of
photographs. We recommend that
you leave this at the default setting of
Enabled.

• TonerMiser (Elite 1212 only) lets you
use less toner when printing drafts of
a document for proofing.

• Smoothing (Elite 1212 only) reduces
the jagged appearance of text and
graphics.

• The Output Tray option allows you to select the default output location, either TOP
(face down) or REAR (face up).

Other items in the Advanced page
Most of the items in Document Defaults control what will be the defaults in the Page Setup
and Print dialog boxes in your applications. Any changes you make will override the
settings in the printer’s control panel for this computer only.

If you are constantly making changes in these dialog boxes, you may find that you can
avoid this by making changes in the Paper/Output and Graphic section. The new settings
will then become the defaults in applications. Note that the Graphic section applies to the
whole document and not just to any graphic images within documents.

We recommend that unless you need to change paper sizes and paper sources, you should
leave these settings at their defaults. However, you may want to change the Resolution
setting (see next section).
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Resolution
You can change the output resolution of your documents using the Resolution section of
the Graphic part of the Advanced Document Defaults. If some computers on a network are
not used for documents that need a high resolution, you can set the resolution to the
lowest setting (typically 300 dots per inch). Documents printed at low resolution print
faster than those printed at high resolution.

The figure you set here becomes the default setting for the dialog boxes in applications on
this computer. All resolutions that the printer supports are still options within application
dialog boxes, so you can select higher resolutions when necessary.

Installing printer description files

Some graphics applications need more information about the printer than the standard
printer software provides. This extra information comes in files known as printer descrip-
tion files. You must copy one or more of these files from the Elite 12ppm CD-ROM into a
specified folder in your application folder.

Printer description files have the following extensions: .PDF, .PDX, or .PPD. Please refer to
the documentation included with the application for more information on where to copy
these files and how to use them.

You can use Windows Explorer or open a DOS window to install printer description files.

Installing printer description files using Windows Explorer

1. Insert the Elite 12ppm CD-ROM into your CD-ROM drive.

2. Open Windows Explorer and choose Details from the View menu.

3. In the left pane, find the CD-ROM icon and click on it. You’ll see the files con-
tained in the root directory of the CD-ROM.

4. Click on the Type button at the top of the column in the right pane. The files
are sorted into order by type (three-letter extension).

5. Follow the instructions below for each application you wish to install printer
description files for.

• Adobe Illustrator 4.0 or 4.1:

a. Select all files that end in .ppd .

b. Choose Copy from the Edit menu.

c. Locate the AI4 folder in the left pane (you may have to click on the plus sign next to
a drive letter).
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d. Click on this folder to show its contents in the right pane, then double-click on the
PPD folder.

e. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Adobe PageMaker 6.0:

a. Select all files that end in .ppd .

b. Choose Copy from the Edit menu.

c. Locate the Pm6 folder in the left pane (you may have to click on the plus sign next
to a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
Rsrc folder.

e. Double-click on the Usenglsh folder, then double-click on the Ppd4 folder.

f. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Aldus FreeHand 4.0 or PageMaker 5.0:

a. Select all files that end in .ppd.

b. Choose Copy from the Edit menu.

c. Locate the Aldus folder in the left pane (you may have to click on the plus sign next
to a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
Usenglsh folder.

e. Double-click on the ppd4 folder.

f. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Aldus FreeHand 3.1 and earlier:

a. Open the Ppd3 folder on the Elite 12ppm CD-ROM.

b. Select all files in this folder.

b. Choose Copy from the Edit menu.

c. Locate the Aldus folder in the left pane (you may have to click on the plus sign next
to a drive letter).
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d. Click on this folder to show its contents in the right pane, then double-click on the
Usenglsh folder.

e. Double-click on the Ppds folder.

f. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• Macromedia FreeHand 5.0:

a. Select all files that end in .ppd .

b. Choose Copy from the Edit menu.

c. Locate the Fh5 folder in the left pane (you may have to click on the plus sign next to
a drive letter).

d. Click on this folder to show its contents in the right pane, then double-click on the
Usenglsh folder.

e. Double-click on the Ppd folder.

e. Choose Paste from the Edit menu. You’ll see the ppd files in the window (you may
have to scroll to see them). The files are installed.

• QuarkXPress:

a. Select all files that end in .pdf .

b. Choose Copy from the Edit menu.

c. Locate the Xpress folder in the left pane (you may have to click on the plus sign next
to a drive letter).

d. Click on this folder to show its contents in the right pane.

e. Choose Paste from the Edit menu. You’ll see the pdf files in the window (you may
have to scroll to see them). The files are installed.

Installing printer description files using an MS-DOS window

1. Insert the Elite 12ppm CD-ROM into your CD-ROM drive.

2. Click on the Start button, and choose Programs from the Start menu.

3. You’ll see the programs installed on this machine; click on Command Prompt
and a DOS Window opens.

4. Type the following command and path name for the application you are using
and press the Enter key. These examples assume that your CD-ROM is drive D:
and your application is on drive C: If your CD-ROM uses another drive letter, or
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your application is not on drive C:, change the drive letters accordingly (for
example, if your CD-ROM is drive E: and Adobe Illustrator is on drive D:, the first
example should read copy e:\*.ppd d:\ai4\ppd ).

• Adobe Illustrator 4.0 or 4.1:

Type copy d:\*.ppd c:\ai4\ppd  to install the PPD file.

• Adobe PageMaker 6.0:

Type copy d:\*.ppd c:\pm6\rsrc\usenglsh\ppd4\  to install the PPD
file.

• Aldus FreeHand 4.0 or PageMaker 5.0:

Type copy d:\*.ppd c:\aldus\usenglsh\ppd4  to install the PPD file.

• Aldus FreeHand 3.1 and earlier:

Type copy d:\ppd3\*.* c:\aldus\usenglsh\ppds  to install the PPD
and PDX files.

• Macromedia FreeHand 5.0:

Type copy d:\*.ppd c:\fh5\usenglsh\ppd  to install the PPD file.

• QuarkXPress:

Type copy d:\*.pdf c:\xpress  to install the PDF file.

5. Type Exit and press the Enter key to close the DOS window.

Printing from Windows NT 4.0 applications

GCC printers are designed to work with all Windows NT 4.0 compatible applications. The
Print dialog box varies among applications, but all variations provide the common print
commands along with others that are available for that application only.

The printer’s control panel menus and the settings in the Properties dialog box provide the
default settings for an application’s Print dialog box.
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Selecting print options
This is the Print dialog box for WordPad, a
simple word processing application in-
cluded with Windows NT 4.0. You’ll find
the Print command in the File menu of
most applications. You can change the
target printer, page range, and number of
copies in the main Print dialog box. You
can also click on the Properties button to
make further changes. Other applications
may provide more settings.

The Print Properties dialog box
If you click on Properties in WordPad’s
Print dialog box, you’ll see this dialog box.
This Properties dialog box is similar to the
Printer Properties dialog box, but there are
fewer pages.
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8: Using DOS
There are two ways to print from DOS — within a DOS application or from the DOS
command line. In some cases you may want to save a file in a form that can be copied from
DOS directly to the printer. This process is called Printing to file or Printing to disk.

Overview of setup and printing from a DOS application

You cannot configure DOS once for every application, like Windows. You have to config-
ure every DOS application individually with a printer driver and port setting information.
However, you must configure the port once in every DOS session. You can do this either in
the command line (at the prompt) or include a line in your AUTOEXEC.BAT file to do
this automatically. See the Port Configuration section.

When you print, the printer driver formats your file so that the Elite 12ppm knows
whether to use PostScript or PCL.

When you want to configure DOS printing from an application:

1. Select an emulation mode on the printer’s control panel. When you print, your
print job will be formatted for either PostScript or PCL; set the PS/PCL Sensing
submenu to either PostScript Only, PCL Only, or Auto Switch.

2. Select a printer driver from within the DOS application. DOS applications typi-
cally give you a choice of printer drivers. Select the LaserWriter II NTX for
PostScript printing or the LaserJet III for PCL printing. If the LaserWriter II NTX
driver isn’t offered by your DOS application, choose LaserWriter II, or
LaserWriter. If the LaserJet III driver isn’t offered by your DOS application,
choose LaserJet II, or LaserJet.

3. Check the application’s port settings. The applications’s port settings and the
Elite 12ppm control panel port settings must match.

This DOS application is now ready to print. You can either print the file directly to the
Elite 12ppm or print it to a disk file; later, you can print this file directly from DOS.

Overview of setup and printing from DOS command line

If you want to print a file that has been printed to disk, you need to use the DOS command
line:

1. Check the port settings. The port settings on the Elite 12ppm control panel and
your computer must match.

2. Select an emulation mode on the printer’s control panel. When you print, your
print file will be formatted for either PostScript or PCL; set PS/PCL sensing
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submenu through the Elite 12ppm control panel to either PostScript Only, PCL
Only, or Auto Switch.

3. Use the DOS Copy command to send the print file to the Elite 12ppm. See
“Using the Copy command” later in this section.

Port configuration – DOS

If you want to print from DOS, you must configure a port once in every DOS session. Most
users add a line to their AUTOEXEC.BAT file so that this is done automatically. The port
you configure must be the same as the port that is specified in the DOS application and in
the control panel of your printer.

If you have used another printer to print from DOS, you may find that your
AUTOEXEC.BAT file already includes one of the commands shown in the next sections.

Your PC and the Elite 12ppm are connected through either a parallel or RS-422 serial
interface.

Parallel Port
To set up the parallel port for communication between the Elite 12ppm and the PC, type
the following MS-DOS command before printing:

MODE LPT1:,,P

This command allows the Centronics busy signal to be active for extended periods of time
so that the computer does not abort long print jobs. If you are printing through a parallel
port other than LPT1, substitute that port’s number in the above MODE command.

Serial Port
To set up the RS-422 serial port for communication between the Elite 12ppm and the PC,
type the following MS-DOS command before printing:

MODE COM1:9600,N,8,1

The above MODE command configures the PC serial port for a baud rate of 9600, no
parity, 8 data-bits, 1 stop-bit, and for XON/XOFF flow control. These settings match the
Elite 12ppm’s RS-422 front panel factory default settings. XON/XOFF flow control is
widely used, but check your application’s documentation to see if that handles this proto-
col. It is important that the application support XON/XOFF because standard DOS com-
mands such as PRINT and COPY cannot.

However, we recommend that instead of XON/XOFF flow control, you use DTR flow
control. DTR flow control is preferred because DOS has better support for it, as it matches
the flow control preferred by Windows and thus provides more reliable communication
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when sending PCL jobs to the printer. To use DTR flow control, type the following
MS-DOS command before printing:

MODE COM1:9600,N,8,1,P

Note: You will need to change the Elite 12ppm’s flow control submenu setting to DTR if
you use the this MODE command.

Note: In both the parallel and serial Mode command examples shown in this section, the P
switch may be replaced by the B switch. The B switch is available with MS-DOS version 4.0
and later. (Not all applications support the B switch.)

Redirecting DOS to a serial port
DOS and some DOS applications only print through a parallel port. If you set up the Elite
12ppm to print through the RS-422 serial port, you will need to add an additional MODE
command to redirect your output to the serial port. The following command should be
typed after the previous serial port MODE commands:

MODE LPT1: = COM1:

This command redirects to serial port COM1 the output that DOS or your DOS applica-
tion would normally send to the parallel port. If you use a different serial port (i.e., COM 2,
3, or 4) substitute that number.

Note: A more efficient way of using the MODE commands is to add them to your
AUTOEXEC.BAT file. Refer to your PC documentation for information about editing the
AUTOEXEC.BAT file.

Selecting a printer driver

PostScript
If an application supports PostScript, we recommend that you configure the application to
use a PostScript printer driver. Printing using a PostScript printer driver enables the appli-
cation to use the 11 high quality PostScript font families included with the Elite 12ppm at
all available resolutions. We recommend that you use the LaserWriter II NTX printer
driver if it is available with your application. If not, use LaserWriter II or LaserWriter.
Refer to the application’s documentation for more information.

PCL 5
The Elite 12ppm also includes PCL 5/HP-GL/2 emulation software, which provides
LaserJet III text and graphics compatibility plus the ability to print at 600 dpi. If you are
using a PCL application, we recommend that you configure the application to print to a
LaserJet III. If LaserJet III is not available, use a LaserJet II. If a LaserJet II is not available,
use LaserJet. Refer to the application’s documentation for more information.
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Note: If your document uses 300 dpi user-defined patterns or 300 dpi bitmap fonts, the
Elite 12ppm will only be able to print these at 300 dpi even if 600 dpi PCL is selected. Also,
the Elite 12ppm includes 15 PCL fonts that are compatible with those in the HP LaserJet
III. These fonts consist of 7 bitmap and 8 scalable fonts. If you have configured your Elite
12ppm to print PCL at 600 dpi, the internal bitmap fonts will only print at 300 dpi. The
internal scalable fonts will print at 600 dpi, as will any downloaded scalable font.

Note: In PCL 5 emulation, the Elite 12ppm can print at either 300 or 600 dpi resolution.
The default resolution is 300 dpi. Resolution is set via the Resolution submenu. Also,
although most PCL applications send the necessary commands specifying font, character
pitch, point size, etc., the Elite 12ppm front panel can be used to set many PCL print
characteristics.

The PCL 5 printer language was developed by Hewlett-Packard. For more information
about commands supported by PCL 5, see the HP PCL 5 Printer Language Technical Refer-
ence Manual (Manual Part No. 5961-0509).

Using the Copy command

If you printed to a file from a DOS application, you must use the DOS COPY command to
make the printer print the file. The following command is a typical example:

COPY /B  myfile.prn LPT1

This sends the file myfile.prn to the parallel port LPT1 and to the device connected to that
port.  The binary mode switch /B is needed so that all control characters are sent to the
printer as data.

Note: GCC recommends that you don’t use the DOS PRINT command. Although this
command can produce faster print times, you can’t use binary mode. This can cause
printing problems with complex files. However, if you are sending simple text files, the
PRINT command may work.
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9: Fonts
Introduction

The Elite 12ppm supports a wide range of font types and formats for both the PostScript
and PCL environment.

For PostScript users, the Elite 12ppm comes with 11 high-quality PostScript font families
built into its internal hardware. These fonts are in the Bitstream® Speedo™ format and are
designed to match the corresponding Adobe Type 1 fonts.

The Elite 12ppm can also render any Adobe Type 1 and Apple TrueType™ fonts that you
may be using in your documents. When a document contains fonts that are not built into
the printer, the high-quality outline versions of the fonts will be automatically downloaded
to the printer during the print job and then removed after the job has finished. You may
also manually download fonts to the printer’s internal memory (RAM) by using the
LaserWriter Utility, included with the Elite 12ppm software, or downloaders included with
many font packages; manually downloading fonts can make printing faster. When fonts are
manually downloaded to the printer, they remain in the printer’s RAM and available for all
print jobs sent to the printer for as long as the printer is switched on; the fonts are removed
from RAM when the printer is switched off.

For PCL 5 users, the Elite 12ppm comes with two high quality PCL outline font families
and two 300 dpi bitmap fonts. The outline fonts are in the Bitstream Speedo format, which
are designed to match the AGFA Intellifont® fonts found in the HP LaserJet III.

Resident PostScript fonts

The Elite 12ppm comes with 11 high quality PostScript font families installed in the
printer’s ROM: Times, Helvetica, Courier, Symbol, Helvetica Narrow, Palatino, Avant
Garde, Bookman, New Century Schoolbook, Zapf Chancery, and Zapf Dingbats. The Elite
12ppm printing software includes the matching bitmap screen fonts for the Macintosh.
Screen fonts are the bitmapped images that appear on the screen and are selected from
within a document. When you click the Print button, the Macintosh sends a description of
the bitmap screen font to the Elite 12ppm in the PostScript page description language. The
Elite 12ppm uses the PostScript interpreter to print the high quality outline font. For more
information on the structure of the PostScript language, Adobe offers three books, pub-
lished by Addison-Wesley: PostScript Language Reference Manual (2nd Edition), PostScript
Language Cookbook and Tutorial, and PostScript Language Program Design.
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PostScript resident font catalog

Times Bitstream Dutch™
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9 0

Typefaces: plain, bold, italic, bold italic

Helvetica Bitstream Swiss™
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9
0

Typefaces: plain, bold , italic, bold italic

Courier Courier
A B C D E F G H I J K L M N O P Q R S T U V W X Y
Z a b c d e f g h i j k l m n o p q r s t u v w x
y z 1 2 3 4 5 6 7 8 9 0

Typefaces: plain, bold , italic , bold italic

Symbol Symbol
Α Β Χ ∆ Ε Φ Γ Η Ι ϑ Κ Λ Μ Ν Ο Π Θ Ρ Σ Τ Υ ς Ω Ξ Ψ Ζ
 α β χ δ ε φ γ η ι ϕ κ λ µ ν ο π θ ρ σ τ υ ϖ ω ξ ψ ζ 1 2 3 4 5 6 7 8 9
0

Typeface: plain

Helvetica Bitstream Swiss Narrow™
Narrow A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9 0

Typefaces: plain, bold , italic, bold italic

Palatino Bitstream Zapf Calligraphic™
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9 0

Typefaces: plain, bold, italic, bold italic
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Avant Garde ITC Avant Garde® Gothic
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8
9 0

Typefaces: book, bold, italic, bold italic

Bookman Bookman®

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9
0

Typefaces: light, bold, light italic, bold italic

New Century New Century Schoolbook®

Schoolbook A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8
9 0

Typefaces: roman, bold, italic, bold italic

Zapf Chancery ITC Zapf Chancery®

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9 0

Typeface: medium italic

Zapf Dingbats ITC Zapf Dingbats®

✡ ✢ ✣ ✤ ✥ ✦ ✧ ★ ✩ ✪ ✫ ✬ ✭ ✮ ✯ ✰ ✱ ✲ ✳ ✴ ✵ ✶ ✷ ✸ ✹ ✺
✁ ✠ ✃ ✄ ☎ ✾ ✆ ☛ ✈ ✉ ❁ ❂ ❃ ❄ ❅ ❆ ❇ ❈ ❉ ❊ ❋ ● ❍ ■ ❏ ❐
❑ ❒ ▲ ▼ ◆ ❖ ◗ ❘ ❙ ❚ ✑ ✒ ✓ ✔ ✕ ✖ ✗ ✘ ✙ ✐

Typeface:  plain
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PCL resident font catalog

The Elite 12ppm includes 2 PCL outline font families (Times and Univers) and 2 bitmap
fonts (Courier and Line Printer).

Times Bitstream Dutch
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9 0

Typefaces:  plain, bold, italic, bold italic

Univers Bitstream Zurich
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9 0

Typefaces:  plain, bold, italic, bold italic

Courier Courier
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z
1 2 3 4 5 6 7 8 9 0

Typefaces: 10 pt., 10 pt. bold ,  10 pt. italic,

12 pt., 12 pt. bold ,  12 pt. italic

Line Printer 16 Line Printer 16
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n o p q r s t u v w x y z 1 2 3 4 5 6 7 8 9 0

■ Symbol sets

The symbol sets supported by the Elite 12ppm for resident bitmapped fonts are:

ISO 2:  Int’l Reference Version ISO 21:  German

ISO 4:  United Kingdom ISO 25:  French

ISO 6:  ASCII ISO 60:  Norwegian version 1

ISO 10:  Swedish ISO 61:  Norwegian version 2
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ISO 11:  Swedish Names ISO 69:  French

ISO 14:  JIS ASCII ISO 84:  Portuguese

ISO 15:  Italian ISO 85:  Spanish

ISO 16:  Portuguese HP German, HP Spanish, HP Legal,

ISO 17:  Spanish    ECMA-94 Latin 1, PC-8, PC-8 (DN), and PC 850

In addition to the symbol sets listed, the Elite 12ppm supports the following symbol sets for
resident scalable fonts:

Ventura Math Ventura International Ventura US

PostScript Text PostScript Math MS Publishing

Windows Desktop Math-8

PI Font

Font compatibility

■ Type 1 fonts

The Elite 12ppm is compatible with Type 1 fonts. When using Adobe Type Manager®

(ATM®), these PostScript language outline fonts appear crisp and smooth on the computer
screen, as well as the printed output. ATM is also used to create bitmapped font data at any
size from the Type 1 fonts. For more information on adding and removing Type 1 fonts,
refer to Adobe’s documentation.

■ TrueType fonts

The Elite 12ppm is compatible with TrueType fonts. TrueType is an advanced font tech-
nology that produces high-quality output on the screen as well as on printed output.

Macintosh
If you are using a TrueType font that is equivalent to an Elite 12ppm resident font, the Elite
12ppm automatically uses the resident font rather than downloading the TrueType font. If
you are using a TrueType font that is not equivalent to an Elite 12ppm resident font, the
TrueType font is automatically downloaded.
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Windows
TrueType fonts are automatically installed with Windows and are set to automatically
download by default. Refer to the Windows documentation for more information.

Downloading fonts from a Macintosh

In addition to the fonts that come with the Elite 12ppm, you can purchase more fonts
(both TrueType and Adobe Type 1) and download them to the Elite 12ppm. A downloaded
font is a printer font that is sent by the Macintosh to the RAM located in the Elite 12ppm.

There are two methods for downloading fonts: automatic and manual.

Downloading fonts automatically
If a font being used is not one of the printer’s resident fonts (i.e., nonresident font), it is
automatically downloaded to the printer’s RAM during each print job. After printing is
complete, the font is removed from the printer’s RAM. This method of downloading fonts
is useful if you are printing a variety of fonts within several print jobs. However, if you are
printing the same font repeatedly, this method is inefficient because the font must be
downloaded for every print job.

Downloading fonts manually
If you frequently use the same nonresident fonts, manually downloading them to the
printer’s RAM is faster than having them download automatically each time they are used
in a document. To manually download fonts, use the LaserWriter Utility included with the
Elite 12ppm software. The LaserWriter Utility is located in the Elite™ 12ppm Folder that
was copied onto your startup disk during the initial installation.

When a font is downloaded to the printer’s RAM, it remains in RAM until the printer is
switched off. (If other users on the network have the screen font but do not have the out-
line font, the outline font can still be used as long as it remains in the printer’s RAM.) Since
each manually downloaded font uses some of the printer’s RAM, you are restricted in the
number of fonts that can download by the amount of RAM available in the printer (the
more RAM in the printer, the more fonts you can download). However, using a large
amount of RAM to download fonts can affect the performance of the printer when process-
ing large or complex print jobs. If you frequently use many nonresident fonts in your
documents you may want to attach a dedicated font storage hard drive to the printer.

To manually download fonts using the LaserWriter Utility:

1. Make sure the printer that you want to download fonts to is selected in the
Chooser.

2. Double-click the LaserWriter Utility icon.
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The introduction window appears, along with a message indicating that the LaserWriter
Utility is checking the characteristics of the printer.

3. Choose Download Fonts from the File menu.

The font downloading dialog box appears. The top section indicates the location to which
the fonts should be downloaded. The Printer radio button is selected to download fonts to
the RAM inside the Elite 12ppm.

4. Click Add.

A directory dialog box appears. If the font file list does not appear, click the Desktop button
to search for the list of printer font files.

5. Click the name of a font and then click Add for each font that you want to
download.

6. Click Done.

The original font download window reappears listing the selected font files. To deselect a
font file, click the name of the font and click Remove.

7. Click Download.
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Note: If you are using a downloaded font, install the corresponding screen font on the
Macintosh.

Additional LaserWriter Utility functions

The LaserWriter Utility provides a number of additional functions through its menus.

■ File menu functions

Choose:

Display Available Fonts to display a list of fonts stored in the printer’s RAM (both resident
and manually downloaded) or fonts stored on an external hard disk attached to the printer.

Initialize Printer’s Disk to initialize an external hard disk attached to the printer.

Print Font Catalog to print a list of the fonts available in the printer’s RAM and on an
external hard disk.

Print Font Samples to print a sample of each font available in the printer’s RAM and on an
external hard disk. If you are using an external hard disk and it contains a large number of
fonts, the printer may run out of memory when using this option. As an alternative, use the
Font List option available from the Info Pages menu to print a list of fonts.

Note: If you want to change the printing parameters of the font catalog or font sample
page, use the Page Setup menu command.

■ Utilities menu functions

Choose:

Name Printer to rename your printer.

If you have a font storage
hard drive(s) connected to
your Elite 12ppm the
Printer’s disk(s) button and
accompanying pop-up
menu will be active. Click
the button to download
fonts to an external disk
and choose the SCSI Drive
number corresponding to
the disk you want to
download the selected fonts
onto.
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Set Startup Page to turn the printer’s start page On or Off. This option corresponds to the
Start Page submenu in the front panel of the Elite 12ppm. For example, if you turn off the
start page in the LaserWriter Utility, the Start Page option in the display window on the
front panel will be set to Disabled. (The Elite 12ppm’s default is Enabled.)

Get Page Count to display the total number of pages printed by the Elite 12ppm.

Download PostScript File to send a PostScript file directly to the printer.

Restart Printer to restart the printer between print jobs. This is useful for clearing down-
loaded fonts from the printer’s memory and is preferable to switching the printer off and
on again, as it will not interrupt another print job.

Downloading fonts from Windows

■ Type 1 fonts

Type 1 fonts are automatically downloaded to the Elite 12ppm. These fonts are deleted
from the printer’s RAM when the print job is complete. However, you may want to keep
downloaded fonts in the printer’s RAM for successive print jobs. To maintain Type 1 fonts
in the printer’s RAM, manually download the fonts using the font downloading utility
included with your Type 1 font package. Manually downloaded fonts remain in the
printer’s RAM until you switch off the Elite 12ppm.

Note: If your normal routine is to download several fonts to the printer, it is a good idea to
adjust the Windows printer driver’s virtual memory setting so that it can better process
your documents. Perform the procedure after you have downloaded your normal set of
fonts to the printer.

■ TrueType fonts

While you can download TrueType fonts to the Elite 12ppm, Windows does not recognize
TrueType fonts as resident fonts. Therefore, the TrueType fonts will still be downloaded
from the PC at print time.

Using an external hard disk with the Elite 12ppm (1200 dpi model only)

The Elite 1212 provides a SCSI port for connecting up to seven external SCSI hard disks.
These disks are used to store additional PostScript and TrueType fonts. Using an external
disk for font storage is faster than downloading from the computer and it leaves more
available memory, which improves performance. Fonts can be downloaded from
Macintosh and Windows systems.
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You use a SCSI-1 or SCSI-2 hard drive. The size of this drive doesn’t have to be large. Fonts
typically require around 50 Kb each, so a 20MB drive would be able to hold hundreds of
fonts.

There are several guidelines that must be followed when using the SCSI cable system with
the Elite 12ppm:

• When connecting the SCSI devices, make sure all devices are switched off.

• The SCSI system can only have a maximum of two terminators. If you are connecting one

hard disk to the printer, you will need one terminator for the hard disk unless it is internally

terminated. If two or more hard disks are to be connected to the printer, connect a termina-

tor to the first and last hard disks in the chain, unless they are internally terminated.

• Use a PowerBook® (HDI-30) to SCSI cable to connect the first external hard disk to the Elite

12ppm. If you have trouble purchasing this cable, you can get it direct from GCC.

• If you are connecting multiple hard disks to the Elite 12ppm, make sure that each hard disk

has a unique SCSI ID, and that the SCSI ID is not #7.

Note: The SCSI IDs of hard disks connected to the printer do not affect the SCSI IDs of any
SCSI devices connected to a Macintosh or PC.

To connect an external hard disk to the printer:

1. Switch off both the hard disk and the Elite 12ppm.

2. Connect the HDI-30 end of the SCSI cable to the SCSI port on the Elite 12ppm,
which is located on the back of the printer.

3. Connect one terminator to the SCSI port on the back of the hard disk (if it does
not have built-in termination), and fasten the clips.

4. Connect the 50-pin end of the SCSI cable to the SCSI port on the back of the
hard disk and fasten the clips.

5. Switch on the hard disk first, wait 15 seconds, and then switch on the printer.

When a hard drive is attached to the printer, make sure that the drive is powered on before
powering on the printer. Otherwise, either the hard drive will not be recognized or the
printer will not initialize.

Note: Some hard drives issue a Unit Attention (UA) message when they are first accessed
by the printer. The UA message conflicts with the Elite 12ppm’s startup procedures, caus-
ing the drive not to be recognized. To eliminate this problem switch the printer off and
back on again with the drive still powered on. This procedure will need to be used each
time the hard drive is switched off and then on again.
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6. Print a Start Page or Configuration page.

Information will appear on both of these pages regarding the hard disk. If the disk has not
been initialized, the status information will not reflect the additional space. (See the
Control Panel section on this CD-ROM for information about printing the Configuration
Page.)

Initializing an external hard disk

Each hard disk connected to the printer must be specifically initialized for storing fonts.
Once the hard disk has been initialized for font storage it cannot be used for any other
purpose without first reinitializing it with specific formatting software. Refer to the docu-
mentation included with the hard disk.

■ Initializing hard disks from a Macintosh

To initialize the hard disk from a Macintosh, use the LaserWriter Utility included with the
Elite 12ppm software. The LaserWriter Utility is located in the Elite™ 12ppm Folder that
was copied onto your startup disk during the initial installation.

WARNING: If you initialize your SCSI hard disk, you will lose any data that is currently
on that hard disk.

To initialize external hard disks:

1. Make sure the Elite 12ppm is selected in the Chooser.

2. Double-click the LaserWriter Utility icon.

A dialog message appears, indicating that the LaserWriter Utility is checking the character-
istics of the printer. Then, the LaserWriter Utility menu bar appears.

3. Choose Initialize Printer’s Disk from the File menu.
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A dialog box appears with two options: “Initialize all disks” and “Initialize some disks”. If
you click the button next to “Initialize all disks”, the boxes next to the SCSI ID numbers are
dimmed (A). This option will initialize all hard disks attached to the printer’s SCSI chain. If
you click the button next to “Initialize some disks”, the check boxes representing the SCSI
ID numbers of any hard disks connected to the Elite 12ppm are highlighted: (B) shows an
external hard disk at SCSI ID 1.

A B

If you are attaching more than one hard disk to the printer, we recommend that you always
use the “Initialize some disks” option, and that you initialize each hard disk separately
before chaining them together.

4. Click the button labeled Initialize some disks.

5. Click the box next to the SCSI ID of the first hard disk to be initialized.

An X appears in the box and the Initialize button becomes active.

6. Click Initialize.

A dialog appears asking if you really want to initialize this hard disk. Click OK to proceed,
or click Cancel. A progress status box appears.

7. Click OK.

If the initialization fails, repeat the initialization steps. If the initialization was successful,
repeat the steps for each additional hard disk.

8. Use the LaserWriter Utility to download fonts to the hard disk(s).

Download from Www.Somanuals.com. All Manuals Search And Download.



9-13

■ Initializing hard disks from an IBM PC or compatible

To initialize an external hard disk connected to the Elite 12ppm using an IBM PC or
compatible, use the INITDISK.PS file provided on the Printing Software for Windows
floppy disk. When sent to the printer, this file will initialize any uninitialized hard disks
connected to the printer.

For example, if the printer is connected to the first parallel port,

Type:  copy /b a:\initdisk.ps lpt1:

If the printer is connected to the first serial port,

Type: copy /b a:\initdisk.ps com1:
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10: Maintenance and Troubleshooting
Your Elite 12ppm is exceptionally easy to maintain. Wipe the outer surfaces of the printer’s
case with a damp cloth from time to time to remove dust. Do not use ammonia or alcohol-
based cleaners on or around the printer.

Cleaning the rollers every 12,000 pages

In order to assure smooth paper transport GCC recommends that you check the rollers in
the following illustrations and clean them if necessary with a damp cloth. Do this at alter-
nate toner cartridge changes (approximately 12,000 pages).

The rollers are (from left to right) at the back of the paper output tray, inside the cover at
the rear, and inside the paper tray housing. You’ll need to remove the paper tray to get at
this roller.

GCC
TECHNOLOGIES

GCC
TECHNOLOGIES

Handling and storing toner cartridges

The toner cartridge contains not only the toner itself but also a photoreceptive drum and
other electrostatic components. Handle it carefully. Don’t remove the toner cartridge from
its box until you are ready to use it. Place the cartridge flat and with the handle up. Don’t
tamper with the components within the toner cartridge.

When you store a cartridge properly, it has a shelf life of two years. Don’t store the car-
tridge on end or upside down. Keep the box away from direct sunlight or strong room
light. Keep the temperature within 0-35 degrees Celsius (32-95 degrees Fahrenheit).

Toner spills

Wipe small toner spills with a damp cloth. Don’t use hot water; you may set the toner and
cause stains on clothing and furniture. Wash your hands in cold water. You should remove
larger amounts of spilt toner with a vacuum cleaner. If you spill very large amounts inside
the printer, contact your GCC Technologies dealer or authorized service provider for
cleaning.
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Packing the printer to transport it

Warning: If you are returning the printer to GCC
or its dealers or distributors for any reason, first
contact GCC technical support at 781-276-8620
(U.S. only) or your local GCC dealer or distribu-
tor.

Always use the original shipping box and packing when
you need to move or return your printer. If you don’t
have the box, you can get another from GCC.

Warning: Always remove the toner cartridge
before packing the printer.

1. Unplug the power cord and interface cables,
and remove any optional accessories.

2. Remove the toner cartridge, put it into a plastic
bag, seal it well, and then place it into the box
it came in.

3. Wrap the printer in the original plastic bag.

4. Place the printer into the styrofoam cutouts in the bottom of the original
shipping box.

5. Place the interface cables and the power cord on top of the printer and tape
them to it.

6. Place the remaining packing materials on top of the printer.

7. Tape the box shut.

Printing Problems

Paper Jams
When a paper jam happens, the red service LED on the printer’s control panel flashes and
one of three messages appears in the display. The messages are:

• Paper feed jam

• Paper path jam

• Paper exit jam

You must clear the jam, and open and close the printer’s top cover to reset the printer and
resume printing.
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Paper feed jam
This usually happens when paper is misfed from the paper tray. If you remove the paper
tray you should see a loose sheet of paper.

Paper path jam
This happens when paper is being moved past the toner cartridge. If you remove the toner
cartridge you should see the jammed paper.

Paper exit jam
This happens when a printed sheet jams as it exits the printer. The jammed paper should
be partly visible exiting the printer into the output tray on top of the printer.

Clearing a paper jam
1. Open the top cover of the printer.

2. Locate the jammed paper. If the message says Paper feed jam, open the paper
tray; if the message says Paper path jam, remove the toner cartridge.

3. Grasp the jammed paper with both hands and slowly remove it from the printer
by pulling in the direction that the paper normally takes. If the sheet tears,
make sure you remove all the pieces.

4. Discard the jammed paper. If the jam happened at the paper tray, be sure that
all the paper is beneath the metal bracket at the left front of the paper tray.

5. Check the list below: “Paper Jam Checklist.”

6. Replace the paper tray in the printer (if necessary) and close the top cover of
the printer.

After a minute or so the printer will warm up and resume printing.

GCC
TECHNOLOGIES

GCC
TECHNOLOGIES
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Paper Jam Checklist
• Did you remove all the packing from inside the printer when you set it up?

• Is the paper flat and dry?

• Have you removed the stack of paper and fanned it to make sure that pages are free to
move?

• Are the paper’s edges flush?

• Is the paper under the brackets in the paper tray?

• Is there too much paper in the paper tray? The 250-sheet limit for the standard paper
tray is for 20 lb. (75 g/m2) sheets.

• Are you using the Multipurpose feeder and the rear output for heavy sheets and
envelopes?

• Are the paper length and width guides in the paper tray correctly adjusted?

• Is the paper width guide in the paper tray next to (but not tight against) the paper?

• Is the paper in the tray the same size as in the Page Setup dialog box of your applica-
tion?

• Have you removed all traces of paper from previous jams?

• Is the paper path free from any obvious obstructions?

Other printer problems
Some problems with printing can really be problems with applications. Typical application
problems include:

• A graphic appears on my screen, but when I print only the text shows (Try copying
the graphic to a separate page and print that page only).

• The quality of fonts is very poor (usually a problem with Macintoshes that only have
screen fonts installed; install the printer fonts).

• The computer crashes when I print a document (try printing another document from
that application; if this prints successfully, this probably means that the original
document is corrupt).

You may have problems related to printer or system setup:

• The printer is not listed as available (the printer may not be on line, the printer soft-
ware is not installed correctly, or any network connection to the printer may be
having problems).
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Problems with the printer itself
Typical problems which are directly related to the printer include:

• The printer is not available (there’s probably some error at the
printer; check the control panel to make sure that the printer is on
line and not displaying any error message).

• Output is gray rather than black, or there’s nothing on the page at
all (the toner cartridge is almost empty or completely empty).

• Random areas of the page are blank, or have marks on them (often
this means that the toner cartridge is damaged; try replacing it).

Detailed Troubleshooting

Your GCC printer is designed to perform smoothly and reliably. It
passed rigorous quality standards and tests before being shipped to you.
Despite these qualification standards, on rare occasions you may experi-
ence a problem with the printer’s operation. This section of the manual
is provided to help when a problem occurs. The following pages contain
solutions for common problems. If you need help, call your dealer or
GCC Technical Support at (781) 276-8620. Subjects covered include:

• Chooser problems

• LocalTalk problems

• Serial and Parallel communications problems

• Ethernet communications problems

• Macintosh system crashes

• Macintosh font problems

• PostScript problems

• PCL problems

• Front panel messages

• Clearing paper jams

• Poor quality output

■ Chooser problems

If there is no Chooser under the Apple menu:
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• If you are using System 6.0.x or lower, use Apple’s Font/DA Mover
to install the Chooser into the System file of your startup disk. This desk accessory is part of your
Apple System Software.

• If you are running System 7.0.x or higher, the Chooser needs to be in the Apple Menu
Items folder in the System Folder. A copy of the Chooser is located on the system
floppy disks that came with your Macintosh. See Apple’s documentation if you need
assistance in reinstalling the Chooser.

If the LaserWriter 8 icon does not appear in the Chooser, try the following:

1. Insert the Elite 12ppm CD-ROM.

2. Run the Elite™ 12ppm Installer.

3. From the lower portion of the file installation area highlight LaserWriter 8 and
click Install.

4. Turn off QuickDraw GX.

If the name of your Elite 12ppm does not appear in the “Select a LaserWriter” scroll
box after selecting the LaserWriter 8 icon:

• Check the On Line status LED on the printer’s control panel; it should be solid.

• Check the control panel display window for an error message.

• Check LocalTalk or Ethernet (if available) network cables and connections.

• Set the printer’s control panel 8-pin Serial submenu item to LocalTalk.

• In the Chooser, make sure that the LaserWriter 8 icon is highlighted in the left scroll
box and verify that AppleTalk is Active.

• If there are zones in your AppleTalk network, make sure the zone you select in the
Chooser is the zone where the printer is located. If no zone names appear in the
Chooser, there may be a network problem. Check to see that all devices are properly
connected to the network.

■ LocalTalk problems

If your document does not print and a message appears on your Macintosh screen stating
that the printer could not be found, check the following regarding the LocalTalk network
system:

• Check the On Line status LED on the printer’s control panel; it should be solid.

• Check the control panel display window for an error message.
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• Set the control panel 8-pin Serial submenu item to LocalTalk.

• In the Chooser, make sure that the LaserWriter 8 icon is highlighted in the left scroll
box and verify that AppleTalk is Active.

• Check the LocalTalk connection by following the instructions in the section on
connecting to LocalTalk in the section on connecting to a Macintosh. Verify that all
devices are connected properly and that the network has a beginning and an end.

• Make sure that all computers on the network are using the same version of the Elite
12ppm software.

• If the printer is in a different zone from the computer, check the AppleTalk bridge.

• Restart the printer. The printer’s control panel should indicate that the printer is
Ready.

If you print to one Elite 12ppm and the page prints to a different printer on the network,
switch each printer off and then on again. Printing to a different printer can occur if two
printers occupy the same LocalTalk address.

■ Serial and parallel communication problems

If the Elite 12ppm does not print, there may be a problem with the setup or configuration.
Check the following:

• Check the On Line status LED on the printer’s control panel; it should be solid.

• Check the control panel display window for an error message.

• If you are using the RS-422 serial interface, verify that the 8-pin Serial submenu item
is set to RS-422. Restart the printer. The control panel should indicate that the printer
is Ready. Also verify the RS-422 Serial submenu item settings. They should match the
settings in the Windows Settings box available from the Connect box of the Printers
control panel.

• Check all connections following the instructions in the section on connecting the
printer to a PC using the parallel or serial interface.

• Verify that your Windows software and/or your DOS application software is config-
ured to print to the correct port on the computer.

• For DOS printing, make sure the correct MODE statements are in your
AUTOEXEC.BAT file.

• For PostScript printing, make sure that the Elite 12ppm printer driver is selected.
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■ Ethernet communication problems

When you connected the Elite 12ppm to an Ethernet cabling system, the printer should
have been switched off to avoid connection problems. Before continuing with these
troubleshooting procedures, switch the printer off, wait ten seconds, and then switch the
printer on.

If the printer will not print:

• Switch off the printer. Switch the printer back on and at the same time watch the LED
between the two Ethernet ports (labeled TX/RX). The LED should flash for a few
seconds. If the LED flashes, the network card is probably operating correctly and the
problem might be with your network.

Note to network administrator: As a test of the printer’s ability to receive data over the
network, you can send echo packets to the printer. This should cause the center LED
to flash. Normal print jobs will not cause the center LED to flash.

If your Elite 12ppm is connected to a 10BASE-2 network:

• Verify that a UTP (unshielded twisted-pair) cable is not connected to the UTP con-
nector. (The Ethernet adapter will acknowledge the UTP connection instead of the
coax connection.)

• Verify that the Ethernet cable has a 50 ohm terminator connected at each end.

• Verify that the Ethernet cable is not connected in a loop configuration.  The cable
should be connected as a “linear bus” in which one piece of coax cable is connecting
all the nodes.

If your Elite 12ppm is connected to a 10BASE-T network:

• Verify that the printer is connected to a UTP hub on the other end.

• Verify that the cabling is correctly constructed. The cable should be constructed with a
data grade twisted-pair 2-pair, 3-pair, or 4-pair cable.  There should be at least six
twists per foot.  Do NOT use straight 25-pair or 50-pair phone cables (this cable does
not meet the criteria set for UTP cables, and will cause communication errors).

If the Elite 12ppm printer name does not appear in the right scroll box after selecting the
LaserWriter 8 icon in the Chooser:

• Verify that the correct zone is selected. Ethernet and AppleTalk connections may
appear in different zones.

■ Macintosh system crashes

If your Macintosh system crashes while a document is printing, try the following:
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• Restart the printer. Print the document again.

• If Background Printing is on, turn it off; try printing the document again.

• Reinstall the printer software following the instructions in the Macintosh section of
this CD-ROM.

• Print a different document from the same application. If one document from an
application causes a crash while others do not, the document may be corrupt. Replace
the document.

• Remove (or disable) INITs (Extensions), temporary files, and non-System software
files (such as a Preferences file or a Defaults file) from the System Folder.

• Print from a different application; if all documents from a particular application cause
crashes, replace the application, along with any application-specific Default and
Preferences files. Refer to the application’s documentation for more information. If
documents from different applications cause crashes, you may need to replace your
System and Finder files. Refer to Apple’s documentation for more information.

■ Macintosh font problems

If the fonts printed on the Elite 12ppm appear to be low-quality screen fonts rather than
high-quality resident fonts:

• Make sure that the Elite 12ppm Screen Fonts are in the appropriate location in the
System Folder. Note that with the Font Substitution option off, only screen fonts for
which there are corresponding resident fonts print at high quality. (An exception to
this is if you have TrueType or Type 1 high-quality (printer) fonts installed on your
Macintosh.) With Font Substitution on, some screen fonts will have high-quality
fonts substituted for them, even if there is no corresponding high-quality font. (For
example, Times will be substituted for New York, Helvetica for Geneva, and Courier
for Monaco.)

• If you are using a nonresident font that is downloaded from your computer, make
sure the font file to be downloaded is either in the Fonts folder (System 7.1 or later),
the Extensions folder (System 7.0.x), or the System Folder (System 6.0.x) of the
startup disk; the printer’s RAM; or the printer’s internal hard disk. As you print, a
message appears on the screen of your Macintosh indicating which fonts are being
downloaded.

• Some applications have an option called Fractional Character Widths. In some
applications, if this option is enabled, Font Substitution has no effect.
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• If you are using downloaded fonts, make sure you download all the styles of fonts,
such as bold, italic, and bold italic. If you do not, your document will print with plain
style fonts.

• Deselect the Unlimited Downloadable Fonts in a Document option in the Page Setup
dialog box.

■ PostScript problems

If your PostScript print jobs print incorrectly check the following:

• Make sure the correct printer driver is chosen: for Windows, choose Elite 12ppm, for
Macintosh choose LaserWriter 8.

• Be sure the PS/PCL Sensing menu in the front panel is set to either PostScript Only or
Auto Switch.

• Depending on the application and the complexity of the print job, you may need to
increase the Wait timeout value in the front panel. If the wait timeout is too short,
jobs may print either partially or not at all.

• If you are printing from a Macintosh try printing with Background Printing turned
off.

• Try restarting the printer.

■ PCL problems

If your PCL print jobs print incorrectly check the following:

• Be sure the PS/PCL Sensing menu in the front panel is set to either PCL or Auto
switch.

• Make sure that the LaserJet III driver is installed and selected in your application.

• If the print jobs do not print at all or only partially, try setting the Wait Timeout
setting higher.

Each line of text repeats on the same line:

• Change the Line Termination submenu item to CR=CRLF.
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The next line of text starts below the end of the previous line (stairstep effect):

• Change the Line Termination submenu item to LF=CRLF;FF=CRFF.

Diagnosing errors from print output

“Recommended paper” in these examples is 20-pound (75 g/m2) copier-type paper.

The print is light or faded:

• Moisture in paper – load fresh, dry paper.

• Print density is incorrectly set – adjust the print density

• Toner cartridge is low on toner – replace toner cartridge

• Toner cartridge is damaged – replace toner cartridge

Toner spots are randomly scattered across the page:

• Paper doesn’t meet specification – use recommended paper

• Toner cartridge is damaged – replace toner cartridge

Repeating marks spaced evenly on page:

• Paper path is dirty – print some blank sheets to clear the paper
path

• Toner cartridge is damaged – replace toner cartridge

Light or faded areas within the print:

• Transfer roller smudged – print some blank sheets of paper

• Moisture in paper – load fresh, dry paper

• Paper doesn’t meet specification – use recommended paper

Light or faded vertical bands running through print:

Data sent to printer

Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
character 12).  Last page of
Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal

Data sent to printer

Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
character 12).  Last page of
Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal

Data sent to printer

Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
character 12).  Last page of
Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal

Data sent to printer

Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
character 12).  Last page of
Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
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• Toner distributed unevenly – remove the cartridge and rock it
back and forth a few times

• Toner cartridge is damaged – replace toner cartridge

The entire page is black or partially black:

• Toner cartridge is damaged – replace toner cartridge

• Mechanical malfunction – call for service

The entire page is blank:

• The toner cartridge seal is still in place – remove the
cartridge and remove the seal

• Multiple sheets were fed – fan the paper in the cassette

• The toner cartridge is low on toner – replace toner cartridge

• The toner cartridge is damaged – replace the toner cartridge

• Mechanical malfunction – call for service

Print rubs off or smears:

• Moisture in paper – load fresh, dry paper

• Paper doesn’t meet specification – use recommended paper

• The printer access door isn’t fully closed – make sure it’s fully
closed and latched

If your problem wasn’t covered by these examples, or the solutions don’t
solve your problem, contact GCC Technical Support.

Solving problems by turning the printer off and on again

Sometimes you make changes at the printer’s control panel and these changes appear to
have no effect. Some changes do not take effect until you’ve cycled the printer — that is,
turned it off and on again.

At other times, you can make changes with WebAdmin or the NEST tool, and these require
that you cycle the printer.

Data sent to printer

Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
character 12).  Last page of
Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal

Data sent to printer

Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
character 12).  Last page of
Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal

Data sent to printer

Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
character 12).  Last page of
Press the ON-LINE button to
take the does not print, but
printer off-line, then press the
FORM FEED DATA PRESENT
button to eject the final page or
send the message appears.
Form feed code (decimal
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If the “Service Required” message appears in the control panel, we recommend that you
turn the printer off, leave it for 5 minutes, and then turn it on again. If the Service Re-
quired message doesn’t reappear, you can carry on printing. If the message is still dis-
played, contact GCC Technical Support at 781-276-8620.

There’s a rare possibility that the printer’s internal software may have a problem. Cycling
the printer will normally clear this. If problems persist, contact GCC Technical Support.
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Service and Support

You can contact GCC for technical assistance in several ways.

• Technical Support phones: 781-276-8620.

• Fax: 781-275-1115.

• GCC’s World Wide Web site: www.gcctech.com

• Internet email: support@gcctech.com

• CompuServe: GO MACBVEN, DL2.

• CompuServe email: GCCTech@compuserve.com.

GCC’s World Wide Web site
GCC’s Web site offers a wealth of information. The full manual for the Elite 12ppm series
of printers is here, along with technical bulletins that deal with any problems that arise over
the life of your printer. Check www.gcctech.com to see if your problem has a solution.

Dealer and Service Center support
GCC offers worldwide services from its dealers and service centers. Dealers and service
centers are supported by training, technical documentation, and technical support.

Extended warranties
GCC offers extended warranty programs for all its products. These extend the limited
warranty and cover all parts of the printer (except consumables, like the toner cartridge).
You can purchase an extended warranty during the limited warranty period, and renew it
year after year.

Software upgrades
You can download software upgrades from GCC’s web site or from its section on
CompuServe.

Transporting your printer
Full instructions on packing the printer for transport are on page 10-2 in this section.
Always remove the toner cartridge from the printer before transporting it.

Consumables, accessories, and upgrades
You can purchase consumables such as toner cartridges, accessories, and upgrades from
GCC dealers or direct from GCC itself, by calling 800-422-7777 (U.S. only). A list of
consumables and accessories is in appendix I.
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11: Adobe Acrobat
The installation guide has details of how to set up Adobe Acrobat on your computer’s hard
disk or on a network. Your computer has been configured for Acrobat, otherwise you
wouldn’t be able to read this.

Installation information is repeated here in case you want to configure the CD-ROM on
another computer and cannot find the Quick Installation guide (the paper manual).

This CD-ROM contains full information about your printer, in Adobe Acrobat format
files. Part of this information is in the Quick Installation guide, but this CD-ROM has all
the information about the printer, including all the information in the Quick Installation
guide.

This CD-ROM comes with Macintosh and Windows versions of the Adobe Acrobat Reader
program; you can install this program on a computer and read the documents on this CD-
ROM. Providing that you have sufficient free hard disk space (about 50 MB), you can copy
the data files to a computer and be able to use the manual without the CD-ROM.

The Acrobat reader can read a file and display it on your Macintosh or Windows
computer. You do not have to have any of the fonts used in Acrobat documents installed
on your computer; the program will display and print the fonts, but will not install them
in your computer.

You can print pages from Acrobat documents, and also copy and paste text from Acrobat
files into other applications, and make full text searches within the document.

Installing Adobe Acrobat Reader

1. Put the Elite 12ppm CD-ROM in your CD-ROM drive.

2. (Windows only) Open File Manager (Windows 3 and NT 3.51) or Explorer
(Windows 95 and NT 4.0).

3. Open the Folder or Directory of the CD-ROM called Manuals.

4. Open the Folder or Directory that corresponds to your language. Languages
available for the Acrobat program are English, French, Italian, German, and
Spanish.

5. Run the program called Acroread.mac (Macintosh) or Acroread.exe (Windows).
This installs the Reader program; follow the instructions on the screen.
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Opening Documents with Acrobat Reader

Acrobat documents are stored as Portable Document Format (.pdf) files. Open them in the
same way as you open files in other applications.

Understanding the Acrobat Screen

The Acrobat screen is divided into two parts; bookmarks on the left and pages on the right.
Treat the bookmarks as a table of contents. If a bookmark has a triangle to the left of it, you
can click on the triangle to show a list of subtopic bookmarks. Click on the triangle again to
hide the subtopics. If you click on a bookmark, you’ll jump to the first page in that section.
There is a scroll bar at the bottom of the bookmarks so that you can see all the text in a
bookmark.

Depending on the size of your computer’s screen, you may need to magnify the page. You
can choose the magnification you want by clicking on the magnification box in the status
bar at the bottom center of the screen.

• Fit Page shows the entire height of the page.

• Fit Width shows the entire width of the page. You won’t be able to see some of the top
or bottom of the page.

• Fit Visible is similar to Fit Width, but shows the width of the page between margins.

You can also choose percentage views from the list, or choose Other to create a specific
percentage view. You can also use the magnifying glass button in the toolbar to drag over
an area of the page you want to enlarge.

When you change the magnification it remains at that setting for all pages until you change
it again.

Moving Through Pages

You can move forward and backward through the sections of the Elite 12ppm manual by
dragging the vertical scroll bar. When you do this you’ll see a window telling you which
page you’re selecting.

If you click in the background area of the vertical scroll bar you’ll move one page at a time.
If the magnification you’ve chosen shows less than a full page, you’ll see the top part of
each page followed by the bottom part.

You can also use the toolbar buttons to move from page to page.

This manual has a table of contents with underlined entries in red; click on these to go to
that section of the manual.
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Finding Text

Just as you can think of the bookmarks as a table of contents, the Find tool takes the place
of an index. If you want to find a word:

1. Click on the Find button in the toolbar.

2. You’ll see the Find dialog box. Enter the word(s) you want to find.

3. Click OK; the program takes you to the next place the word appears.

4. If you don’t find the information you’re looking for, press Command-G
(Macintosh) or Control-G (Windows) to go to the next place the word appears.

What’s on this CD-ROM

This CD-ROM contains important information; please take the time to look at the various
sections. These include:

• Using PostScript and PCL fonts

• A detailed troubleshooting guide

• The control panel menu system

• Networking guide

• GCC’s WebAdmin tool for configuring printers remotely

• Installing and using optional equipment

• Detailed printer specifications

Keep this CD-ROM in a safe place. You can buy further copies from GCC.

Download from Www.Somanuals.com. All Manuals Search And Download.



A-1

Appendix A: Printer Specifications

Print Engine: Fuji Xerox P893 (Mario)

Print Method: Dry type laser printing

Languages: PostScript Level 2 compatible (Xionics PS/PLI),

PCL5 with HP-GL/2 (Xionics FIVE/PLI)

Processor: 50MHz AMD 29040 RISC

Memory: Standard memory differs with model. All models upgradeable to 64 MB

Interfaces: LocalTalk/RS-422, Centronics parallel, HDI-30 SCSI (1200 dpi model only),
Ethernet 10BASE-2 (1200 dpi model only), and 10BASE-T

Letter Print Speed: 12 pages per minute

Maximum time until first page printed: 30 seconds (plus processing time)

Height: 8.98 in. (228 mm)

Width: 16.57 in. (421 mm)

Depth: 16.34 in. (415 mm)

Weight: 27.2 lbs (12.2 kg)

Power requirements: 120 VAC (min. 108 VAC, max. 132 VAC), 50/60 Hz, maximum
5.5 amp during printing

or 230 VAC (min. 198 VAC, max. 264 VAC), 50/60 Hz, maximum 3 amp during printing

Temperature (during operation): 40 º F - 95 º F (5 º C - 35 º C)

Humidity (during operation): 15% - 85% relative humidity, non-condensing

Altitude (during operation): 0 - 8,200 feet (0 - 2,500 meters)

Noise level during operation: Less than 51 db

Noise level in standby: Less than 32 db

Toner Cartridge life: 6,000 pages (letter size with 5% coverage)

Engine life (minimum life expectancy): 300,000 pages/5 years

Maximum number of pages printed per month: 20,000

Certifications: UL/CSA/FCC/VDE, Energy Star
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Font Formats supported: Adobe Type 1, Type 3, TrueType, Bitstream Speedo, AGFA
Intellifont.

Universal tray/250 sheet capacity:

Letter Legal Legal 13"

Executive A4 B5

Transparencies  (Letter/A4, 50 sheets maximum)

Label stock  (Letter/A4, 50 sheets maximum)

Multipurpose feeder: Sizes as above with 80 sheets of paper, 40 transparencies, and 40
sheets of label stock maximum capacity. The multipurpose tray can also be used with the
following  envelope sizes (10 envelopes maximum):

Commercial #10 Monarch DL C5

You can also use the multipurpose tray for up to 25 postcards.

Optional Letter tray/500 sheet capacity:

Letter A4 Legal Legal 13"

Optional Envelope tray/30 envelope capacity:

Commercial #10 Monarch DL C5  Postcard

Both the above optional paper sources require that you have the optional sheet feeder.

Paper weight:

Paper trays : 16-28 lb. (60 g/m2 - 105 g/m2)

Multipurpose feeder: 16-36 lb. (60 g/m2 - 135 g/m2)

Paper Dimensions

Letter: 8.5 x 11 in. (215.9 x 279.4 mm)

Legal: 8.5 x 14 in. (215.9 x 355.6 mm)

Legal 13˝: 8.5 x 13 in. (215.9 x 330.2 mm)

Executive: 7.25 x 10.5 in. (184.2 x 266.7 mm)

A4: 210 x 297 mm (8.27 x 11.69 in.)

B5: 182 x 257 mm (7.17 x 10.12 in.)

Postcard: 3.94 x 5.83 in. (100 x 148 mm)

Download from Www.Somanuals.com. All Manuals Search And Download.



A-3

Envelopes

Commercial #10: 4.125 x 9.5 (104.8 x 241.3 mm)

Monarch: 3.875 x 7.5 (98.4 x 190.5 mm)

DL: 4.33 x 8.66 in. (110 x 220 mm)

C5: 162 x 229 mm (6.38 x 9.02 in.)

Print alignment

Skew: The amount by which a supposedly horizontal printed line may vary from being
parallel with the edge of the paper. This assumes that vertical printed lines are also at an
angle, so that the entire image is printed correctly but slightly rotated on the page. Mea-
sured with a 190 mm (7.48 inch) line.

Within 1.2 mm (0.047 inch) either up or down (normal paper tray)

Within 1.4 mm (0.055 inch) either up or down (multipurpose tray)

Registration: The amount by which images appearing to left or right, or above or below
previously printed images. Images appear on the paper correctly printed and aligned, but
not in the same place. Measured at the mid-point of the side or top of the paper.

Within 2.0 mm (0.079 inch) horizontal or vertical either way

Magnification: The amount by which a line can be greater or smaller than its nominal
length. Measured with a 240 mm (9.45 inch) vertical line and a 190 mm (7.48 inch) hori-
zontal line. These lines are centered on the page to avoid measuring parallelism errors.

Within 0.8 percent longer or shorter than its nominal length

Parallelism: The amount by which the ends of two vertical and two horizontal lines can
be greater or farther apart than the other ends. Measured with vertical lines of 234 mm
(9.21 inch) and horizontal lines 190 mm (7.48 inch). These lines are arranged to form a
rectangle on the page.

Within 1.44 mm (0.057 inch) horizontal or vertical either way

Linearity: The amount that three straight lines (horizontal, vertical, and diagonal) can
vary from being truly straight. One end of each of the horizontal and vertical lines meet at a
corner; the diagonal line is at 45 degrees to the other two lines and passes close to the
center of the paper. The horizontal line is 190 mm (7.48 inch), the vertical line is 234 mm
(9.21 inch), and the diagonal line is 269 mm (10.6 inch). The amount is measured by the
distance a line can vary from the position of a true straight line.

Within 0.5 mm (0.02 inch) either side, horizontal and vertical lines
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Within 1.2 mm (0.05 inch) either side, diagonal line

Perpendicularity: The amount one end of a 114.5 mm (4.51 inch) vertical line can vary
from true perpendicular.

Within 0.8 mm (0.03 inch) either side of true vertical

H
GF

Direction of Paper Travel

Skew

(-1.2mm) ≤ E ≤ (+ 1.2mm)
or (-1.4mm) ≤ E ≤ (+1.4mm) when fed from the MBF
E = F - G
H = 190mm
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B B
A

Direction of Paper Travel

Lead edge registration

(4.0 - 2.0mm) ≤ A ≤ (4.0 + 2.0mm)
B=B
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C

D

D

Direction of Paper Travel

Side edge registration

(4.0 - 2.0mm) ≤ C ≤ (4.0 + 2.0mm)
D=D
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Direction of Paper Travel

Parallelism

(-1.4mm) ≤ T ≤ (+ 1.4mm)
T = U - V
U ≥ 234mm
W ≤ 190mm

W

VU
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Direction of Paper Travel

Orthogonality

(-0.8mm) ≤ J ≤ (+ 0.8mm)
K = L
M = 114.5mm

LK

M

90∞

J
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Appendix B: Paper specifications and
recommendations
GCC Technologies recommends the following materials for use with your printer. GCC
does not assume liability for materials used with the printer that are not listed below.

Printing on standard papers

Your GCC printer prints on most kinds of paper stock, including most color stocks and
letterhead. The printer produces best results on standard 20-pound (75 g/m2) copier-type
paper; however, paper weights from 16-lb. to 28-lb. (60 g/m2 to 105 g/m2) should also
provide good results.

To produce even clearer, sharper images, use paper with a surface that is smoother, but not
shinier, than photocopy paper. Some companies offer paper specifically designed for laser
printers.

Printing on letterhead

Letterhead should conform to the weight and surface characteristics specified in the previ-
ous section. Also, keep the following points in mind when printing on letterhead:

• Temperature: Some letterheads use low-temperature dyes that vaporize and smear at
high temperatures. Many letterheads that have a slick texture use a heat bonding
process called thermography that bonds the print to the paper. Letterheads produced
with this technique may “unbond” in the printer, causing damage.

• Paper Texture: Highly textured paper may not print evenly.

• Paper Finish: Paper that is extremely shiny does not work well.

Printing on envelopes

Use envelopes that are smooth (but not slick) and have rectangular or square flaps (rather
than a triangular flap).

Envelopes should be fed from the multipurpose feeder. There is also an envelope tray
available as an option. For more information, see “Optional accessories.”

WARNING: The printer uses heat in the printing process. Do not use material that may
melt inside the printer, such as Tyvek® envelopes. Serious damage to the printer may result.

Printing on overhead transparency film

Use transparencies recommended for dry toner machines. Other transparencies may cause
damage to the printer.
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Appendix C: Adding memory to your printer
You can print more complex documents and download more fonts to your printer if you
add RAM. To do this you have to open up the printer and insert a SIMM (Single Inline
Memory Module). The printer can hold up to 64 MB of RAM, in two SIMM sockets. There
is already at least one SIMM installed in the printer.

When you have installed the memory you must update the drivers in every Windows or
Macintosh computer that uses the printer.

Specifications

You can add SIMMs of any size from 2 MB to 32 MB. SIMMs must be non-parity 72-pin,
70 nanoseconds or faster, non-composite, symmetrical, low-profile, 5-volt, and tin leaded.
This kind of memory is readily available from many sources, or you can order upgrade kits
direct from GCC. Use only EDO (extended data out) or FPM (fast page mode). You
cannot use DIMMs, SDRAM, or other special RAM technologies.

SIMMs do not have to be installed in pairs, nor do you have to add a SIMM of the same
size as that already installed. You can install any capacity SIMM in either socket.

Why would I need to add memory to the Elite 12ppm?

You can print virtually any 600 dpi pages with 8 MB of RAM and virtually any 1200 dpi
pages with 16 MB (if your model of the Elite 12ppm supports this resolution).

You can use up RAM by setting the printer to Auto Switch between PostScript and PCL 5.
Utilities like NEST, WebAdmin, and TCP/IP use small amounts of RAM; together with
Auto Switch, these require under 4 MB.

In addition, you’ll need printer RAM for any fonts you download. These require as much
RAM as the space they occupy on the hard drive of your computer. In general, fonts
occupy under 50K of RAM.

With an extra 8 MB of RAM or more, you’ll see minor performance improvements.

Required tools and safety precautions

You should not need any tools to add memory to your printer. However, you should guard
against static charges. Your body can easily accumulate a static charge; if you touch a
sensitive piece of circuitry, you can destroy it without realizing.
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GCC strongly recommends that you use a grounding wrist strap. You can buy one from
the same place that you bought your SIMMs. If you do not have a grounding wrist strap,
touch the perforated metal chassis of the printer (see step 9 following).

Installing the RAM into the Elite
12ppm

1. Switch off the printer. Do not
unplug the power cord from
the AC outlet.

2. Unplug the interface cables
from the back of the printer.

3. If necessary, move the printer so
that you have clear access to its
left side.

4. Remove the paper tray.

5. Open the top cover by pressing the
release button on the top right of the printer.

6. You need to remove the side cover. Unscrew
the two thumbscrews at the rear of the
printer (labelled “A” in the bottom picture).
If these are tight, you may need to use a #2
Phillips screwdriver.

7. Reach inside the case. Pull the
edge of the cover (B) toward
you, then move the cover
away from the rest of the
printer to prevent it from
latching again.

8. Place both hands on the top
of the side cover (C). Lift the
edge of the cover next to
the top cover; this unlatches
the cover, and you should
be able to slide the cover
away from the printer.

A

A

C

B

B

C
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9. IMPORTANT: Attach a
grounding wrist strap to
the perforated metal
chassis, or touch the chassis
regularly to dissipate static
electricity from your body.

10. The ROM and RAM cards
are at the right of the
controller board. Remove
the ROM card to get better
access to the RAM slots.

Install
RAM
SIMM

Notch

Remove
RAM
SIMM

Notch

a. Place your index fingers under the back
edge of the ROM card.

b. With your thumbs, slowly push the two
retaining clips outward until the clips clear
the top surface of the ROM card.

c. Pivot the ROM card away from the retaining
clips and remove the ROM card from the
socket.

ROM
SIMM

RAM
SIMM

RAM
Socket
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d. The ROM card has a notch in it; this must be at
the top of the contacts when you reinstall it.

e. Put the ROM card in a safe place; after you have
installed the RAM you will need to reinstall it.

11. Install the RAM SIMM.

a. Position the SIMM so that the notch is toward
the top.

b. Place the SIMM in the socket so that the top of
the SIMM is angled toward your left. Gently
press the SIMM down into the socket.

c. Pivot the SIMM so that it moves upright. The
retaining clips will snap into place. If the retain-
ing clips will not snap into place, you have not
inserted the SIMM correctly.

12. Reinsert the ROM card in the same way that you
inserted the SIMM.

Warning: If the RAM SIMM and ROM card are not correctly inserted completely into the
socket, your printer will display an error message when you turn it on and will not operate.

If you are having trouble inserting the SIMM or ROM card:

• Make sure that the cards are in the correct sockets. The ROM card is shorter than the
SIMM.

• Make sure that the notch in each card is toward the top.

13. Remove the grounding wrist strap from the printer (if necessary), and reinstall
the printer’s side cover. Don’t tighten the thumbscrews. Turn on the printer and
wait to see if the control panel shows the “ready” message. If it does, turn the
printer off and go on to the next step.

If the ready message doesn’t appear, turn off the printer and remove the cover.
Gently try to rock the ROM card and SIMMs. If they are inserted correctly, they
should not move. Carry out steps 11 and 12 again, and replace the cover and
turn the printer on.

If the ready message still doesn’t appear, and you are confident that you have
installed the ROM card and SIMM correctly, call GCC technical support at 781-
276-8620 (U.S. only) or your local GCC dealer or service center.

RAM SIMMROM card

Notch
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14. If the printer is ready, tighten the thumbscrews (at the rear of the side cover) by
hand. Make certain that the printer is switched off. Reinstall the interface
cables (if you are using the parallel port, insert the plug for this first).

15. Turn the printer on again. If the “ready” message appears on the control panel,
the physical installation was successful. You now have to confirm the installa-
tion and update the printer driver on all computers that use this printer.

Confirming the installation

These steps confirm that printer recognizes the additional memory.

1. Switch on the printer.

2. Press the On Line button on the control panel; you’ll see the message “Off
Line” in the display panel.

3. Press the Menu key four times; you’ll see “Printer Info” in the display panel.

4. Press the Enter key; you’ll see the total amount of RAM that the printer recog-
nizes. If this is the same as the new total of RAM, press the On Line key and the
printer goes back on line.

If this figure is not the same as the total amount of RAM, turn the printer off,
and remove the side cover. Now carry on from step 13 in the previous set of
steps, beginning with the paragraph “If the ready message doesn’t appear . . .”

Updating LaserWriter 8 printer driver

After you have installed extra memory you must update the LaserWriter 8 driver configu-
ration on every Macintosh that uses the printer.

1. Switch the printer on.

2. Select the Chooser from the Apple (ð ) menu.

3. Click the LaserWriter 8 icon in the upper left area of the Chooser. You’ll see the
name of your Elite 12ppm in the upper right area of the Chooser below “Select
a PostScript printer.” If the name is not highlighted click on it to highlight it.

4. Click on the Setup button. You’ll see the Setup dialog box.

5. Click on the Auto Setup button. You’ll see a message box telling you that the
computer is communicating with the printer.

6. After a few seconds you’ll see the Setup dialog box again. Click the OK button
to return to the Chooser, and then close the Chooser.
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7. Repeat the preceding six steps on every Macintosh that will use the printer.

Updating Windows drivers (all versions)

After you have installed extra memory you must update the Windows printer driver on
every Windows computer that will use the printer.

You need to carry out the next four steps once. This method works for all versions of
Windows.

1. Switch the printer on.

2. Open a DOS Window. You can use the MS-DOS prompt icon on the Windows 95
(or NT 4.0) Start menu, or the MS-DOS Prompt icon in the Windows 3.1 (or NT
3.51) Main Window.

3. Assuming that your printer is on LPT1 and that Windows is installed on the C
drive, type the following:

copy c:\windows:\system\testps.txt lpt1

If your printer is connected to another port, or Windows is installed on a drive
other than C, change the references. Do not use any Windows print commands;
you must execute this command in DOS.

4. Type EXIT  and press the Return key to return to Windows.

The printer will have printed a page which shows “Max Suggested VM (KB):” This is the
maximum suggested Virtual Memory for the printer in kilobytes. You need to enter this
figure in the Printers section of Windows Control Panel on every Windows computer that
uses the printer. The way you do this varies between versions of Windows.

Windows 3.1
1. Open the Main Window in Program Manager, and double-click on the Control

Panel icon.

2. Double-click on the Printers icon.

3. Click on the Setup button.

4. Click on the Advanced button.

5. Enter the suggested virtual memory value into the Virtual Memory (KB) box.

6. Click the OK button until you’ve returned to Program Manager.

7. Repeat the preceding six steps on every Windows 3.1 computer that will use the
printer.
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Windows 95
1. Choose Settings from the Start menu, and choose Printers from the submenu.

2. You’ll see the Printers window; use the right mouse button to click on the Elite
12ppm icon.

3. You’ll see a menu; choose Properties from this list.

4. You’ll see the Properties tabbed dialog box; click on the Device Options tab.

5. At the top of the dialog box is a section marked Available printer memory (in
KB). Enter the suggested virtual memory into this box.

6. Click OK.

7. Repeat the preceding six steps on every Windows 95 computer that will use the
printer.

Windows NT 3.51
1. Open the Main Window in Program Manager, and double-click on the Control

Panel icon.

2. Double-click on the Printers icon.

3. Click on the Setup button.

4. Click on the Advanced button.

5. Enter the suggested virtual memory value into the Virtual Memory (KB) box.

6. Click the OK button until you’ve returned to Program Manager.

7. Repeat the preceding six steps on every Windows NT 3.51 computer that will
use the printer.

Windows NT 4.0
1.  Choose Settings from the Start menu, and choose Printers from the submenu.

2. You’ll see the Printers window; use the right mouse button to click on the Elite
12ppm icon.

3. You’ll see a menu; choose Properties from this list.

4. You’ll see the Properties tabbed dialog box; click on the Device Options tab.

5. In the window, click on Virtual Memory.

6. Enter the suggested virtual memory figure into the box.

7. Click OK.
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8. Repeat the preceding seven steps on every Windows NT 4.0 computer that will
use the printer.
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Appendix D: Adding and configuring
optional paper trays
This section provides information on installing and configuring optional Elite 12ppm
paper trays. These include:

• A 500-sheet paper tray

You’ll need to install the 500-sheet feeder to add the 500-sheet paper tray. You can load
sheets of US Letter, A4, Legal 13" and Legal 14" paper. You can select this tray from your
computer, using an application’s Print dialog box.

The 500-sheet feeder is supplied with one 500-sheet paper tray.

• An envelope tray

You’ll need to install the 500-sheet feeder to add the envelope tray. You can select this tray
from your computer, using an application’s Print dialog box.

• A face-up output tray

This fits on the rear of the printer to catch paper. You’ll need this tray if you select the
Rear (face up) option in an application’s Print dialog box.

Because you can select the 500-sheet paper tray and the envelope tray from your computer,
you’ll need to change the printer driver software also. See the section “Updating your
computer’s software.” You may want to make the 500-sheet paper tray your default paper
tray. This is covered in the section of this appendix “Setting default paper trays through the
control panel.”

Installing the 500-sheet feeder and paper tray

If you carry out the installation by yourself, you’ll need enough space to put the printer
alongside the 500-sheet feeder. If you have someone to help you, that person can position
the 500-sheet feeder while you hold the printer. When the installation is complete, the
printer will be five inches higher. Make sure that there will be enough space above the
printer to open the top cover.

1. Turn off the printer and disconnect the power and interface cables.

2. Remove the paper tray from the printer.
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3. Unpack the 500-sheet feeder and remove all
packing. Check that you have the sheet feeder,
the 500-sheet paper tray, and four locking
clips.

4. If you’re working alone, place the sheet feeder
next to the printer with the curved cover to
the front. If you have help, one person should
lift the printer up while the other puts the
sheet feeder into place.

6. Fit the locking clips at the left and
right front of both units.

7. Fit the locking clips at the left and
right rear of both units.

5. Lower the printer onto the sheet feeder. If
you align the front right corner of each part,
you’ll find that the printer will locate on the
three posts on the sheet feeder.
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8. Replace the 500-sheet and the 250-sheet paper trays.

9. If necessary, move the printer to the location where it will be kept. There are
two finger grips, one on either side of the sheet feeder.

10. Reconnect the power and interface cables.

11. Configure the software on each computer that will use the printer.

Using the 500-sheet paper tray and the envelope paper tray

The sheet feeder can hold either the 500-sheet paper tray or the envelope tray. These slide
into the sheet feeder in the same way as the 250-sheet paper tray slides into the printer.

Loading the 500-sheet paper tray

Loading the 500-sheet paper tray is similar to loading the 250-sheet paper tray, but you
adjust for different paper sizes in a different way.

1. Remove the paper tray from the feeder.

2. If you need to adjust the paper size guides, follow the next four steps. If not, go
to step 6.

3. Turn the paper tray so that the front is away from you. The length guide has
two indentations at left and right. Put your thumb in one and push up gently.
When this releases that side, push up the other side.

4. Slide the guide forward or backward so that the colored tabs on the base of the
paper tray align with the position for the paper size you’ll be using.

5. Press down on the guide to lock it into place. Turn the paper tray around so
that the front is toward you.

6. Squeeze the width guide lever toward its brace, and then pull the guide lever
to the right.
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7. Add paper to the tray by sliding it under the guides at the rear of the paper
tray, and then pushing down on the paper at the front of the tray until it fits
under the metal brackets. The paper tray may lock in the down position, but
when you insert the paper tray into the feeder it will release.

8. Squeeze the width guide lever toward its brace, and then move it so that it lies
next to the paper. Do not fit the width guide tightly against the paper, because
this may cause paper jams.

9. Replace the paper tray into the feeder. You’re now ready to print.

If you’re printing on letterhead, place sheets so that the letterhead is face down and toward
the front of the tray. If you use three-hole punched paper, position the paper so that the
holes are on the left side of the tray.

Loading the envelope tray with envelopes

Note: The Elite 12ppm does not check the size of the envelopes you place in the tray. Make
sure you’re using the envelope size you specified in your application.

1. Remove the envelope tray from the feeder and turn it so that the handle is
toward you.

2. If the postcard guide (a piece of plastic with the words “For Japanese Postcard”)
is at the rear of the area where you put envelopes, follow the next steps to
remove it. Otherwise, go to step 9.

3. Place your forefingers under the tab at the front of the postcard guide, and
press down on the top center of the guide with your thumb.
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4. Roll the postcard guide toward you by pulling it forward. It will become free at
the rear. Now you can slide it up and back to remove the two tabs from the
slots and remove it from the envelope tray.

5. Move the postcard guide to the right rear of the envelope tray. This is where
it’s stored when you’re not using it.

6. Tilt the back of the postcard guide up and toward you so that the two tabs fit
in the two slots.

7. Place your forefingers under the tab at the front of the postcard guide, and
press down on the top center of the guide with your thumb.

8. Rotate the postcard guide away from you so that it lies flat in the envelope
tray. It will click into place.

9. If the guides are set to the envelope size you intend to use, go to step 11.

10. Lift the rear of the size guide and move it back or forward so that it fits the size
of the envelopes you’re using.

The holes in the size guide fit over a pair of tabs in the bottom of the envelope
tray. The holes must fit over the tabs. The size guide has the names of envelope
sizes by the holes.

11. Squeeze the width guide lever toward its brace, and then pull the guide lever
to the right.
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12. Place the envelopes in the tray with the flaps upward and the hinge of the flap
toward the right.

13. Squeeze the width guide lever toward its brace, and then move it so that it lies
next to the envelopes. Do not fit the width guide tightly against the envelopes,
because this may cause jams.

14 Replace the envelope tray into the feeder. You’re now ready to print.

Loading the envelope tray with postcards

1. Remove the envelope tray from the feeder and turn it so that the handle is
toward you.

2. If the postcard guide (a piece of plastic with the words “For Japanese Postcard”)
is not at the rear of the area where you put postcards, follow the next steps to
install it. Otherwise, go to step 10.

3. The postcard guide is normally stored at the right rear of the envelope tray.
Place your forefingers under the tab at the front of the postcard guide, and
press down on the top center of the guide with your thumb.

4. Roll the postcard guide toward you by pulling it forward. It will become free at
the rear. Now you can slide it up and back to remove the two tabs from the
slots and remove it from the envelope tray.

5. Move the postcard guide to the back of the area where you load postcards and
envelopes.

6. Tilt the back of the postcard guide up and toward you so that the two tabs fit
in the two slots.

7. Place your forefingers under the tab at the front of the postcard guide, and
press down on the top center of the guide with your thumb.

8. Rotate the postcard guide away from you so that it lies flat in the envelope
tray. It will click into place.

9. If the guides are set to the postcard size you intend to use, go to step 11.

10. Lift the rear of the size guide and move it back or forward so that it fits the size
of the postcards you’re using.

The holes in the size guide fit over a pair of tabs in the bottom of the envelope
tray. The holes must fit over the tabs. The size guide has the names of envelope
sizes by the holes.
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11. Squeeze the width guide lever toward its brace, and then pull the guide lever
to the right.

12. Place the postcards in the tray with the side to be printed downward and the
top of the postcard toward the right.

13. Squeeze the width guide lever toward its brace, and then move it so that it lies
next to the postcards. Do not fit the width guide tightly against the postcards,
because this may cause jams.

14. Replace the envelope tray into the feeder. You’re now ready to print.

Installing the face-up output tray

The face-up output tray fits on the rear of the printer and holds output that would other-
wise be deposited in the output tray on the top of the printer. If you have paper that’s
heavier than normal copy paper, you may need to use the face-up output tray to prevent
paper jams and creasing.

If you use the multi-purpose feeder at the front of the printer, the face-up output tray gives
you a straight-through path through the printer which minimizes jams and creasing.

1. Unpack the paper tray and remove all packing materials.

2. Align the tabs on the bottom of the tray with the holes in the back of the
printer.

3. Push down on the tray to insert the tabs into the holes.

4. Slide out the underside of the tray to its fullest extent so that it locks into place.

5. Lift up the hinged part of the tray so that it extends further.
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Setting default paper trays through the control panel

You may want to make the 500-sheet paper tray your default paper tray. This means that it
will appear as the default choice in applications’ Print dialog boxes.

You can make the 500-sheet tray the default by using the printer’s control panel. Briefly,
you take the printer offline, choose the Paper Handling menu and select Tray 1 from the
Default Source submenu. Full details of how to change menu settings are in the section of
this manual under “Control Panel.”

You can change the settings in the control panel before you carry out the software updates
on computers. If you decide to change the settings on the printer after you’ve updated the
software on the computers, you’ll have to update the software again.

Updating your computer’s software

You have to update your printer driver so that the new paper tray will be shown as an
option in the list of available paper trays. How you do this varies between operating sys-
tems. Abbreviated instructions are given below. Full instructions are included in the rel-
evant sections of this CD-ROM. These changes must be made to every computer that will
use the printer.

Macintosh

You make your Macintosh aware of changes to the printer by selecting the LaserWriter 8
icon in the Chooser, and clicking on the name of printer from the list. Then click Setup,
and then click Auto Setup. The printer sends information to the computer, which updates
the printer information in the computer.

Windows 3.1 and Windows NT 3.5 and NT 3.51

All versions of Windows before Windows 95 and NT 4.0 let you select any one of the
complete range of standard and optional paper sources, even if you haven’t installed those
paper sources. If you choose a paper source that isn’t installed, the printer uses the main
paper tray. There’s no need to configure your software, as the printer will now use the
correct paper source when you select it.
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Appendix E: QuickDraw GX
Introduction

QuickDraw GX is Apple Computer’s printing and typographic system software. This
appendix is a brief introduction to the printing features provided with QuickDraw GX and
to the specific printing interface provided by GCC QuickDraw GX PostScript printer
drivers.

Note: Additional information about QuickDraw GX printing can be obtained through
Macintosh Guide, the online help system installed with System 7.5 or later. To access the
information, click the question mark icon  on the right side of the menu bar and select
Macintosh Guide. When the main Macintosh Guide dialog box appears, click Printer &
Fonts from the Topics scroll box on the left.

Installing QuickDraw GX is a separate procedure included with System 7.5 or later. Please
refer to your Apple System documentation for installation instructions.

Note: For the purposes of this appendix, the GCC SelectPress 1200 is used as an example to
detail QuickDraw GX functions and features. Your GCC printer’s supported paper sizes,
paper sources, and features may differ.

QuickDraw GX compatibility

QuickDraw GX requires Macintosh System 7.5 or later. Your applications must support
QuickDraw GX. There are three levels of QuickDraw GX compatibility:

• Unadopted – Applications that do not support QuickDraw GX will display Page
Setup and Print dialog boxes that are variants of the standard QuickDraw GX dialog
boxes. QuickDraw GX can be disabled in unadoptive applications via the Turn Desk-
top printing On/Off option in the Apple Menu. Turning off desktop printing substi-
tutes the LaserWriter 7.2 printer driver for the currently selected GCC QuickDraw GX
printer driver.

• Aware – GX aware applications offer full support of QuickDraw GX Page Setup and
Print dialog boxes, and Desktop printing.

• Savvy – GX savvy applications offer full support of QuickDraw GX Page Setup and
Print dialog boxes, and Desktop printing. GX savvy applications also support the
advanced typographic capabilities provided by QuickDraw GX. The guide does not
cover QuickDraw GX typographic capabilities.
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Installing GX drivers

The printing software for your new printer includes a QuickDraw GX printer driver. When
you install the rest of your printing software, QuickDraw GX is also installed.

Choosing a GX printer driver (creating a desktop printer icon)

With QuickDraw GX you no longer use the Chooser to select a printer. Now, you use the
Chooser to create desktop printer icons for each of your printers. These icons are then
placed on your desktop. Once you have created the appropriate desktop printer icons, you
will no longer need to open the Chooser for any printer related tasks.

A desktop printer contains general information about the capabilities of your printer (e.g.,
resolution(s), memory, supported paper sizes, etc.). Also, by creating a desktop printer the
standard QuickDraw GX Page Setup and Print dialog boxes are edited to reflect the user-
selectable options available with your particular printer.

1b In this box, click the
name of the
AppleTalk Zone (if
any) that the printer
is connected to.

1c In this box, click the
name of the printer.

Make sure AppleTalk
is Active, and chosen
in the Connect via:
pop-up menu.

1a In this box, click the
GX driver that
corresponds to the
GCC printer you are
using.

To create a desktop printer icon:

1. Choose the Chooser from the Apple (ð ) menu.

The Chooser appears.

2. Click Create.

In a few moments a desktop printer icon for the printer you selected will appear on your
desktop.
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Note: QuickDraw GX allows you to share a desktop printer, similar to the way you can
share folders, with other users on the network. For more information open Macintosh
Guide and refer to “share a printer with other users?” under the topic Printers and Fonts.

Configuring a desktop printer

After you have created a desktop printer you need to configure it. A desktop printer is
configured through the desktop printer’s Printing menu. To access the Printing menu,
click a desktop printer icon; the Printing menu will appear in the Macintosh menu bar next
to the Special menu.

The Printing menu contains selections for the following functions:

Background printing

In QuickDraw GX, background printing is always on. The Printing menu contains the
following options for controlling background printing:

• Start Print Queue

• Stop Print Queue

• Hold Print Request

• Resume on Page One

• Resume on Page…

• Set Print Time…

For information about the above commands and the background printing operation in
general, open Macintosh Guide and click Look For. When the search window appears type
background printing into the entry box and click Search. Double-click the manage printing
jobs? phrase to access the information.

Setting default printer

If you have more than one desktop printer use this option to designate
one of them as the default printer.

Note: Each time you create a new desktop printer, it becomes the
default printer.

To set a default printer:

1. Click the desktop printer icon of the printer that you
want to make the default.

2. Choose Set Default Printer from the Printing menu.
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The default printer is now set. Notice that the default desktop printer icon now has a dark
border around it. All print jobs will now be sent to this printer, unless you specify other-
wise.

Determining input tray paper size(s)

The Input Trays… selection enables you to “tell” the printer driver about your printer’s
paper sources and the paper sizes that they will contain.

When you first open the Input Trays… dialog box, it will look like the one pictured directly
below. This dialog box will not display the paper sources available on your printer. How-
ever, if you click in the box containing unknown, you will see a list of the paper sizes that
are supported by your printer.

 

In order for the printer driver to learn about your printer’s paper sources (e.g., lower tray,
upper tray multipurpose feeder, etc.) you must first print something. The quickest way to
do this is:

1. Go to the Finder.

2. Choose Print Desktop… from the File menu.

3. In the Print dialog box, enter 1 in both the From and To boxes.

4. Click Print.

In a few moments a page will print.
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5. Choose Input Tray… from the Printing menu again.

A new dialog appears, specific to your printer. It should display the paper sources
available from your printer, and provide a paper size pop-up menu, listing all sup-
ported sizes, for each source.

6. Choose a paper size for each paper source.

Although QuickDraw GX enables you to specify a paper size for each paper source, it
is recommended that you leave the pop-up menus set to Unknown. This is recom-
mended because the internal software of GCC printers is able to direct print jobs to
the paper tray containing the correct size paper.

7. Click OK.

Selecting printer extensions

The QuickDraw GX software is “extensible,” meaning that Apple or third-party developers
can add new capabilities (e.g., watermarks) to it.  These extended capabilities are called
printer extensions.

The Extension Setup… selection in the Printing menu enables you to choose which printer
extensions to use with a desktop printer and the order in which they are to be applied
during printing. Refer to the Macintosh Guide and the documentation accompanying
third-party printer extensions for more information.

Configuring printer extensions

Some printer extensions can be configured from the Printing menu. These printing exten-
sions will be added to the bottom of the Printing menu.

QuickDraw GX Page Setup dialog box (GX aware applications)

The QuickDraw GX Page Setup dialog box displayed by GX aware and savvy applications is
a “two-level” dialog box. When you choose Page Setup from the File menu, the dialog box
below appears:
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This is the first-level dialog box; it enables you to choose:

• Paper Type (paper size)

• Orientation

• Scaling

After choosing options, click:

More Choices to see the second-level of the Page Setup dialog box, which contains addi-
tional page setup options.

Cancel to close the Page Setup dialog without saving any changes.

Format to save your page setup selections and close the Page Setup dialog box.

If you click More Choices, the second-level of the Page Setup dialog box appears displaying
additional page setup options.

The second-level of the dialog box uses page setup panels to display different groups of
options. Page setup panel icons appear in a scroll box on the left side of the Page Setup
dialog box.

All printers have General panel, and all GCC printers have an Options panel.
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The General page setup panel

When the General panel is highlighted, the Page Setup dialog box looks like the one pic-
tured above. This panel contains the same options as the first-level Page Setup dialog, plus
the Format for pop-up menu.

The Format for pop-up menu is divided into two sections by a
dotted line:

Above the line is a list of all QuickDraw GX drivers installed in your
Extensions folder.

Below the line is a list of desktop printers that you have created.

The default for this menu will correspond to the default desktop printer. However, if you
want to print the document to another desktop printer, choose it from the list below the
dotted line. This will enable you to access the Options panel for the newly selected printer.

Note: Choosing a new printer from the Format for menu does not change the default
printer; use either the Set Default Printer command in the Printing menu in the Finder, or
select a different printer in the Print to menu in the Print dialog box.

The Options panel

When Options (preceded by the name of your GCC printer) is highlighted in the scroll box
on the left, the Page Setup dialog box looks like the one pictured below.

The first three options, Flip horizontal, Flip vertical, and Invert image, are available with all
GCC printers. Other options may appear in this panel (e.g., AccuGray™) depending on the
model of your GCC printer.

After choosing options, click:

Fewer Choices to return to the first level of the Page Setup dialog box.

page setup panels
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Cancel to close the Page Setup dialog without saving any changes.

Format to save your page setup selections and close the Page Setup dialog box.

QuickDraw GX Print dialog box (GX aware applications)

The QuickDraw GX print dialog box displayed by GX aware and savvy applications is a
“two-level” dialog box similar to the Page Setup dialog box.

When you choose Print from the File menu, the dialog box below appears:

This is first-level Print dialog box; it enables you to choose:

• Printer (Print to)

• Page range (Pages)

• Number of copies (Copies)

The Print to pop-up menu enables you to print to a desktop printer other than the default
desktop printer.

After choosing options, click:

More Choices to see the second level of the Print dialog box, which  contains additional
page setup options.
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Cancel to close the Print dialog without saving any changes.

Print to print your document with the selected options.

If you click More Choices, the second-level of the Print dialog box appears displaying
additional Print options.

Like the Page Setup dialog box, the second-level of the Print dialog box uses page setup
panels to display different groups of options. The panel icons appear in a scroll box on the
left side of the Print dialog box.

All printers have a General panel. There are also a number of standard GX panels (Print
Time and Paper Match). Third-party printer extension panels will also appear here.

The General print panel

When the General panel is highlighted, the Print dialog box looks like the one pictured
above. This panel contains the same options as the first-level Print dialog box, plus the
following additional options:

• Paper Feed

• Destination

• Quality

Paper Feed enables you to choose the paper source. The options are:

• Automatic.  Choosing Automatic directs the printer to draw paper from the paper
tray containing the paper size specified in the Page Setup dialog box’s Paper Type
pop-up menu. Automatic is the default.

• Manual.  Choosing Manual directs the printer to prompt you to insert the specified
paper size into the manual feed position and press the Manual Feed key.
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Destination enables you to send your document to the selected desktop printer, or to save it
to a PostScript file. Printer is the default.

If you choose PostScript®, the Print button changes to Save. Clicking the Save button
causes a Save dialog box appear:

Enter a location that you want your file saved to.

You can also select the fonts that should be saved with your document, using the Include
pop-up menu.

Note: Choosing the Non-Standard Fonts option includes all the fonts used in your docu-
ment except for printer-resident fonts. (See your User’s Manual for more information
about resident fonts.)

Quality enables you to choose an output resolution (in dots-per-inch) for your document.
The available resolutions will depend on the GCC printer model being used.

Other print panels

The Print dialog box also contains some other panels that are standard with QuickDraw
GX.

Print Time – This panel enables you to control when a document will be printed.

Paper Match – This panel enables you to redirect a document to another paper tray. It
also allows you to choose how the document should be adjusted (cropped, tiled, scaled) if
the paper in the selected tray is too small.

After choosing options, click:

Fewer Choices to return to the first level of the Print dialog box.

Cancel to close the Print dialog without saving any changes.

Print to print your document with the selected options.
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Page Setup and Print dialog boxes (unadopted applications)

If QuickDraw GX is enabled and you are printing from an application that has not adopted
QuickDraw GX, the application will display alternate Page Setup and Print dialog boxes.

The dialog boxes will display standard page setup and print options (paper size, orienta-
tion, scaling, etc.), plus any printer-specific options (e.g., paper sizes, resolution) available
with the selected desktop printer. Note: Not all printer-specific options will be available
(e.g., AccuGray) from the alternate dialog boxes.

Note: The alternate dialog boxes may not be accessed the same way (i.e., choosing Page
Setup and Print from the File menu) in all applications. For example, in PageMaker 5.0.x.,
the alternate Page Setup and Print dialog boxes are accessed by choosing Print from the
File menu and then clicking Setup in the Print dialog box.

Page Setup dialog box

The Page Setup dialog box pictured below appears in applications that have not adopted
QuickDraw GX.

The Page Setup dialog enables you to choose:

• Paper (paper size)

• Orientation

• Reduce or Enlarge (scaling)

• Pages per Sheet (n-up printing)

• Options (Flip horizontal, Flip Vertical, Invert Image, and Precision Bitmap Align-
ment)

The Custom pop-up menu displays the additional paper sizes supported by the selected
desktop printer.

Note: The default paper size for GCC GX drivers is US Letter. However, it has been ob-
served that some applications will default to some other paper size.
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Print dialog box

The Print dialog box pictured below appears in applications that have not adopted
QuickDraw GX.

The Page Setup dialog enables you to choose:

• Number of copies (Copies)

• Page range (Pages)

• Cover Page

• Paper Feed

• Destination

• Resolution

The Resolution pop-up menu displays the resolutions supported by the selected desktop
printer.

Turning off QuickDraw GX printing

If you are having problems printing from an application that has not adopted QuickDraw
GX, you have the option of turning QuickDraw GX off.

The command Turn Desktop printing On/Off is inserted into the Apple Menu when an
application that does not support QuickDraw GX is in use.

Note: The Turn Desktop printing On/Off command will only appear if QuickDraw GX
Helper is installed.

When you choose Turn Desktop printing Off, QuickDraw GX substitutes LaserWriter 7.2
as the default printer driver. LaserWriter 7.2 is installed with System 7.5 and provides
standard Apple LaserWriter paper source and paper size options. (See information on the
following page.)
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Substituting LaserWriter 7.1.2 or LaserWriter 8 for LaserWriter 7.2

The LaserWriter 7.2 printer driver provides paper sources and paper sizes that correspond
to the standard Apple LaserWriter. Therefore, when this driver is used you will not be able
to select the paper sizes and sources supported by your GCC printer.

However, you can regain access to your GCC printer’s paper sizes and sources by causing
QuickDraw GX to substitute either the customized LaserWriter 7.1.2 printer driver that
comes with your GCC printer software, or LaserWriter 8 (which enables you to use the
PPD file for your GCC printer).

Substituting Laser 7.1.2

You can force QuickDraw GX to use the custom version of Laser 7.1.2 by renaming it.

To rename the printer driver:

1. Open the Extensions folder.

2. Locate the printer driver that corresponds to your GCC printer’s name.

3. Rename the printer driver.

Because of the method (alphabetical search) QuickDraw GX uses to substitute a driver, we
recommend that you add either an A or a space to the beginning of the
printer driver’s name. For example the printer driver that comes with all
Elite XL printers is named Elite XL. To force it to substitute for LaserWriter
7.2, change the name to AElite XL.

Substituting LaserWriter 8

The automatic substitution procedure used by QuickDraw GX always seeks
to use a version of LaserWriter 7.x.x whenever possible. Therefore, you
must first remove any versions of LaserWriter 7.x.x from the Extensions
folder and then use the LaserWriter 8 Setup function to configure any
printer(s) you plan to use, with the correct PPD(s).

Important Note: The following procedures presume a knowledge of System 7.5 and
LaserWriter 8 components. For more information, refer to the LaserWriter 8 section of
your printer’s user’s manual and/or the System 7 and 7.5 documentation. You may also
contact GCC Technical Support at 781-276-8620.

To use LaserWriter 8:

1. Remove any versions of LaserWriter 7.x.x from the Extensions folder.
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If you are not sure of the version of a printer driver, highlight it and select Get Info
from the File menu. The version number will be displayed near the bottom of the box.

2. Determine if LaserWriter 8 is in your Extensions folder.

If you do not have a copy of LaserWriter 8 in the Extensions folder, install one using
the installer on your printing software disk or your System disks.

3. Disable QuickDraw GX.

Use the Extensions Manager control panel to disable both QuickDraw GX and
QuickDraw GX Helper.

4. Restart your Macintosh.

5. Open the Chooser.

6. Configure printer(s).

Use the Setup function to select a PPD for each GCC printer that you intend to use
with QuickDraw GX desktop printing turned off.

7. Re-enable QuickDraw GX.

Use the Extensions Manager control panel to Re-enable both QuickDraw GX and
QuickDraw GX Helper.

8. Restart your Macintosh.

9. Create desktop printer(s).

Now, when you choose Turn Desktop printing Off, LaserWriter 8 will be substituted
instead of LaserWriter 7.2.

Important note on fonts: Because QuickDraw GX modifies your fonts when it is installed,
documents printed with desktop printing turned off might not print correctly. If your
document uses non-resident Type 1 fonts, they will print as bitmaps. To fix this problem,
open the folder named •Archived Type 1 Fonts• in your System Folder. (This folder is
created during the QuickDraw GX installation.) Copy the any Type 1 font files (you don’t
need to copy the font suitcases) that you need into the Fonts folder.
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Appendix F: PCL
The table below some frequently-used PCL printer commands (escape sequences) that can
be useful when sending a PCL print job from DOS to your GCC printer. PCL commands
tell the printer which actions to perform or which fonts to use.

The commands listed below are a subset of the PCL command set. When entering escape
sequences, substitute the # symbol in the escape sequence referenced in the left column
with the appropriate number from the right column.

The character l shown in some examples after the ampersand (&) is a letter l (a lower-case
letter L).

Printer command

EC

LF

FF

CR

ECE

EC&l#X

EC&l0X

EC&l#H

EC&l#A

EC&l#O

EC&a#L

EC&a#M

EC&l#E

EC&l#F

Function

Escape character

Line feed

Form feed

Carriage return

Resets printer

Number of copies

Ejects page

Selects paper source

Selects a paper size

Select orientation

Sets left margin

Sets right margin

Sets top margin

Sets page length

# refers to

n/a

n/a

n/a

n/a

n/a

1 to 32,767

n/a

1 = tray 1, 2 = manual feed, 3 = manual feed,

4 = tray 2, 6 = MPFeeder

1 = executive, 2 = letter, 3 = legal 14”, 26 = A4, 45 =

JIS B5, 62 = legal 13”, 71 = postcard,

80 = monarch, 81 = commercial 10, 90 = DL

0 = portrait, 1 = landscape

Column number

Column number

Number of lines

Number of lines from top margin
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The PCL font list page, which can be printed via your printer’s control panel Info Pages
menu, contains information about the 15 resident PCL fonts; a second page is printed if
you have downloaded other PCL fonts to the printer’s memory. The font list pages
contain nine columns of information. See the following page for a description of the
information in each column.

Courier 10
«Esc»(8U«Esc»(s0p10h12v0s0b3T

Resident Fonts      Bitmapped

2

Num Font Name

ABCDE fgh ij[ !} @ #^&=123'
ÀÂÈÊËYy0ÇçNn!?oÜßÁDÒ

ABCDE fgh ij[ !} @ #^&=123'
ÀÂÈÊËYy0ÇçNn!?oÜßÁDÒ

0

3

0

0

12

12

10

10

Roman-8

Roman-8

Weight Print SampleStylePointsPitchSymbol Set

Courier 10 Bold
«Esc»(8U«Esc»(s0p10h12v0s3b3T

1

ID

205

204

9

2

1

3

4

5

6

7

8

PCL Downloaded Fonts

Elite 1212™

PCL Resident Fonts

Elite 1212™
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1. Font Number: The number you would use to select a font as the default font in the
PCL Font Number submenu.

2. Font Name: The name of the default font. The escape sequence for the font is also
shown below the font name.

3. Symbol Set: The specific group of special characters that will be available with the
default font.

4. Pitch: The number of characters per inch.

5. Points: The vertical height of a character.

6. Style: Indicates the appearance and posture of the typeface, such as italic, upright, or
condensed.

7. Weight: Indicates the density of a typeface, such as medium, bold, light, or black.

8. Print Sample: Shows a sample of how the font will print.

9. Font ID: The identification number assigned to a downloaded font.
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Appendix G: Interface connector pinouts
Use the following pinouts and descriptions of the various printer interface connectors if
you need to purchase or make a new cable.

RS-422 Serial:

IBM  PC/XT  (P1)

25  PIN  SERIAL  PORT

SIGNAL PIN DIRECTION
SHELL

CH. GND 1
TXD 2

RXD 3

RTS 4
CTS 5

DSR 6

SIG.GND 7

DCD 8
DTR 20

PIN
SHELL

1
2

3

4
5

6

7

8

HSKO
HSKI

TXDB-

SIG.GND
RXDB-

TXDB+

NC

RXDB+

SIGNALDIRECTION

PRINTER  (P2)

MINI-DIN 8

BRAIDED  SHIELD

NC
NC

NC

Uni-directional Parallel

PIN SIGNAL DESCRIPTION DIRECTION

1 /STROBE Data Strobe In to Printer

2 D1 Data Bit 1 In

3 D2 Data Bit 2 In

4 D3 Data Bit 3 In

5 D4 Data Bit 4 In

6 D5 Data Bit 5 In

7 D6 Data Bit 6 In

8 D7 Data Bit 7 In

9 D8 Data Bit 8 In

10 /ACK Acknowledge Out from Printer

11 BUSY Busy Out

12 PERROR Paper Empty Out

13 SELECT Select Out Out

14 /AUTOFD Not Used In

15 NC Not Used

16 GND Signal Ground
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17 CGND Chassis Ground

18 NC Not Used

19-30 GND Signal Ground

31 /INIT Initialize In

32 /FAULT Printer Fault Out

33 NC Not Used

34 NC Not Used

35 NC Not Used

36 /SELECTIN Not Used

Bi-directional Parallel (nibble mode)

PIN SIGNAL DESCRIPTION DIRECTION

1 /STROBE Data Strobe In to Printer

2 D1 Data Bit 1 In

3 D2 Data Bit 2 In

4 D3 Data Bit 3 In

5 D4 Data Bit 4 In

6 D5 Data Bit 5 In

7 D6 Data Bit 6 In

8 D7 Data Bit 7 In

9 D8 Data Bit 8 In

10 /ACK Acknowledge Out from Printer

11 BUSY Busy Out

12 PERROR Paper Empty Out

13 SELECT Select Out Out

14 /AUTOFD Autofeed In

15 NC Not Used

16 GND Signal Ground

17 CGND Chassis Ground

18 NC Not Used

19-30 GND Signal Ground
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31 /INIT Initialize In

32 /FAULT Printer Fault Out

33 NC Not Used

34 NC Not Used

35 NC Not Used

36 /SELECTIN Select In In

Ethernet (UTP):

PIN SIGNAL DESCRIPTION DIRECTION

1 TX+ Transmit+ Out

2 TX- Transmit- Out

3 RX+ Receive+ In

4 NC

5 NC

6 RX- Receive- In

7 NC

8 NC

LocalTalk:

PIN SIGNAL DESCRIPTION DIRECTION

1 HSKO Handshake Out Out

2 HSKI Handshake In In

3 TXD- Transmit Data- Out

4 SIG GND Signal Ground

5 RXD- Receive Data- In

6 TXD+ Transmit Data+ Out

7 NC Not Used

8 RXD+ Receive Data+ In
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Appendix H: Radio and TV interference
Your printer generates radio frequency energy and, if not installed and used in accordance
with GCC Technologies’ instructions, it may cause interference to radio and television
communications.

This GCC printer was certified under test conditions that included the use of shielded
cables and connectors between system components. It is mandatory that you use shielded
cables and connectors to reduce the possibility of causing interference to radio, television,
and other electronic devices.

You can determine whether your printer is causing interference by turning it off. If the
interference stops, it was probably caused by your printer.

If your printer does cause interference to radio or television reception, you can try to
correct the interference by using one or more of the following measures:

• Turn the television or radio antenna until the interference stops.

• Move the printer to one side or the other of the television or radio.

• Move the printer farther away from the television or radio.

• Plug the printer into a different outlet so the printer and receiver are on different
circuits.

If necessary, you should consult your dealer or a radio/television technician for additional
suggestions. You may also find helpful the following booklet prepared by the Federal
Communications Commission: How to Identify and Resolve Radio-TV Interference Prob-
lems. This booklet is available from the US Government Printing Office, Washington, DC
20402, Stock No. 004-000-00345-4.
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Appendix I: Elite 12ppm Consumables
and optional accessories

Optional items

You can add optional accessories to your Elite 12ppm. Contact GCC Direct Sales at (800)
422-7777 (U.S. only) or your local dealer. For a complete list of optional Elite 12ppm
items, see our World Wide Web store at www.gccdirect.com.

Elite 12ppm Lower Sheet Feeder

If you want to add a 500-sheet paper tray or an envelope feeder, you must first install the
lower sheet feeder. This attaches to the bottom of the Elite 12ppm; the trays fit inside it.
The lower sheet feeder is supplied with a 500 sheet paper tray. This holds up to 500 sheets
of letter, A4, Legal 13” and Legal 14” paper. You can attach a single lower sheet feeder to
the Elite 12ppm printer.

Elite 12ppm Optional paper trays

The following optional paper trays are available for use with the Elite 12ppm:

• Universal paper tray

Capacity 250 sheets — Replacement for the standard tray shipped with the Elite 12ppm.
You may find it convenient to have separate paper trays for each kind of stationery you
use.

• Envelope tray

Commercial #10, Monarch, DL, C5, Postcard — Optional tray with a capacity of 30
standard weight envelopes. Requires the 500-sheet feeder.

• 500-sheet paper tray

Capacity 500 sheets — requires the 500-sheet feeder.

Elite 12ppm Face Up output tray

The Elite 12ppm face up output tray attaches to the rear of the printer. It holds output
when you choose Rear Output (Face Up) in your applications. When you use it with the
multipurpose feeder, it provides a straight through paper path.
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Elite 12ppm Accessory Order Numbers

Each Elite 12ppm accessory description is followed by the GCC order number.

• Elite 12ppm Toner cartridge .................................................................. AC16120

• Elite 12ppm Standard Universal paper tray (250 sheet capacity) ................. AC16128

• Elite 12ppm Lower Sheet Feeder (500 sheet capacity)

including a 500-sheet paper tray ............................................................ AC16126

(compatible paper trays) – .......................................................... AC16130, AC16132

• Elite 12ppm Paper tray (500 sheet capacity) ............................................  AC16130

(use with sheet feeder) – ....................................................................... AC16126

• Elite 12ppm Envelope Tray (30 envelope capacity) ......................................... AC16132

(use with sheet feeder) – ........................................................................ AC16126

• Elite 12ppm Face up output tray ............................................................ AC16136

• Elite 12ppm 8 Megabyte memory expansion kit ....................................... AC16311

• Elite 12ppm 16 Megabyte memory expansion kit ..................................... AC16313

• Elite 12ppm 32 Megabyte memory expansion kit ....................................  AC16315

• Farallon PhoneNET Connector Kit ......................................................... AC13270

• HDI 30 to SCSI cable ............................................................................ AC13369

• SCSI terminator ................................................................................... AC10060

• Uni-directional Parallel Cable ................................................................ AC15282

• Shipping box and foam ....................................................................... 102.16349

• Elite 12 ppm CD-ROM with software and documentation ...................... 101.16317

• Quick Installation guide ...................................................................... 030.16319
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Appendix J: Glossary
5 percent page: A page of text, used to provide a standard for the number of pages that can
be printed using one toner cartridge. So named because the toner covers five percent of the
page.

Adobe Type 1: One of the two common file formats for fonts (the other is TrueType).
Requires a PostScript printer or Adobe Type Manager for fonts to print correctly. Fonts can
be scaled to any size.

Adobe Type Manager: A program which allows you to use Adobe Type 1 format fonts on a
non-PostScript printer. Also improves the on-screen display of fonts.

AppleTalk: A network communication protocol for connecting Apple computers and
other devices to share information. When used with an EtherNet network interface, this is
known as EtherTalk.

Apply button: A button, usually found in a dialog box, which makes any changes specified
in the dialog box. Unlike the OK button it does not close the dialog box. See OK button,
Close button, and Cancel button.

AccuGray: A GCC software technology that enables truer halftone reproduction by coun-
teracting the effects of dot gain and by adjusting the print engine’s gray level response to a
1 to 1 correspondence.

all ports active: Technology that allows you to connect several computers and/or networks
to one printer. Each port is able to accept print jobs without affecting the others.

application (program): A program, such as Microsoft Word or PageMaker, used to
manipulate information.

baud: The speed at which data is transferred (bits/second).

bit: The smallest unit of computer information (a single binary digit).

bitmap: A representation of a shape in computer memory. It’s achieved by dealing with the
image area as a series of very small squares; if any square is more than 50 percent covered
by the image, that square is black (or, in color bitmaps, a color). Bitmaps typically are
made out of areas 1/72 or 1/96 of an inch square. Bitmap images cannot easily be enlarged
or reduced.

bitmap font: A font whose characters consist of the arrangement of bits into shapes. These
characters are used as screen fonts on computers that do not use scalable fonts, and they
tend to be jagged when printed on a high-resolution printer. Now largely replaced by
outline fonts.
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black and white: Used to define images which have no color information. Strictly speaking,
it should only describe images with no shades of gray - just areas of black. See halftone.

bus network: A form of network cabling where each computer is connected (daisy-chained)
to the computer at either side of it. The ends of the bus are terminated.

byte: A unit of computer information equal to 8 bits.

Cancel button: A button, usually found in a dialog box, which closes the dialog box and
does not carry out any changes that may have been specified. See Apply button, Close
button, and OK button.

check box: A small square section of a dialog box that when clicked puts a check mark in
the box. This shows that the feature or choice mentioned in the accompanying caption has
been selected. Clicking again removes the check mark. Check boxes can usually be selected
and deselected independently. See Option button.

Chooser: A Macintosh accessory that allows you to select and use networked devices such
as printers and file servers.

client/server: A form of networking used in larger installations. One or more computers
are dedicated as servers and handle all the network traffic from the other computers, known
as clients. Printers are usually installed anywhere on the network and are controlled by the
server(s). See also peer-to-peer.

clone: A functionally equivalent piece of hardware or software.

Close button: A button, usually found in a dialog box, which closes the dialog box so you
can see behind it. The Close button usually does not cause any changes to occur. See Apply
button, Cancel button, and OK button.

complex page: A page consisting of graphics or text and graphics. Complex pages may
require more printer RAM to print.

Control Panel: Part of the Windows or Macintosh system software. Also the panel at the
front of the printer itself.

daisy-chain: A way of connecting devices on a network. Cables pass from one device to the
next. The ends of the daisy chain are not connected, but have terminators attached.

default: A value or setting built in to a system or program. A default can usually be
changed, but is chosen to be satisfactory to the majority of users.

default printer: The printer that will appear as the default choice in print dialog boxes in
applications.
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desktop: The working environment of the Macintosh Finder and Windows systems that
displays folders, files, and applications as icons.

device: A piece of equipment, such as a hard disk, printer, or scanner, used with a com-
puter. Also known as a peripheral.

dialog box: A small window that opens up on the screen to get user input or acknowledg-
ment.

disk space: The amount of space available on a hard disk or floppy disk.

dot gain: An unavoidable increase in the size of halftone dots due to the interaction of
toner, paper, heat, and pressure during the printing process. This increase in dot size
increases the density of toner on paper, causing the printed output to appear darker. GCC’s
AccuGray technology works to counteract the effects of dot gain.

dots per inch (dpi): A measurement of resolution, or the density of dots, for a given output
device. Higher dots per inch usually give better image quality.

download: To send a font to a printer’s built-in memory (RAM) or hard disk.

drop-down list: A section of a dialog box that contains one entry but has a downward-
pointing arrow at the right. Clicking on the arrow reveals a list of alternative choices.

engine: The entire printer apart from the electronics.

EtherNet: A commonly-used network protocol.

flow control: The control of information along an interface to enable the interface to take
only as much information as it can handle.

folder: An organization tool for arranging documents, applications, and other folders on a
storage device. Known as a directory on Windows systems prior to Windows 95.

font: A collection of letters, numbers, punctuation marks, and special characters with a
consistent design. Also known as a typeface.

fuse: To melt toner particles so that they adhere to the paper.

fuser unit: The part of the printer that melts toner particles.

grayscale: The range of gray tones between black and white. The human eye can distin-
guish up to approximately 256 levels of gray.

halftone: An image made up of black toner dots. The printer simulates darker or lighter
shades of gray by printing greater or lesser amounts of dots in each area of the image. This
is a common method of printing photographs.
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halftone cell: A pattern of printed dots; each dot can be turned on or off in order to repre-
sent different percentages of gray.

high-quality fonts: Outline fonts that are shipped with the printer or purchased from your
dealer. On the Macintosh, screen fonts are used to create your documents and the printer
replaces them with high-quality fonts during the printing process. See outline fonts.

Installer: An application that installs the software.

interface: The point at which two devices are physically connected, enabling them to
communicate. Printers have a number of sockets; you plug a connector into these sockets
depending on whether you’re communicating with the printer by network, parallel, or
serial port.

jaggies: A slang term for the effect when some fonts and images print with jagged (rather
than smooth) edges. This usually happens if you attempt to print a resized bitmapped
image or font, or if you have screen fonts but not printer fonts on the Macintosh.

lpi: (lines per inch) A measure of the frequency of a halftone screen (usually between 53
and 200). Lpi refers to the lines of halftone spots that make up the screen. Higher lpi
usually means a better-quality image.

LocalTalk cable system: Apple’s network cable system used to support an AppleTalk
network system.

megabyte: A unit of measurement equal to 1024 kilobytes, or 1,048,576 bytes.

NEST (Novell Embedded Systems Technology): A feature of many GCC printers, which
can be used on Novell networks. Normally, a Novell network requires you to dedicate a
computer as a print server; NEST allows the printer itself to fill that function.

NetWare: Network software from Novell that enables computers to communicate with
other computers and peripherals such as printers.

network: A group of computers and peripheral devices, such as printers, that are intercon-
nected so they can communicate with each other. A network also includes the hardware,
such as cables that connect the devices, and the software that allows them to communicate.

OK button: A button, often found in a dialog box, which closes the dialog box and makes
any changes that were specified. See Cancel button, Close button, and Apply button.

on-screen preview: A representation of a vector image as a screen bitmap. This allows you
to edit the image in graphics programs; your changes are also applied to the vector image.
Windows previews are BMP format; Macintoshes are PICT. If you transfer a vector image
from Mac to PC or vice versa, you’ll usually lose the on-screen preview.

Download from Www.Somanuals.com. All Manuals Search And Download.



J-5

option button: A circular section of a dialog box when clicked causes the center part of the
circle to turn black. This indicates the feature or choice mentioned in the accompanying
caption has been selected. Option button are used in groups, and selecting one button
deselects all the others. See also Check box.

outline fonts: Fonts whose characters are vector images, built using mathematical represen-
tations. Unlike bitmapped fonts, they can be scaled to any size without degradation. Ex-
amples include PostScript (Adobe Type 1) and TrueType fonts.

output tray: Where paper is received after it has been printed. Usually on the top of the
printer.

pages per minute (ppm): The maximum number of pages that the printer’s paper trans-
port is deigned to pass through in one minute. If your pages are largely text, your printer
will produce printed pages close to the rated ppm; if you have more complex graphics
images, pages will appear more slowly.

paper jam: What happens when paper doesn’t flow smoothly through the paper path.
Paper is usually trapped inside the printer and creased or torn.

paper tray: Removable storage for sheets of paper. The printer takes sheets of paper from
the tray during the printing process. Also known as a cassette.

parallel: A way of transmitting information using (typically) eight bits at the same time.
Most PCs have a parallel port to connect to a printer. See also serial.

parity: A bit (number) in serial communication that is used to detect bad data transmis-
sion.

PCL: A page description language, similar to but much less powerful than PostScript.
Requires PCL-format fonts. Invented by Hewlett-Packard, PCL is now uncommon.

peer-to-peer: A form of networking used mainly in smaller installations. Any computer can
communicate directly with any other computer. Printers are often attached to computers
directly. See also client/server.

peripheral device: Any device used to input, output, or exchange data. See device.

pixel: The smallest area of a computer screen that can be controlled by software programs.
Screen resolution is measured in either the number of pixels visible across the entire screen
(for example, 640 x 480), or in pixels per inch. Screen resolution is usually less than printer
resolution, so you can’t guarantee that what you see is exactly what will print.

platform: A type of computer standard (Windows, Mac OS, DOS, etc.) which covers all
computers that conform to that standard, including clones.
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port: A communication connection often located on the back of computers and peripheral
devices, usually in the form of a socket.

PostScript: A high-level page description language. PostScript commands describe the text
and graphic images in a document.

PostScript printer: A printer equipped with circuitry that changes PostScript information
into a bitmapped image for printing.

print server: A computer on a network that takes print jobs from other computers and
sends them to the printer. This means that other computers on the network can return to
processing almost immediately while the print server communicates with the printer. See
also NEST.

printer description files: Files that allow certain applications to use printer-specific fea-
tures.

printer driver: The software that creates a page description when you want to print a
document. This description is sent to the printer for printing.

printer font: The high-quality part of fonts for the Macintosh.

printer memory or printer RAM: Temporary storage space used to hold downloaded fonts
and for calculations during print jobs. If there’s insufficient printer memory, you may not
be able to print at the highest resolution of the printer.

printing software: Computer software needed for printing that includes the printer driver
and other related files.

printer’s disk: A hard disk attached to the printer that contains fonts and also serves as
temporary storage during print jobs.

processor: The CPU (central processing unit) or “chip” of the printer, which control all its
actions.

properties: Configuration characteristics of a peripheral or of a software feature. Usually
found in Windows operating systems or applications.

protocol: All the characteristics of (usually) a communications system, such as a network.
A protocol describes how the messages are constructed in software, as well as the types of
connectors used.

rasterize: To convert an image into a dot pattern that can be represented by dots of toner
on a page.
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resolution: The number of dots per unit of length or area. Higher resolution usually leads
to better image quality. High resolution pages typically have sharper text and more detailed
photographs than low resolution pages. High resolution pages may require more RAM to
print than the amount supplied in the printer.

RAM (Random-Access Memory): Temporary storage area for information. This informa-
tion is lost every time the computer or printer is shut down.

ROM (Read-only Memory): Permanent storage area for information. This information is
usually supplied by the manufacturer of the computer or printer and is not accessible by
the user.

RS-422: An 8-pin hardware interface that allows the transfer of data in an asynchronous
serial format. It has five user-defined parameters: baud rate, data bits, stop bits, parity, and
flow control. Your GCC printer’s RS-422 interface is shared with the LocalTalk interface.

screen fonts: Fonts displayed on the Macintosh screen; they’re represented on paper with
printer fonts. Screen fonts are not as high quality as printer fonts; if you don’t install the
printer fonts the printer will print the screen fonts.

screen frequency: The number of lines of dots per unit of length in a halftone screen.

SCSI: A standard for transmitting data. While often used to connect devices to computers
(particularly Macintoshes), it is used by GCC printers to optionally connect hard drives to
store fonts and other information. It is not used to connect the printer to the computer.
The SCSI chain on a printer is totally independent of any SCSI chain on the computer.

serial: A way of transmitting information one bit at a time. Serial transmission of data to
the printer is usually slower than parallel printing.

sheet feeder: An additional paper source. It requires a paper tray to actually hold the paper.

simple page: A page purely consisting of text.

star network: A form of networking where each computer is connected to a hub, and all
network traffic flows through the hub.

stop bits: The number of bits that specify the end of a serial transmission frame.

straight through paper path: A way of passing paper through the printer without it bend-
ing. Sometimes heavy or easily damaged paper can only be printed this way. Usually set up
by using the multipurpose feeder and a rear output tray.

smoothing: A process that makes the text and graphics of some applications look better.

startup disk: The disk (usually a hard disk) containing the System and Finder files used to
run the Macintosh.
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System 7, OS 8: Various versions of the Macintosh system software (“Mac OS”).

system administrator: The person responsible for keeping a network running smoothly.
This person may be needed to configure computers and printers connected to a network.

System Folder: The folder containing Macintosh System and Finder files used to start and
run the Macintosh.

terminator: A small device connected at the ends of certain network and SCSI cabling. If
you don’t use a terminator where needed, the network or SCSI chain will operate errati-
cally or may not operate at all.

toner: A special plastic powder in the toner cartridge that “fuses” to the paper to create an
image.

toner cartridge: A plastic box containing toner; the cartridge is placed in the printer to
supply toner during the printing process. Toner cartridges often also contain an imaging
drum.

TrueType: A file format for fonts which can be scaled to any size. Supporting software is
built in to Windows and Macintosh system software. One of the two major font file for-
mats (the other is Adobe Type 1).

vector images: Images that are described in computer memory using a series of instruc-
tions on how to draw each part. Because there’s no reference to the quality of the printer or
other output device, vector images can be easily scaled up or down. Eventually the instruc-
tions are converted to a bitmap image (or rasterized) in the printer when the image is
printed. PostScript or EPS format files are an example of vector images.

WebAdmin: GCC’s program for remotely configuring printers on a network using a web
browser. Printers can be configured from anywhere in the world using the World Wide
Web.

Windows: A name for a series of Microsoft operating systems. Windows 3.0 and 3.1 do not
have built-in networking; Windows for Workgroups, Windows 95, and Windows NT 3.51
and 4.0 can be networked without additional software.

wizard: A series of dialog boxes used in Windows systems to carry out complicated tasks
step-by-step. Often used to configure items like printers.

x: (as in “Windows 3.x”, or “System 7.x”) A character representing any number or num-
bers. Therefore, “System 7.x” refers to variations of the Macintosh system software includ-
ing 7.1 and 7.5.5, and all other variations beginning with “System 7.”
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Appendix K: Warranties and Licenses

Software License Agreement
OPENING THE BAG CONTAINING THE SOFTWARE (the “Software”) WHICH ACCOMPANIES THIS MANUAL INDICATES
YOUR ACCEPTANCE OF THE TERMS AND CONDITIONS CONTAINED IN THIS LICENSE AGREEMENT. THE TERMS OF THIS
LICENSE AGREEMENT APPLY TO YOU AS THE ORIGINAL LICENSEE OF THE SOFTWARE AND THE RELATED USER
DOCUMENTATION (the “Documentation”) AND TO ANY SUBSEQUENT LICENSEE THEREOF.

IF YOU DO NOT ACCEPT OR AGREE TO THE TERMS OF THIS LICENSE AGREEMENT YOU MAY RETURN THE PRODUCT,
WITH DATED PROOF-OF-PURCHASE OF THE PRODUCT, TO YOUR DEALER WITHIN 10 DAYS FOR A FULL REFUND OF
PURCHASE PRICE THEREOF. ALL RETURNED SOFTWARE MUST BE UNUSED AND IN THE UNOPENED PLASTIC BAG.

LICENSE
In return for payment of the purchase price of your GCC Technologies Product (“the Product”), you have been
granted a limited, non-exclusive license (“License”) to use the Software and the Documentation on the terms set
forth in this License Agreement.

GCC Technologies, Inc. (“GCC”) retains ownership of these copies of the Software and the Documentation. These
copies of the Software and the Documentation are licensed to you according to the following terms:

PERMITTED USES
YOU MAY:
1. Use the Software with any appropriate GCC product.
2. Copy the Software onto a single hard disk drive.
3. Transfer the Software to another party, if the other party agrees to the terms and conditions of this License
Agreement and completes and returns a Registration Card to GCC. The Registration Card may be obtained by
writing to GCC’s Customer Service department at the address set forth below. If you transfer the Software to any
other party, you must transfer all copies and the Documentation to such party.
4. Make a single copy of the Software on another diskette for backup purposes only.

PROHIBITED USES
THE LICENSE OF THE SOFTWARE AND THE DOCUMENTATION GRANTED TO YOU IS LIMITED, AND YOU MAY NOT:
1. Make copies of any of the Documentation or make copies of the Software other than as expressly set forth
above.
2. Alter, modify or adapt the Software or the Documentation, including translating, decompiling, disassembling,
creating derivative works, or merging the Software with other software.
3. Use any backup diskette you have made or allow someone else to use any backup diskette unless the Software
on the original diskette is defective.
4. Rent, sublicense, assign or otherwise transfer any interest in any of the Software or the Documentation except
as set forth above.
5. Modify or erase any copyright, trademark or proprietary rights notice on any medium containing the Software
or the Documentation or copy or reproduce any of the Software or the Documentation without all of GCC’s
copyright, trademark and proprietary rights notices.

The License is effective until terminated. You may terminate it at any time by destroying all copies of the Software
you have and mailing your original Software diskettes and the Documentation to GCC. The License and your right to
use the Software will automatically terminate upon your failure to comply with any provision of this License Agree-
ment or upon GCC’s election to terminate the License as set forth below. You agree upon such termination to destroy
all copies of the Software which you have and to mail your original Software diskettes and the Documentation to
GCC.

GCC retains all rights and title to the Software and the Documentation except for the limited license contained
herein. The Software and the Documentation are protected by the copyright laws of the United States. There are
severe penalties, civil and criminal, for copyright infringement. Nothing in this License Agreement constitutes a
waiver of GCC’s rights under the copyright laws of the United States or any other law.
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Limited Software Warranty
WARRANTY
If you discover physical defects in the medium on which the Software or the Documentation are distributed, at its
option, GCC will either replace the medium at no charge to you or terminate the License and require the return of
your Product, and upon such return, refund to you the purchase price thereof.  To qualify for this warranty, you must
return the defective medium with proof-of-purchase to GCC during the one year period after you acquired the
Software.

Except as set forth in the immediately preceding paragraph, GCC PROVIDES THE SOFTWARE AND THE DOCUMENTA-
TION “AS IS” AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR WARRANTIES OF
QUALITY OR PERFORMANCE.  YOU THE LICENSEE ARE ASSUMING THE ENTIRE RISK AS TO THE QUALITY OF THE
SOFTWARE AND THE DOCUMENTATION AND THE RESULTS OF ITS USE.  Your exclusive remedy with respect to the
Software, the Documentation and this License Agreement, shall be limited to the replacement of any defective
medium, or refund of the purchase price of your Product, as set forth above.

APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING THE ENCLOSED COM-
PUTER SOFTWARE PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.  THE EXCLU-
SION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES.  THE ABOVE EXCLUSION MAY NOT APPLY TO
YOU.  THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS.  THERE MAY BE OTHER RIGHTS THAT YOU
HAVE WHICH VARY FROM STATE TO STATE.

IN NO EVENT WILL GCC BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, even if advised of the
possibility of such damages.  In particular, GCC shall have no liability for any programs or data stored or used with
the Software, including the costs of recovering such programs or data.  In no event shall GCC’s liability with respect to
the Software, the Documentation and this License Agreement, in contract, tort (including negligence) or otherwise,
exceed the original price paid by you for your Product.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN,
EXPRESS OR IMPLIED.  No GCC dealer, agent, or employee is authorized to make any modification or addition to this
warranty.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIABILITY FOR INCIDENTAL OR CONSE-
QUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.  THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

GENERAL
This License Agreement is governed by the laws of the Commonwealth of Massachusetts.  This License Agreement constitutes the
entire agreement between GCC and you concerning the Software and the Documentation, and supersedes all prior communications,
agreements and understandings, written or oral, between GCC and you with respect thereto.

Should you have any questions concerning this License Agreement, the Software or the Documentation, you may contact GCC by
writing to Customer Service, GCC Technologies Inc., 209 Burlington Road, Bedford, MA  01730-9143.  For the name of the nearest GCC
service center or representative, call (800) 422-7777.

TRADEMARKS
GCC Technologies and the GCC Technologies logo are registered trademarks of GCC Technologies Inc. Elite 12ppm is a trademark of GCC Technologies, Inc.
Apple, AppleTalk, LocalTalk, LaserWriter, EtherTalk, Macintosh, and the Apple logo are registered trademarks of Apple Computer, Inc. Finder and TrueType
are trademarks of Apple Computer, Inc. PostScript is a registered trademark of Adobe Systems Incorporated. Adobe and Illustrator are registered
trademarks of Adobe Systems Incorporated. Adobe Type Manager, ATM, and Separator are trademarks of Adobe Systems Incorporated. PageMaker is a
registered trademark of Adobe Systems Incorporated. MacPaint and MacWrite are registered trademarks of Claris Corp. LetraSet is a registered trademark
of Esselte Pendaflex Corp. DesignStudio is a trademark of Esselte Pendaflex Corp. IBM is a registered trademark of International Business Machines Corp.
Helvetica, Palatino, and Times are registered trademarks of Linotype-Hell AG Corp. Phoenix Technologies, PhoenixPage, and Multi-grey are registered
trademarks of Phoenix Technologies. Centronics is a registered trademark of Centronics Data Computer Corp. Ethernet is a registered trademark of Xerox
Corp. Microsoft and Word are registered trademarks of Microsoft Corp. Windows and Windows 95 are trademarks of Microsoft Corp. Bitstream is a
registered trademark of Bitstream Inc. Speedo, Bitstream Dutch, Bitstream Swiss, Bitstream Swiss Narrow, and Bitstream Zapf Calligraphic are trademarks of
Bitstream Inc. ITC Avant Garde, ITC Bookman, ITC Zapf Chancery, and ITC Zapf Dingbats are registered trademarks of International Typeface Corporation.
New Century Schoolbook is a registered trademark of Kingsley-ATF Type Corp. Helvetica, Palatino, and Times are registered trademarks of Linotype-Hell AG
Corporation. Tyvek is a registered trademark of Dupont Chemical Corp. PhoneNET is a registered trademark of Farallon Corp. Cheapernet is a registered
trademark of National Semiconductor. CHAMP is a trademark of Amp Inc. Canvas is a trademark of Deneba Systems. Quark and QuarkXpress are
trademarks of Quark Inc. Ready,Set,Go is a registered trademark of Manhattan Graphics Corp. PCL is a registered trademark of Hewlett-Packard Company.
NetWare is a registered trademark of Novell Corp.  Other trademarks are the property of their respective owners.
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Limited Hardware Warranty

GCC Technologies, Inc. (“GCC”) warrants, for the limited period of one year from the date of original purchase, the Elite
12ppm sold by GCC and any accompanying media on which GCC software is recorded (the “Product”) to be free from
defects in materials and workmanship.  During the warranty period, GCC or its authorized representative will, at its
option, repair, replace or refund the purchase price of any defective product at no additional cost, provided you return
it during the warranty period, transportation charges prepaid, to GCC or an authorized GCC dealer or representative.
You must attach your name, address and telephone number, a description of the problem, and a dated proof-of-
purchase bearing the serial number for each product returned for warranty service.

This Warranty is limited to the original purchaser of the product and is not transferable unless otherwise agreed by GCC
in writing.  This Warranty does not apply to any product which has been damaged by accident, abuse, or misuse, which
has been modified without the prior written permission of GCC.

GCC MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE
SUPPLIED WITH THE PRODUCT, ITS QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR
PURPOSE.  AS A RESULT, THE SOFTWARE IS LICENSED “AS IS,” AND YOU THE LICENSEE ASSUME THE ENTIRE RISK AS TO
ITS QUALITY AND PERFORMANCE.

EXCEPT AS EXPRESSLY SET FORTH ABOVE, GCC MAKES NO OTHER WARRANTIES WITH RESPECT TO THE PRODUCT,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

UNDER NO CIRCUMSTANCES SHALL GCC’S LIABILITY ARISING OUT OF OR IN CONNECTION WITH THE PRODUCT OR THE
USE OF, OR THE INABILITY TO USE, THE PRODUCT, IN CONTRACT, IN TORT (INCLUDING NEGLIGENCE), OR OTHERWISE
EXCEED THE PURCHASE PRICE OF THE PRODUCT, AND IN NO EVENT SHALL GCC BE LIABLE FOR SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR DOWNTIME OR LOST PROFITS, BUSINESS,
USE OF SOFTWARE OR EQUIPMENT, OR GOODWILL, WHETHER OR NOT GCC HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential
damages, or do not allow limitations on how long an implied warranty lasts, so the above limitations or exclusions may
not apply to you.  ANY IMPLIED WARRANTIES, INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO ONE YEAR FROM THE DATE OF ORIGINAL
PURCHASE OF THIS PRODUCT.  This warranty gives you specific legal rights, and you may also have other rights which
vary from state to state.

No GCC dealer, representative, agent or employee is authorized to make any modification, extension or addition to this
warranty on behalf on GCC.  THE WARRANTIES AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL
OTHERS, EXPRESS OR IMPLIED.

For the name of the nearest GCC service facility or representative, call GCC at (800) 841-1833, or write to:
Director of Customer Service, GCC Technologies Inc., 209 Burlington Road, Bedford, MA  01730-9143.
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FEDERAL COMMUNICATIONS COMMISSION

WARNING: This equipment was tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions in this manual, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation.  For more information about radio frequency interference, refer to the section of this manual on
Radio and TV interference.

CANADIAN REGULATIONS
This equipment is a Class A digital apparatus that complies with the Radio Interference Regulations, CRC c.
1374.

IMPORTANT: Changes or modifications to this product not authorized by GCC Technologies Inc. could void
the FCC Certification and negate your authority to operate the product. This product was tested for FCC
Compliance under conditions that included the use of shielded cables and connectors between system
components. It is important that you use shielded cables and connectors to reduce the possibility of causing
interference to radios, television sets, and other electronic devices. You can obtain the proper shielded cables
from GCC Technologies or from an Authorized GCC Technologies dealer.

CLASS 1 LASER PRODUCT

LASER  SAFETY: This printer is certified as a Class 1 laser product under the U.S. Department of Health and
Human Services (DHHS) Radiation Performance Standard according to the Radiation Control for Health and
Safety Act of 1968. This means that the printer does not emit hazardous radiation. Since radiation emitted
inside the printer is completely confined within protective housings and external covers, the laser beam
cannot escape from the machine during any phase of user operation. The Center for Devices and Radiological
Health (CDRH) of the U.S. Food and Drug Administration implemented regulations for laser products on
August 1, 1976. These regulations apply to laser products marketed in the United States. The label on the
printer indicates compliance with the CDRH regulations and must be attached to the laser products marketed
in the United States.

Caution - Use of controls, adjustments, or performance of procedures other than those
specified in this manual may result in hazardous radiation exposure.

EPA ENERGY STAR COMPUTERS AWARD
The Elite 12ppm printer is designed to conserve electricity. With
its power-saving design, the Elite 12ppm qualifies for the U.S.
Environmental Protection Energy Star Computers Award.

CREDITS
© Copyright GCC Technologies Inc., 1998.  All rights reserved.
The Elite 12ppm User Manual was written by David Field.
It was edited by Saadia Baloch, Lee Doron, Armik Ghazarians, Brian Harriss, Krista Ingram, Bill
Krech, Rebecca Leebow, Michael McCabe, and David Nicholson.

Cover design and illustrations by Bill Krech.
Fonts used were Frutiger and Minion. Printed in USA; part number 030.16403 rev B.
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DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN45014

Manufacturer's Name: GCC Technologies

Manufacturer's Address: 209 Burlington Road
Bedford, MA  01730-9143

declares that the product:

Product Name: Elite 12ppm

Model Name: Elite 1212 (1200dpi)

Product Options: 500 sheet feeder AC16126
250 sheet Universal paper cassette AC16128
500 sheet Universal paper cassette AC16130
Duplex Unit AC16134
Face Up Output Tray AC16136
Envelope cassette (30 envelope capacity) AC16132

conforms to the following Product Specifications:

Safety: EN60950 (1992) / UL 1950 (1993) / CSA 22.2 No. 950 (1993)

EMC: EN55022 (1988) / CISPR 22 (1993), Class B (1)
EN50082-1 (1992) Generic Immunity
IEC 801-2 (1991) Electrostatic Discharge
IEC 801-3 (1984) Radiated RF Immunity
IEC 801-4 (1988) Electrical Fast Transient/Burst

Supplementary Information: The product herewith complies with the requirements of the
Low Voltage Directive 73/23/EEC and EMC Directive 89/336/EEC. and
carries the CE marking accordingly.

(1) The product was tested with an IBM PS/2 computer system and
the Macintosh Quadra computer system.

GCC Technologies:

United States- 209 Burlington Road, Bedford, MA  01730-9143, U.S.A.,  Tel: (781) 275-5800,  Fax: (781) 275-1115
United Kingdom- 729 London Road, Hounslow, Middlesex, England TW3 1SE, Tel: (44) 181-754-6000, Fax: (44) 181-754-6060
Germany- Hahnbuschweg 2-4, D-24147 Klausdorf, Germany, Tel: (49) 431 79 97 610, Fax: +49 (0) 431 79 97 666
France- 104 Rue Castagnary F-75015, Paris, France, Tel: (33) 1 45 33 51 51, Fax: +33 (0) 1 45 33 33 51
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Toner cartridge (single) AC16120

500 sheet feeder AC16126
(compatible paper tray) AC16130

250 sheet Universal paper cassette AC16128

500 sheet Universal paper cassette AC16130
(use with sheet feeder) AC16126

Face Up Output Tray AC16136

Envelope cassette (30 envelope capacity) AC16132
(use with sheet feeder) AC16126

8 megabyte memory expansion kit AC16311

16 megabyte memory expansion kit AC16313

32 megabyte memory expansion kit AC16315

GCC
TECHNOLOGIES

GCC Technologies, Inc.
209 Burlington Road
Bedford, Massachusetts  01730-9143
781-275-5800
http://www.gcctech.com

CONSUMABLE ITEMS AND ACCESSORIES

For information on ordering consumable items and accessories for the Elite 12ppm, please call GCC
Sales at (800) 422-7777 (U.S. and Canada only). Outside the U.S. and Canada, call your local
GCC dealer.
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